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この度は、PL-U4101C1 PcWaveForm をお買い上げ頂きましてありがとうございました。 本プログラムは、当社レコーダで収録さ

れたデータファイル(収録条件などが記録されたテキストベースのヘッダファイルとバイナ リデータファイルがペアで構成される)

の波形表示や解析を行うためのプログラムです。

改定履歴
発行日 Revision 内容

2006 年 11 月 12 日 3.01 改定初版

プログラムバージョン 6.21 に合わせて全面改訂、基礎編および解析機能操作編の分冊形式に。

2007 年 1 月 20 日 3.02 プログラムバージョン 6.23.XX に対応。

「14． チャネル間演算 Window」に各関数の詳細追加。

2007 年 3 月 20 日 3.03 5 関数追加、1 関数文法修正
BIT 検査関数、閾値通過データ番号検索関数 3、交点検索関数、論理波形部分反転 関数、データ切り出

し関数の追加

閾値通過データ検索関数１のパラメータ追加

2007 年７月 25 日 3.04 1/3octave 分析機能追加

プログラムバージョン 6.25.0.1 以降に対応

2008 年２月７日 3.05 プログラムバージョン 6.28.0.0 以降に対応

「８． X-Y グラフ Window」機能変更にともない記述内容変更

「９． 多軸グラフ Window」機能変更にともない記述内容変更

「14．３．26．移動実効値関数」関数名修正

「14．３．76．閾値通過データ番号検索関数 1」文法修正

2008 年７月 10 日 3.06 「ボタンに登録されている演算関数一覧」を更新

「14． チャネル間演算 Window」に各関数の詳細追加。

以下、誤植部分の訂正(誤→正)
① 14.3.10 移動平均関数：  MAB→MAV

② 14.3.12 自然対数関数：  底 10→底 e

③ 14.3.23： ACN→ACS

④ 14.3.30 主ひずみ方向関数： EMN→ETH、ラジアン→単位は degree

⑤ 14.3.46 経過時間関数：  SBC(k):→SPB(k)

⑥ 14.3.47 FV 関数： パスル→パルス

⑦ 14.3.52 パルス梯子倍関数：  RDV→PDV

⑧ 14.3.54/55 GATE 関数： GOV の引数 k の説明に追記、GUN の引数の説明を修正

K >= X の時、X は 0 とします。 → k >= X の時、X は k とします。

⑨ 14.3.73 MARK 位置データ番号検索関数： MRK(k,X)→MRK(k)、引数 X 不要

⑩ 14.3.74： MARK 位置データ番号検索関数→閾値通過最大値位置データ番号検索関数

⑪ 14.3.84 論理波形部分反転関数： 記述例 $2=ECP(1,1,$1)。41→$2=ECP(1,10,$1)。$1 以下、関数

追加部分

① 14.3.50 全身振動補正フィルタ関数(ISO2631-1)→(ISO2631-1,-4))

文法に追加： WBB(X) → 全身振動補正フィルタ B（座位、立位、仰臥位における Z 軸、ISO2631-1）

② 標準関数追加： MCD,SWP,DTF,MKS

2008 年８月 26 日 3.07 PcWaveForm Version 6.31.X.X 以降に対応

「14． チャネル間演算 Window」に演算結果ファイルの生成される形式の追加

2009 年４月１8 日 3.09 PcWaveForm Version 6.34.0.5 以降に対応

「３．伝達関数 Window」の設定ダイアログにグラフ表示パターンの追加

「14．１．３． 登録した演算式を保存する」に演算式情報登録ファイルのフォーマット説明を追加

2009 年 9 月 1 日 3.10 PcWaveForm Version 6.36.0.0 以降に対応

「１４．１．1． 演算式を登録し演算結果チャネルファイルを生成する」に保存ファイル自動表示機能を追加

2010 年 2 月 4 日 3.11 PｃWaveForm Version 7.00.0.0 以降に対応

「５． 1/ｎオクターブ解析 Window」記述内容変更

「７． 多次元時間率頻度解析 Window」記述内容変更

「14． チャネル間演算 Window」各関数の詳細変更 標準関数追加：

DAG,PVF,EQP,VRP,RSM,LCM 113 関数に
「演算関数一覧」を内容変更

2010 年 3 月 20 日 3.12 プログラムバージョン 7.01.0.0 以降に対応

「14．３． 演算関数」の変更、各演算関数についての説明を、別冊 PcWaveForm 演算関数仕様編とした。

2010 年 9 月 26 日 3.13 「６． 度数分布解析 Window」全面改定

2011 年 3 月 18 日 3.14 「２． FFT 解析 Window」「２．１．３． オーバーオール値の表示」記述修正

「14． チャネル間演算 Window」 「複数要素同士の演算」注意事項追加

2011 年 7 月 15 日 3.15 「２． FFT 解析 Window」
サポートしている解析タイプの変更、「２．１．３． オーバーオール値の表示」記述変更

PcWaveForm Version 7.05 に対応

2011 年 7 月 15 日 3.16 「４． Waterfall 解析 Window」 サポートしている解析タイプの変更

「14． チャネル間演算 Window」  演算関数一覧表更新

「16． Arch_1 Script」新規

PcWaveForm Version 7.06 に対応

2012 年 7 月 27 日 3.17 「５．1/n オクターブ解析 Window」 解析バンド設定に説明追加

2013 年 9 月 20 日 3.18 走行軌跡表示 Window に GPS データ対応を追加

2014 年 12 月 10 日 3.19 多チャネル FFT 解析追加

2015 年 6 月 29 日 3.20 保証規定等
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ソフトウェア使用許諾契約
お客様へ: ご使用になられる前に、本許諾内容をよくお読み下さい。本ソフトウェアは、お客様が以下のソフトウェア使用許諾契約の

条件に同意されることを前提として、ご使用を許諾するものです。万一、同意頂けない場合は、パッケージすべてをご購入店へご返却

下さい。ご購入代金を返金させて頂きます。

本契約は、お客様が本ソフトウェアをコピー、またはインストールを開始したときから発効します。ご同意頂けない場合は、コピーや

インストールはしないで下さい。

使用権

本使用許諾契約は、お客様が１台のコンピュータ上で、本ソフトウェアを使用する権利を許諾します。2 台以上のコンピュータ上で同

時に使用することはできません。そのような必要がある場合は別途ライセンス契約が必要です。

著作権 お客様が本ソフトウェアを取得されたことは、本許諾契約に規定された以外に本ソフトウェアのいかなる権利、権限若しくは

利権の取 得を意味するものではありません。当社はお客様に対して本ソフトウェアに関するいかなる権利も譲渡しません。本ソフト

ウェアの著 作権、その他の一切の知的財産権は、日本国憲法、万国著作権条約に基づき保護されます。本ソフトウェアの著作権、そ

の他の一切の 知的財産権、および所有権は当社またはおよびそのサプライヤに帰属しています。

制限事項 お客様は、本ソフトウェアの一部またはすべてを許諾無く複製することはできません。ただし、保管目的以外で使用しない

ことを前提 に、バックアップコピーを作成することができます。また、下記の BSD ライセンス適用部分は除かれます。 お客様は、

当社の文書による事前の承諾なく、本ソフトウェアの全部又は一部に対して改修、変更、翻案、併合、逆コンパイル、リバ ースエン

ジニアリングを行ってはなりません。

お客様は、著作権表示を削除、隠蔽などの視認困難な状態にしてはなりません。 お客様は、当社の文書による事前の承諾なく、本ソ

フトウェアの全部又は一部を譲渡・販売・転貸・リースしあるいはその二次的著作 物を創作・譲渡・販売・転貸・リースを行っては

なりません。

限定的保証 当社は、本ソフトウェアの使用が許諾されたお客様に対して、推奨されたオペレーティングシステムおよびハードウェア

環境で使用さ れた場合に、本ソフトウェアが、実質的に取扱説明書どおりに機能することを、本ソフトウェアの受領後 90 日間保証し

ます。本ソフト ウェアが、取扱説明書どおりに機能しない場合においても、それが重要な差異で無い限り、保証を受ける義務は発生し

ません。本ソフ トウェアが実質的に取扱説明書に従って機能しない場合の、当社および関連会社のすべての責任並びにお客様に対する

唯一の救済手段 は、当社の選択により、本ソフトウェアの交換、または、お客様が支払った使用許諾料の払い戻しのいずれかに限られ

ます。当社は、 本ソフトウェアの使用や使用不能から生じた派生的ないかなる損害（事業上の損失、営業の中断、営業上の情報の損失、

その他の金銭 上の損害など）についても、その損害の可能性が明示であると黙示であるとを問わず当社に知らされていたとしても、責

任を負いませ ん。なお、上記は本ソフトウェアの操作が中断しないことや誤りのないことを保証するものではありません。

BSD ライセンスに関する事項
本ソフトウェアでは、BSD ライセンスで使用と再頒布が認められた、下記の著作権者のソフトウェア製品を音声再生のために使用して

います。該当ソフトウェア製品に関するライセンス条項は以下のようになっています。原文の情報を正しく伝えるために英文のままで

記載します。

Copyright (c) 2002, Xiph.org Foundation

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 

conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer 

in the documentation and/or other materials provided with the distribution.

Neither the name of the Xiph.org Foundation nor the names of its contributors may be used to endorse or promote products derived 

from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 

BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 

SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 

DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 

INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 

NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

本許諾契約に関し、ご不明な点等ございましたら、下記宛にご連絡下さい。

株式会社 デイシー

〒205-0002 東京都羽村市栄町３－３－６

電話: 042-570-7121
メール: info@deicy.co.jp

Copyright (c) 2015, DEICY Corporation 

All rights reserved.

i



目次

１． 解析機能の起動...................................................................................................................1
１．１． 波形表示からデータ切り出し操作..........................................................................................................................................................2

１．１．１． 波形表示モードの選択...........................................................................................................................................................2

１．１．２． 手動で切り出し範囲を設定する .........................................................................................................................................3

１．２． 解析の起動......................................................................................................................................................................................................4

２．  FFT解析 Window..................................................................................................................7
２．１． 操作.....................................................................................................................................................................................................................8

２．１．１． FFT 解析 Window を表示する............................................................................................................................................8

２．１．２． 複数チャネルの FFT 結果重ね描きで表示する......................................................................................................12

２．１．３． オーバーオール値の表示..................................................................................................................................................13

２．１．４． FFT グラフの X 軸ズーム....................................................................................................................................................14

２．１．５． 切り出し区間の表示移動と解析結果の表示連動..................................................................................................14

２．２． 解析結果の保存.........................................................................................................................................................................................15

２．２．１． FFT 解析結果をファイルに保存する.............................................................................................................................15

２．２．２． FFT グラフ上のカーソル読み取り値をファイルに保存する..................................................................................15

２．３． グラフのプリントアウト..................................................................................................................................................................................16

２．４． 多チャネル分割表示 FFT 解析................................................................................................................................................................................17

３． 伝達関数 Window ..............................................................................................................19
３．１． 操作..................................................................................................................................................................................................................20

３．１．１． 伝達関数 Window を表示する.........................................................................................................................................20

３．１．２． Nyquist 線図を表示する.....................................................................................................................................................24

３．１．３． 切り出し区間の表示移動と解析結果の表示連動..................................................................................................24

３．２． 解析結果の保存.........................................................................................................................................................................................25

３．３． グラフのプリントアウト..................................................................................................................................................................................25

４．  Waterfall解析 Window....................................................................................................27
４．１． 操作..................................................................................................................................................................................................................28

４．１．１． Waterfall 解析 Window を表示する..............................................................................................................................28

４．２． 解析結果の保存.........................................................................................................................................................................................33

４．２．１． Waterfall 解析結果をファイルに保存する..................................................................................................................33

４．３． グラフのプリントアウト..................................................................................................................................................................................33

５．  1/nオクターブ解析 Window..........................................................................................35
５．１． 操作..................................................................................................................................................................................................................36

５．１．１． 1/n オクターブ解析 Window を表示する...................................................................................................................36

Y 軸スケールの設定..................................................................................................................38
５．１．２． 1/ｎオクターブ分析グラフを表示する...........................................................................................................................39

５．１．３． バンド毎、移動実効値波形表示グラフを表示する.................................................................................................40

５．１．３． バンド毎カラーコンターマップグラフを表示する........................................................................................................41

５．１．4． オクターブバンド解析の留意点........................................................................................................................................42

５．２． 解析結果の保存.........................................................................................................................................................................................42

５．２．１． 1/n オクターブ解析結果をファイルに保存する.......................................................................................................42

５．３． グラフのプリントアウト..................................................................................................................................................................................42

６． 度数分布解析 Window ....................................................................................................43
６．１． 操作..................................................................................................................................................................................................................44

６．１．１． 度数分布解析 Window を表示する..............................................................................................................................44

６．２． 解析結果の保存.........................................................................................................................................................................................46

６．２．１． 度数分布解析結果を表示しファイルに保存する....................................................................................................46

６．３． グラフのプリントアウト ..................................................................................................................................................................................47

７． 多次元時間率頻度解析 Window.................................................................................49
７．１． 操作..................................................................................................................................................................................................................50

７．１．１． 時間率頻度解析 Window を表示する.........................................................................................................................50

７．２． 解析結果の保存.........................................................................................................................................................................................53

７．２．１． 多次元時間率頻度解析結果をファイルに保存する .............................................................................................53

８． X-Y グラフ Window ...........................................................................................................55
８．１． 操作..................................................................................................................................................................................................................56

８．１．１． X-Y グラフ Window を表示する......................................................................................................................................56

８．１．２． グラフ表示条件を保存し読み出す................................................................................................................................58

８．２． 解析結果の保存.........................................................................................................................................................................................59

８．２．１． 解析結果をファイルに保存する.......................................................................................................................................59

８．３． グラフのプリントアウト..................................................................................................................................................................................59

９． 多軸グラフ Window............................................................................................................61
９．１． 操作..................................................................................................................................................................................................................62

９．１．１． 多軸グラフ Window を表示する......................................................................................................................................62

ii



９．１．２． グラフ表示条件を保存し読み出す................................................................................................................................64

９．２． グラフのプリントアウト..................................................................................................................................................................................64

10． スパイクカット ......................................................................................................................65
10．１． 操作................................................................................................................................................................................................................66

10．１．１． スパイクカット機能を使う...................................................................................................................................................66

10．１．2． スパイクカットの動作説明.................................................................................................................................................69

11． 走行軌跡表示 Window..................................................................................................71
11．１． 操作................................................................................................................................................................................................................72

11．１．１． 走行軌跡を表示する.........................................................................................................................................................72

11．１．２． 走行軌跡からコースマップを生成する.......................................................................................................................76

11．１．３． GPS 走行軌跡から KML ファイルを生成する .........................................................................................................76

12． オフセット調整処理..........................................................................................................77
12．１． 操作................................................................................................................................................................................................................78

12．１．１． オフセット調整処理を行う................................................................................................................................................78

13． Statis 2 Window ..............................................................................................................81
13．１． 操作................................................................................................................................................................................................................82

13．１．１． 式を登録し演算結果を表示する..................................................................................................................................82

13．１．２． 演算式設定ダイアログの内容を保存し読み出す .................................................................................................85

13．２． 解析結果の保存......................................................................................................................................................................................86

13．２．１． 解析結果をファイルに保存する....................................................................................................................................86

14． チャネル間演算 Window...............................................................................................87
14．１． 操作................................................................................................................................................................................................................88

14．１．１． 演算式を登録し演算結果チャネルファイルを生成する....................................................................................88

14．１．２． 登録済み演算式を編集する..........................................................................................................................................97

14．１．３． 登録した演算式を保存する............................................................................................................................................98

14．１．４． テーブルを定義して非線形データを処理する....................................................................................................101

14．１．５． リサンプリング処理と周波数/空間周波数の相互変換...................................................................................103

14．２． 解析結果の保存...................................................................................................................................................................................104

14．２．１． スカラー量演算結果をファイルに保存する..........................................................................................................104

14．３． 演算関数..................................................................................................................................................................................................106

15． NoteBook Window........................................................................................................109
15．１． 操作.............................................................................................................................................................................................................110

15．１．１． NoteBook を設定する....................................................................................................................................................110

15．１．２． 演算を実行する ................................................................................................................................................................113

15．１．３． 異なった収録データファイルでの NoteBook ファイルの共有.......................................................................114

16． Archi_1 Script.................................................................................................................115
16．１． Archi_1 Script の作成と編集操作................................................................................................................................................116

16．１．１．編集 Window を起動する................................................................................................................................................116

16．１．２． 記述エリアへの書き込み方法.....................................................................................................................................117

16．１．３． 編集機能..............................................................................................................................................................................117

16．２． Archi_1 Script ファイルの保存と読み出し.................................................................................................................................124

16．２．１．記述編集エリアに表示されている内容のファイル保存......................................................................................124

16．２．３．作成編集エリアの印刷 .....................................................................................................................................................125

16．３． Archi_1 Script 実行メニューの操作.............................................................................................................................................126

16．３．１．実行メニューダイアログの表示......................................................................................................................................126

16．３．２．Arch_1 Script ファイルの実行メニューへの登録.................................................................................................126

16．３．３．実行メニューから編集 Window への遷移と登録削除.......................................................................................127

16．３．４．実行環境設定......................................................................................................................................................................127

16．３．５．Arch_1 Script の実行.......................................................................................................................................................128

16．３．６．実行メニューの入れ替え.................................................................................................................................................129

16．４． 結果シートの操作..................................................................................................................................................................................130

16．４．１．結果シート Window の表示.............................................................................................................................................130

16．４．２．結果シートページの切り替え ..........................................................................................................................................130

16．４．３． 結果シートの格納.............................................................................................................................................................130

iii



１． 解析機能の起動

Page 1

１． 解析機能の起動
PcWaveForm では、メインの波形画面で切り出された区間のデータに対して、様々な解析を実行することができます。 波形表示画面

は、必要な解析区間を抜き出すためのガイドウィンドウの役目を持ちます。 この波形表示画面を見ながら、解析区間を特定し、その区

間データに対して、必要な解析機能を適用します。

波形表示画面の操作やデータ切り出し方法については、別冊の「取扱説明書-基礎編」を参照して下さい。
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１．１． 波形表示からデータ切り出し操作
解析機能を起動するまでの、簡単な操作の流れを復習します。 収録データファイルを開くと、事前に設定された波形表示

モードにしたがって、SeparateWave モード、または CommonWave モードにいずれかのモードで、収録データ波形が表示さ

れます。

１．１．１． 波形表示モードの選択
PcWaveForm では、Separate Wave または、Common Wave のいずれかの波形表示モードを選択することができます。 表

示モードの選択は、メニューバー[Set] -> [CommonWave]で行います。[CommonWave]をチェックしない場合、Separate 

Wave モード、チェックをした場合は、Common Wave モードとなります。

Separate Wave モード

波形グラフをチャネル毎に分割して表示します。

一画面あたり最大 16 チャネル分(左右にチャネル

をオーバーレイ)を表示します。それ以降のチャネ

ルはページを切り換えて表示します。

Common Wave モード

複数チャネルの波形グラフを 1 枚のチャートレコー

ダイメージのグリッド画面に表示します。各チャネル

の Y 軸グリッドの描き出し位置と Y 軸グリッドスケー

ルを個別に設定できます。表示されているチャネ

ル以上のチャネルがある場合には、ページを切り

換えて表示します。
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[Analyze]メニューと解析機能アイコン [Analyze]メニューでは、各種解析

機能を実行します。 下の表に、各解析機能の内容と、メニューバーに表示され

るアイコンを示します。

項目 内容 アイコン

Statistics Report... 基本統計量解析を行います。

(基礎編を参照して下さい。)

Note Book 基本統計量解析を行います。Statistics Report と同等の機能を持ちますが、異なるファイル間の処理が

可能です。

XY Graphics... X-Y グラフを表示します。

Statis2 演算式が登録でき、基本的な応力解析などを行うことができます。

FFT/Ave.FFT... FFT 解析を行います。

TRANS & COH... 伝達関数を表示します。

Waterfall... 解析範囲として指定されたカレントチャネルの切り出し区間の FFT 結果を Water Fall 形式で表示します。

Calc... チャネル間演算・関数演算を行うことができます。

DrawPlot 値の自動読取が行える手書き Window を表示します。

(基礎編を参照して下さい。)

Sound 表示されている波形データを WAV ファイルに変換して PC のサウンドシステムで音として再生します。

(基礎編を参照して下さい。)

MultiDim Frequency Analysis 多次元時間率頻度、最大６軸のチャネルデータの信号レベルの分布をグラフ表示します。

Distribution 度数分布解析結果を表示します。

1/3 Octave オクターブ解析を行います。

Spike Cut スパイクノイズを除去することができます。

Offset.ADJ 各チャネルにオフセット量の設定ができます。
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このページはブランクです。
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２． FFT 解析 Window
メイン画面で、解析範囲指定されたカレントチャネルのFFTを実行します。FFTグラフでは、カレントチャネルを切り換えることによって、

各チャネルの FFTグラフの重ね描きもできます。

◆ FFT 点数: 512, 1024, 2048, 4096, 8192, 16384 から選択できます。

◆ 窓関数: ハニング、ハミング、ブラックマン、カイザーベッセル、エクスポネンシャル、フラットトップ、Off から選択できます。

◆ 解析タイプ: スペクトラム(尖塔値または rms 値)、パワースペクトラム、パワースペクトラム密度、エネルギースペクトラム密度から

選択できます。
◆ 平均 FFT 表示時、平均スペクトラ、最大スペクトラ、または両方表示が選択できます。

◆ FFT 解析結果を CSV ファイルに保存することができます。

◆ FFT グラフのカーソルプロット値を、リスト表示および CSV ファイルに保存できます。
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２．１． 操作
２．１．１． FFT 解析 Window を表示する
① メインの波形表示画面で FFT 解析対象の区間を切り出します。

このとき、解析対象チャネルをカレントチャネルに指定しておきます。

②  メニューバーの、[Analyze]  ->  [FFT/Ave.FFT...]をクリックするか、ツールバーの、    をクリックすると FFT 解析
Window が表示されます。デフォルトで表示される解析条件は、前回使用されたときの条件となります。

カレントチャネルに設定された Ch1 の切り出し区

間データの FFT 解析を行います

位置

が FFT 波形上を移動します。 クロスカーソルポイ

ントの値は画面左下(周波数) と右上(Y 軸値)に表

示されます。

ここに表示されたグラフタイトル、および解析条 件、

X/Y 軸スケールは、次に説明する[Analysis
Condition...]で変更できます。

クロスカーソルは、<FFT Cond  Setting> ダイアログの

<Cursor><Visible>をチェックすると表示されます。
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③ 必要に応じて、FFT 解析条件を変更します。FFT 解析 Window のメニューバー[Option] -> [Analysis Condition...]をクリ

ックします。

解析条件設定<Analysis Condition>の設定内容

項目 内容

Analysis Type 得ようとする解析結果を選択します。
振幅の場合 Spectrum(ス

ペクトラム): A

実効値の場合

Spectrum(rms): A/√2 (= Arms) 

Power Spectrum: Arms ^2 (= Prms)

Power Spectrum Deisity = Prms/⊿f (= PSD)

なお、⊿f は次の計算式から得られます。⊿f=fs(サンプリング周波数)/m(FFT Points FFT 点数)

Energy Spectrum Density = PSD x FFT フレーム周期

なお、FFT フレーム周期は、次の計算式から得られます。  FFT Points x サンプリング周期

Window Func 処理する時間軸データにかける窓関数を選択します。(各窓関数式は後述します。)
Hanning(ハニング), Hamming(ハミング), Blackman(ブラックマン), Kaiser_Bessel(カイザーベッセル), FlatTop(フラッ

トトップ), Exponantial(エクスポネンシャル), Off(レクタンギュラ)

Exp.Window Param: Exponantial が選択されたとき有効となります。t0(FFT フレーム内の窓開始点)および窓の幅

をデータポイントで設定できます。

次ページに続く

グラフタイトル設定<Title>:

FFT 解析グラフにここで入力されたグラフタイトルを表示します。初期値は､直前に設定された内容となります。

<Title>の右側にカレントチャネル番号およびチャネル名と単位が表示され、解析対象のチャネルを示します。

<Cursor>: グラフ 画面に クロスカーソ ル を表示す るか しないか を設 定します。

<Visible>にチェックを付けると表示します。

解析条件設定<Analysis Condition>:  FFT 解析条件を設定します。

X/Y 表示軸設定<X Axis><Y Axis>: 軸スケールを設定します。

グラフ画面色設定<Color>/グラフ線色設定<Plot>: それぞれのカラーバーをクリック

すると、カラーパレットが表示されグラフ各部分の色の 変更ができます。

[OK]をクリックするとここに表示された設定を確

定し、解析内容を変更し FFT グラフ Window に戻

ります。
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ィケードの

じく

ます

FFT 解析するフレーム
ます。平均化処理を

解析対象とします。

複数チャネルの重ね

上には最新の結果のみ

表示するスペクトラ本数

でとなります。FFT フレーム

選択された FFT

0Hz(直流分)のスペクトラは

定欄の右側<Max. Frequency>

サンプリング周波数（

Max. Frequency = (Fs / FFT Points) x Display Lines  (Fs / FFT Points = ⊿f)

平均化処理を行うかどうかを

が有効になり、オーバーラップ

Overlap: 繰り返される

ーラップ率が設定されると

Spectra:  解析結果

します。<Both>を選択

設定されている解析範囲

レーム長に満たない

ーバーラップ率で自動決定

定したい加算回数から

複数チャネルの重ね

上には最新の結果のみ

Axis Attb.: X 軸スケール

ールを選択した場合

LOG スケールを選択

ド開始周波数、右端

Format: X 軸目盛値表示形式

更する場合は、表示欄右側

されます。

Axis Attb.: Y 軸スケール

します。この設定と X 

[dB]を選択すると、0dB = max/0dB

場合、各チャネルの

Format: Y 軸目盛値表示形式

示形式を変更する場合

ログが表示されます

Scale: スケールとして

Auto は、グラフに書

の解析結果を表示している

AutoHold  は、すでに

最大値を越える場合

Manual はスケール最大値

グラフスケールの<Max Value>(

Manual 設定以外で

ィケードの開始値、例

じく表示されている結果

ます。
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するフレーム長（データ点数）
を行わない場合、設定

ね描き表示されている

のみ表示されます。

本数を選択します。

フレーム長を変更すると

FFT Points

512

1024

2048

4096

8192

16284

のスペクトラは表示されません

<Max. Frequency>に表示されます

（Fs）と FFT Points、

Max. Frequency = (Fs / FFT Points) x Display Lines  (Fs / FFT Points = ⊿f)

うかどうかを選択します

オーバーラップ率や個々

される FFT 処理の重なり

されると、設定欄右側

解析結果は<Ave>(平均スペクトラム

選択するとグラフ上には

解析範囲に対して設定

たない範囲は解析されません

自動決定されます。従

から求めて設定して下

ね描き表示されている

のみ表示されます。

スケール属性を設定します

場合、左端は 0Hz、右端

選択した場合、グラフはディケード

右端は表示スペクトラ本数

軸目盛値表示形式の設定を

表示欄右側の[Setting]

スケール属性を設定します

X 軸属性設定でグラフが

0dB = max/0dB =

チャネルの Max 値基準)、または

軸目盛値表示形式の設定を

場合は、表示欄右側

されます。

スケールとして<Auto>(自動)、<AutoHold>

書き込まれるカレントチャネルの

している場合でも最新

すでに設定されているスケールの

場合にのみスケールが

最大値および最小値

<Max Value>(最大値

で Y 軸属性が LOG 

例えば結果の最小値

結果の最大値を含むディケードの

内容

）を選択します。選択
設定されている解析範囲指定

されている時に FFT 解析フレーム

。

設定可能な最大表示

すると初期値に戻ります

表示スペクトラ初期値

されません。表示スペクトラ

されます。

、Display Lines の関係

Max. Frequency = (Fs / FFT Points) x Display Lines  (Fs / FFT Points = ⊿f)

します。<Ave FFT>をチェックすると

個々のスペクトラ最大値表示

なり率を設定できます

設定欄右側<Ave Counts>に繰

スペクトラム)、<Max>(最大

には平均スペクトラムと

設定したオーバーラップ

されません。また、平均化回数

従って、明示的に平均加算回数

下さい。

されている時に平均化処理

。

します。LINEAR スケールまたは

右端は設定した表示スペクトラム

グラフはディケード単位で増減

本数から演算された周波数

を行います。現在使用

[Setting]ボタンをクリックします

します。[LINEAR]スケール

でグラフが方眼、またはセミログ

= ( )の選択が有効

または 0dB の値を指定

を行います。X 軸同様

表示欄右側の[Setting]ボタンをクリックします

<AutoHold>半自動、

まれるカレントチャネルの解析結果

最新の結果により毎回自動更新

されているスケールの最大値を

にのみスケールが更新されます。

最小値を明示的に設定してスケーリングを

最大値)および<Min Value>(

LOG の場合、グラフスケールの

最小値が 0.23 の場合、

むディケードの終了値

内容

選択は、512, 1024, 2048, 4096, 8192, 16284 
解析範囲指定の開始点からここで

フレーム長の変更を行

最大表示スペクトラ本数は

ります。

表示スペクトラ初期値

200

400

800

1600

3200

64 0

スペクトラ本数を設定すると

関係は次のようになっています

Max. Frequency = (Fs / FFT Points) x Display Lines  (Fs / FFT Points = ⊿f)

をチェックすると設定されている

最大値表示を行うかどうか

できます。設定可能な値は

繰り返される FFT 処理

最大スペクトラム)、

スペクトラムと最大スペクトラムの

したオーバーラップ率で FFT 処理を繰

平均化回数は設定した解析範囲

平均加算回数を設定

平均化処理の ON/OFF 変更を

スケールまたは LOG スケールから

スペクトラム本数から

増減し、左端は一次

周波数を含むディケードの

現在使用されている表示形式

ボタンをクリックします。クリックされるとフォーマット

スケール、[LOG]スケール

またはセミログ、ログログのグラフ

有効となり、Max 値を

指定してグラフスケールとするか

軸同様に現在使用されている

ボタンをクリックします。クリックされるとフォーマット

、<Manual>(手動)の

解析結果によりグラフスケールが

毎回自動更新されます

を越えない場合は直前

してスケーリングを行

<Min Value>(最小値)入力ができます

グラフスケールの最小値は表示

、0.1 が採用されます

終了値、例えば、最大値

２． FFT 

512, 1024, 2048, 4096, 8192, 16284 
からここで設定したフレーム

行うと、重ね書きが解除

は選択した FFT フレーム

表 スペクトラ最大値

すると、表示最大周波数

のようになっています。

Max. Frequency = (Fs / FFT Points) x Display Lines  (Fs / FFT Points = ⊿f)

されている解析範囲内

うかどうか設定します。

は 0～99(%)範囲となります

処理の回数を表示します

、または<Both>(両方

スペクトラムの 2 本を同時に表示

繰り返しますが、最後

解析範囲の大きさとここで

設定したい場合は、解析範囲

を行うと、重ね描きが

スケールから選択します

から求めた周波数となります

一次の周波数（Δf）が含

むディケードの終了周波数

表示形式が表示されます

クリックされるとフォーマット設定ダイアログが

スケール、または[dB]スケールから

ログログのグラフ形式が設定できます

0dB にするか(複数

してグラフスケールとするか選択できます

されている表示形式が表示

クリックされるとフォーマット

の 3 種から選択できます

によりグラフスケールが毎回設定され

されます。

直前のスケールがそのまま

行います。このモードが

ができます。

表示されている結果の

されます。またグラフスケールの

最大値が 12.3 の場合は、

FFT 解析 Window

512, 1024, 2048, 4096, 8192, 16284 から行え
したフレーム長までを

解除され、グラフ

フレーム長の 1/2 ま

スペクトラ最大値

255

511

1023

047

4095

8191

表示最大周波数が演算され設

解析範囲内で平均化処理

となります。オーバ

します。

両方)表示から選択

表示します。

最後の処理で FFT フ

きさとここで設定したオ

解析範囲の幅を設

きが解除され、グラフ

します。LINEAR スケ

となります。また、

含まれるディケー

終了周波数となります。

されます。表示形式を変

ダイアログが表示

スケールから選択

できます。

複数チャネル表示の

できます。

表示されます。表

クリックされるとフォーマット設定ダイア

できます。

され、複数チャネル

のスケールがそのまま使用され、

このモードが選択されると、

の最小値を含むデ

またグラフスケールの最大値は同

、100 が採用され

Window
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２． FFT 解析 Window

前ページより

項目 内容

Cursor <Visible>をチェックするとカーソル機能が ON され、グラフ上にクロスカーソル線が表示されます。
カーソルはマウスドラッグにより任意位置に移動できます。また細かくカーソル線を移動させる場合は、キーボード

の左右矢印キーを押すことで移動できます。

カーソル位置の周波数値は、グラフ枠外左下に、また Y 軸値はグラフ枠外右側に表示されます。

Ref.Ch 参照チャネル平均値を表示します。チェックボックスをチェックすると、右側のリストボックスで選択した参照チャネ
ルの FFT 処理に相当する区間の平均値をグラフの上側に表示します。 例えば、解析チャネルが振動の場合、参

照チャネルに回転数チャネルを選択すると、FFT 解析結果に時間軸上 同じ領域の回転数が表示され、ある回転

域における振動のスペクトラム解析であることが明確になります。

Color 色を変更する場合、各項目の右のカラーボタンをクリックします。クリックされるとカラーパレットダイアログが表示さ
れます。表示されるスペクトラム線色を変更する場合は、<Plot>リスト上の変更する Ch 行のカラーボタンをクリック

します。

Outside: グラフ外側の枠の背景色です。

Inside: グラフ内側の背景色です。

Title: グラフタイトル文字色です。

GridLine: グリッド線色です。

Scale Value: スケール値の文字色です。

Cursor: カーソル線色です。

窓関数(Window Function)の演算式

Hanning/Hamming 窓関数式

w(t)    (1 ) cos(2  t )
T

T は FFT フレーム長さを意味します。Hanning 窓関数時、α=0.5、Hamming 窓関数時 α=0.54 をとります。

Blackman 窓関数式

w(t).42659.49656cos(2


t ) .76848cos(4 t )
T T

Kaisar_Bessel 窓関数式

w(t)11.24cos(2


FlatTop 窓関数式

t ).244cos(4
T

t ) .00305cos(6 t )
T T

w(t)11.93cos(2
t )1.29cos(4
T

t ).388cos(6
T

t ) .0322cos(8 t )
T T
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２． FFT 解析 Window

w(t) e

Exponential 窓関数式

(t t 0) /



t0(FFT フレーム内の窓開始点)および τ 値(窓の幅)を設定できます。

0<=t0<T、t0+τ<=T の関係が成立する必要があります。設定値はフレーム内のインデックス番号(データ番号)で行いま

す。
FFT 点数を変更しても自動的には更新されません。

２．１．２． 複数チャネルの FFT 結果重ね描きで表示する
異なるチャネルの同一解析範囲の結果を重ね描きで表示することができます。

① FFT 解析 Window のメニューバー、[Winodw] -> [Horz Tile]をクリックすると、現在開かれている FFT 解析 Window と、

元の波形表示 Windowが同時表示されます。

② 波形表示 Window で、FFT 解析 Window に重ね描きを行うチャネルをカレントチャネルに指定します。この例の場合、

Ch2 を重ね描きするカレントチャネルに設定しました。

② カーソルのフォーカスが、波形表示 Window にあることを確認し(波形表示 Window のダイアログタイトル部が濃い色で表

示されます)、メニューバーの、[Analyze] -> [FFT/Ave.FFT...]をクリックするか、ツールバーの、    をクリックすると、カ
レントに指定したチャネルの FFT解析結果が重ね描き表示されます。

チャネルのグラフ枠外左側をクリックする

か、キーボードの Tab キーを押してカレントチ

ャネルとして指定します。チャネル番号が反

転表示となります。

この部分が濃い色になってい

ることを確認します。

カレントチャネルに指定した Ch2(ピンク)の波形が重 ね

描きされました。

必要に応じて、Window 最大化ボタンをクリックして

下 さい。FFT 解析 Window が画面いっぱいに表示

され ます。



クロスカーソル

複数

または

いてチャネルを

２．１．３．
FFT 

最新解析結果

に解析

クロスカーソル線の対象

複数チャネルの FFT 

または、表示部右のチャネルをクリックして

いてチャネルを切り

２．１．３． オーバーオール値の表示
FFT グラフ画面タイトル

最新解析結果の窓関数補正

解析されたチャネルの

対象チャネルを

FFT 結果が表示

のチャネルをクリックして

り換えるには、マウスカーソルのフォーカスを

オーバーオール値の表示
タイトル下部に FFT 

窓関数補正に関

されたチャネルの結果を表示

チャネルを切り換える

表示されている場合

のチャネルをクリックして下線表示

マウスカーソルのフォーカスを

オーバーオール値の表示
FFT 結果のオーバーオール

関して正規化されたオーバーオール

表示します。現在表示

[Tab]
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クロスカーソルは

(黒)上

場合、クロスカーソル

下線表示を切り換えます

マウスカーソルのフォーカスを、FFT 

オーバーオール値の表示
のオーバーオール値を

されたオーバーオール

現在表示されている

[Tab]キーを押す、または

クロスカーソルは

ンク)上を移動

クロスカーソルは X Axis Acc 

上を移動します。

クロスカーソル線の対象チャネルを

えます。ただし、複数

FFT 解析 Window 

を表示します。

されたオーバーオール値を示し、

されている FFT 解析結果

または[Y Axis Acc]をクリック

クロスカーソルは Y Axis Acc 

移動します。

X Axis Acc のチャネル

チャネルを切り換えるには

複数の Window 

Window に置く必要

、複数チャネルを

解析結果のオーバーオール

をクリック

Y Axis Acc のチャネル(ピ

２． FFT 

えるには、[Tab]

Window が表示されて[Tab]

必要があります。

チャネルを解析した結果

のオーバーオール値を表示

FFT 解析 Window

[Tab]キーを押すか、

[Tab]キーを用

結果の時は、直前

表示します。

Window

、
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２． FFT 解析 Window

２．１．４． FFT グラフの X 軸ズーム
FFT グラフ枠内で、マウスを右クリックすると、[X Zoom In]/[X Zoom Out]メニューが表示されます。

[X Zoom In]操作により拡大された、グラフの X 軸スペクトラ本数は、内部的に保持され、以降の重ね描きにも有効です。条

件設定ダイアログの設定値の書き換えは行いません。

２．１．５． 切り出し区間の表示移動と解析結果の表示連動
メニューバー[Window]から、[Horz Tile]または[Vert Tile]をクリックすると、メインの波形表示 Window と FFT 解析 Window 

を水平方向、または垂直方向に並べて表示することができます。このとき、メインの波形表示 Window の切り出し範囲である

反転表示部分をマウスで移動すると、FFT 解析 Window の解析結果も連動して変化します。

メニューバーおよびツールバーの表示内容は、現在のカーソルが、波形表示、もしくは FFT 解析 Window のどちらの Window 

に存在するかによって異なります。上の表示例では、カーソルは波形表示 Window に存在し、波形表示 Window の操作が

有効です。このとき FFT 解析 Window に関する操作を行うためには、マウスを FFT 解析 Window のいずれかの位置でクリッ

クします。

X Zoom In をクリックするとこの範囲

がズームされます。

X 軸属性が LOG スケールの場合は、カーソル線位置を含むデ

ィケード単位で拡大表示されます。

拡大した部分をさらに拡大するには、[X Zoom In]操作を続けて

行います。

[X Zoom Out]は、拡大されたグラフを元々設定されているスペ

クトラ本数から演算される周波数までの表示に戻します。

切り出し区間を移動すると、連動して FFT 解析 Window も変化します。

波形表示 Window のメニューバー、[Option]
-> [Auto_Scroll Mode]をクリックするとダイア

ログが表示され、波形の自動スクロールがで

きます。
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２． FFT 解析 Window

２．２． 解析結果の保存
２．２．１． FFT 解析結果をファイルに保存する
FFT 解析結果を csv ファイルに保存することができます。

FFT 解析 Window のメニューバー、[File] -> [Save FFT Data]をクリックします。ファイル保存ダイアログが表示され、ファイ

ル名を付けて保存することができます。

拡張子 csv のテキストファイル形式で保存されます。重ね描き表示されたチャネル分の解析結果がファイルに保存されま

す。

1 行目は、キーワード、グラフタイトル、解析年月日と時分

秒、2 行目は、解析対象ファイル名、3 行目は、解析列ご

との信号名と単位、4 行目は、解析列ごとのチャネル番

号、5 行目は、解析列ごとの解析表示形式、6 行目は、

解析列ごとの使用した窓関数、7 行目から解析結果とな

ります。1 列目は、スペクトラ番号、2 列目は周波数、3 列

目から各チャネルの解析結果が記載されます。

２．２．２． FFT グラフ上のカーソル読み取り値をファイルに保存する
FFT グラフ上のカーソル読み取り値をリスト表示し、csv ファイルに保存することができます。

リスト表示された値は、拡張子 csv のテキストファイル形式で保存されます。ファイル名、表示領域周波数とともに、表示さ

れる値は、チャネル番号、チャネル名、単位、Y 軸値、X 軸周波数軸値、任意に入力されたコメントです。

リスト右上の[Save]をクリックすると、ファイル保存ファイアログを開き、現在のリスト表示の内容を csv ファイルとして保存しま

す。

FFT 解析グラフが全面に表示されているとき、この

す

るとリスト表示が現れます。

カーソルプロットされた位置がマ

ークされ、マーク内の番号が下の

リストに一致します。

クロスカーソルを読み取りする位置に移動し、リスト

右上の[Regist]ボタンをクリックすると、その位置の

値が、リストに登録されます。 (この例の場合、リスト

の 3 番目に値が書き込まれま

す。)

カーソル値リスト表示

<Comment>セルでダブルクリックすると、該当チャネ

ルにコメント入力ができます。

表示を削除するには、<No.>セルをクリックして、リ

スト表示の該当チャネル全体を反転表示し、

[Delete]をクリックします。

0 56416

FFT RESULT FFT/AVEFFT 2006/9/25 22:08:42
File Name 4chData.hdr

Name(Unit) X Axis Acc(G^2)  Y Axis Acc(G^2)
ChNo Ch1 Ch2
Analysis Mode  Power Spectrum  Power Spectrum

No Frequency(Hz) Hanning Hanning
1 2.441 0.001 0.001
2 4.883 0 0
3 7.324 0 0
4 9.766 0 0
5 12.207 0 0
6 14.648 0 0
7 17.09 0 0
8 19.531 0 0
9 21.973 0 0

10 24.414 0 0
11 26.855 0 0.001
12 29.297 0.002 0.037
13 31.738 0.008 0.06
14 34.18 0.002 0.006
15 36.621 0 0
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２． FFT 解析 Window

２．３． グラフのプリントアウト
表示されている FFT グラフをプリントアウトするには、FFT 解析 Window のメニューバー、[File] -> [Print]をクリックします。

[Print Preview]では、プリントプレビューを行うことができます。
[Print Setup...]では、用紙の向きやプリンタの設定を行うことができます。
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２． FFT 解析 Window

２．４． 多チャネル分割表示 FFT 解析
① メインの波形表示画面で FFT 解析対象の区間を切り出します。

② メニューバーの、[Analyze] -> [Multi Cｈ FFT...]をクリックするか、ツールバーの、    をクリックすると CH 選択画面

が表示されます。

チャネル名一覧が左側に表示されます。

③解析したいCHを左クリックで選択し中央の[>>]ボタンを左クリックすると、選択したCHが右の解析CH欄に表示されます。

CH は、キーボードの ctrl ボタンや shift ボタンを併用することで同時に選択できます。

解析 CH 数は最大 9CH です。
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２． FFT 解析 Window

④OK を選択すると FFT 結果が表示されます

⑤ 必要に応じて、FFT 解析条件を変更します。解析 Window のメニューバー[Option] -> [Analysis Condition...]をクリックし

ます。

設定項目は FFT 解析に準じますので 2.1.1③を参照してください。 2.1.1③との

差は下記となります。
・Ave FFT Param ： Spectra で Both の設定がありません。

・Y Axis Scale：Manual を選択すると PlotList の ScaleMin/ScaleMax の値が有効になります。

結果の保存やグラフの印刷も FFT 解析 Window と同様の操作で可能です。2.2～2.3 を参照してください。
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３． 伝達関数 Window

３． 伝達関数 Window
メイン画面で、解析範囲指定されたカレントチャネルと同じ波形表示窓にオーバーラップ表示されているチャネルペア(Separate 

Wave の場合でカレントチャネルは左側チャネルに設定して下さい。Common Wave ではカレントチャネルとその直下に表示されている

チャネルがペアとなります。) の伝達関数を演算しグラフ表示します。また、演算結果をリスト表示し、CSV ファイルとして保存すること

もできます。なお、カレントチャネル側が入力チャネルとなります。

◆ 振幅/位相/コヒーレンス関数のグラフ表示。振幅(Gain)と位相(Phase)は同一グラフ枠、または、別グラフ枠表示の選択ができま

す。
◆ 振幅、位相、周波数それぞれの軸スケールに対して Autoscale、あるいは、表示範囲の設定ができます。

◆ Nyquist 線図を表示できます。

◆ 伝達関数演算結果をリスト表示し、その値を CSV ファイルとして保存することもできます。



３．１． 操作
３．１．１．
①メイン

メニューバー

伝達関数

る<Signal Name/Display Channels Seting>

左側

ります

ントチャネルと

メニューバー

左側

(チャネルマーカーが

そのチャネルの

操作
３．１．１． 伝達関数

メイン画面で、解析対象

メニューバー[Set] 

伝達関数 Window 

<Signal Name/Display Channels Seting>

左側の表示チャネルの

ります。(この例の場合

ントチャネルと同じグラフ

メニューバー[Set] 

左側のチャネル表示

チャネルマーカーが

そのチャネルの下に

カレントチャネル

カレントチャネル

出力

伝達関数 Window 
解析対象チャネルを

et] -> で [CommonWave]

Window 機能を Separate View 

<Signal Name/Display Channels Seting>

チャネルの中から、カレントチャネル

場合、Ch1 です。

じグラフ枠内に表示

et] -> で [CommonWave]

表示マーカーの中

チャネルマーカーが反転表示となります

に表示されているチャネルが

カレントチャネル = 入力チャネル

カレントチャネル = 入力

出力チャネル

Window を表示する
チャネルを指定します

ommonWave]にチェックがない

Separate View から使用

<Signal Name/Display Channels Seting>の[Overlap]

カレントチャネル(入力

。) (カレントチャネルは

表示されているチャネルが

ommonWave]にチェックした

中から、カレントチャネル

となります。)

されているチャネルが出力

入力チャネル
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を表示する
します。

にチェックがない場合

使用するときは、

[Overlap]をチェックして

入力チャネル)は

カレントチャネルは必ず左側

されているチャネルが出力チャネルとなります

にチェックした場合は、

カレントチャネル(入力チャネル

出力チャネルとなります

場合は、Separate View 

、必ずメニューバー

をチェックして下さい。

は、チャネル選択

左側に表示されているチャネルの

チャネルとなります

、Common View 

チャネル)は、マーカー

チャネルとなります。

Separate View となります

ずメニューバー[Set] -> [View Channels ...] 

選択リストをマウスでクリックされたチャネルとな

されているチャネルの

チャネルとなります。(この例の場合

Common View となります。

マーカー部がクリックされたチャネルとなります

３． 伝達関数

となります。

> [View Channels ...] 

リストをマウスでクリックされたチャネルとな

されているチャネルの中から選択して

場合、Ch2 です

がクリックされたチャネルとなります

出力チャネル

伝達関数 Window

> [View Channels ...] で表示され

リストをマウスでクリックされたチャネルとな

して下さい。) カレ

です。)

がクリックされたチャネルとなります。

Window

され

カレ

。
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３． 伝達関数 Window

反転表示領域の右側にマウスカーソルをおき、[Shift]キーを押しながら、切り出し範囲を決めます。

③切り出し範囲を決め、ツールバーの  をクリックするか、メニューバー[Analyze] -> [TRANS & COH]をクリックしま す。

前回使用された解析条件に基づく伝達関数 Window が表示されます。

下記の例は、条件設定メニューで<Gain/Phase Common>(後述)にチェックされた例です。

Window 上側は、左 Y 軸は振幅、右 Y 軸を位相スケールとしたグラフです。 下側は、コヒ

ーレンス関数のグラフです。

②次に解析範囲を指定します。ツールバーの をクリックして、切り出し区間を反転表示します。

カーソル位置の振幅値 カーソル位置の位相

カーソル位置の周波数

カーソル位置のコヒーレンス関数

Window 表示時に左端にあるカーソル線をマウスでドラッグすると、その 位

置のデータを読み取ることができます。
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３． 伝達関数 Window

下記の例は、条件設定メニューで<Graph Layout>で[Gain + Phase + COH](後述)が選択された例です。 上から位相、振

幅、コヒーレンス関数の順に別枠にグラフ表示します。

カーソル位置の近傍にマウスカーソルを置き、右クリックするとダイアログが表示されます。[X Zoom In]をクリックすると、現在

のカーソル位置を一番右端にして、グラフ画面を再描画します。(周波数軸方向のズーム表示)

[X Zoom Out]では、拡大された表示を元に戻します。

[Zoom In]が選択されても、条件設定ダイアログの、表示スペクトラ本数(Display Lines)は変更されません。
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３． 伝達関数 Window

④解析条件を変更するには、伝達関数 Window のメニューバーで、[Option] -> [Analysis Cond.]をクリックし、条件設定ダ

イアログを表示します。

次の FFT 処理パラメータについては、「２． FFT 解析 Window」を参考にして下さい。

項目 内容・操作

Title グラフ画面上部に表示されるグラフタイトルを入力できます。

ChX/ChX 現在表示されているグラフの入力チャネル(矢印の元)と出力チャネル(矢印の先)のチャネル番号とチャネル名、物理量単位

を表示します。

Analysis Condition 解析条件を入力します。
FFT Points: 伝達特性解析に使用する FFT 点数を選択します。切り出し区間のデータサイズにより選択できる点数は異なりま

すが、512/1024/2048/4096/8192/16384     のいずれかの選択となります。

Window Func.: FFT 処理を行う時間軸データに対する窓関数処理を行います。

Hanning/Hamming/Blackman/Kaiser_Bessel/FlatTop/Exponential      のいずれかの選択となります。

Overlap: FFT 処理フレームの時間軸上の重なり率を設定します。設定範囲は、0～99%となります。この重なり率を設定する

と、<Ave.Counts>に現在切り出されている範囲での繰り返し FFT 回数が表示されます。

Display Lines: グラフ表示するスペクトラ本数を設定します。表示可能なスペクトラ本数は、設定された FFT 点数の 1/2 まで

です。スペクトラ本数を設定するとグラフ表示される最大周波数が<Max.Frequency>に表示されます。

Gain Axis Auto: チェックを付けると、振幅軸スケールがオートスケールとなります。
Min/Max/Grid: <Auto>のチェックをはずして、手動でグラフ軸スケールを設定します。Gain グラフの Y 軸の表示最小値

(Min)、表示最大値(Max)、1 表示グリッドあたりの振幅値(Grid)を入力します。

Format: [Setting ...]をクリックして表示されるダイアログで、Gain 軸の表示形式を選択します。

Exponential format では桁数指定の指数表記となります。

Fractional format では小数点以下の桁数を指定した表記となります。

Significant format では表示の全桁数を指定した表記となります。

桁数の指定は、<Precision>に数値を入力します。選択された形式と入力された桁数に従い、表記例が<Example>に表示さ れま

す。
DB/LINEAR: Gain 軸のスケールを dB 表示とするかリニア表示とするか選択できます。

Freq Axis Auto: チェックを付けると、周波数軸スケールがオートスケールとなります。
Min/Max: <Auto>のチェックをはずして、手動でグラフ軸スケールを設定します。X 軸周波数軸スケールの表示最小値

(Min)、表示最大値(Max)を入力します。 周波数軸スケールをリニアスケール(LINEAR)にするか対数スケール(LOG)にするか

選択します。

Format: [Setting ...]をクリックして表示されるダイアログで、Gain 軸の表示形式を選択します。

Exponential format では桁数指定の指数表記となります。

Fractional format では小数点以下の桁数を指定した表記となります。

Significant format では表示の全桁数を指定した表記となります。
桁数の指定は、<Precision>に数値を入力します。選択された形式と入力された桁数に従い、表記例が<Example>に表示さ

れます。

Phase Axis 位相軸スケールの表示最小値と最大値をそれぞれリストボックスカラー選択します。最小値は-180 度～０度まで、最大値

は 30 度から 180 度まで、30 度刻みの選択ができます。

Graph Layout グラフのレイアウトを次の３つの中からひとつ選択できます。

(Gain + Phase) + COH: Gain 振幅左側に、Phase 位相を右側にスケール表示したグラフとコヒーレンス関数のグラフを上下に

表示します。

Gain + Grid + COH: 上から順に、振幅、位相、コヒーレンス関数の３つのグラフを表示します。

Gain + Phase: 上から順に、振幅と位相の２つのグラフを表示します。

Visible チェックを付けると値読み取りカーソルを表示します。

Color グラフ各部の色や線色を選択しまスカラーバー部をダブルクリックすると<色の設定>が表示され、色を変更することができま

す。

OK クリックすると、現在入力されている内容を確定し、グラフ表示を変更します。

Cancel クリックすると、入力されている内容の反映は行わず、元のグラフ表示に戻ります。
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３． 伝達関数 Window

切り出し区間を移動すると、連動して伝達関数 Window も変化します。

波形表示 Window のメニューバー、[Option] -> 

[Auto_Scroll Mode]をクリックするとダイアログが
表示され、波形の自動スクロールができます。

３．１．２． Nyquist 線図を表示する

伝達関数 Window の左端にマウスカーソルを置き、カーソル表示が<⇔>になった時に、マウスを右にドラッグすると Nyquist 

線図グラフが表示されます。
伝達関数 Window のグラフ上でカーソルを移動すると、Nyquist 線図の同じ周波数位置にクロスカーソル線が移動します。

３．１．３． 切り出し区間の表示移動と解析結果の表示連動

メニューバー[Window]から、[Horz Tile]または[Vert Tile]をクリックすると、メインの波形表示 Window と伝達関数 Window を

水平方向、または垂直方向に並べて表示することができます。

このとき、メインの波形表示 Window の切り出し範囲である反転表示部分をマウスで移動すると、伝達関数 Window の解析

結果も連動して変化します。

メニューバーおよびツールバーの表示内容は、現在のカーソルが、波形表示、もしくは伝達関数 Window のどちらの Window 

に存在するかによって異なります。上の表示例では、カーソルは波形表示 Window に存在し、波形表示 Window の操作が

有効です。このとき伝達関数 Window に関する操作を行うためには、マウスを伝達関数 Window のいずれかの位置でクリッ

クします。

⇔、マウスを右にドラッグ
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３． 伝達関数 Window

３．２． 解析結果の保存
伝達関数 Window の右端にマウスカーソルを置き、カーソル表示が<⇔>になった時に、マウスを左にドラッグすると伝達関

数演算結果リストが表示されます。表示された内容を、CSV ファイルに保存することができます。

３．３． グラフのプリントアウト
メニューバー[File]から、[Print...]を選択すると、表示されている伝達関数グラフのプリントアウトができます。

[Print Preview]では、プリントプレビューを行うことができます。
[Print Setup...]では、用紙の向きやプリンタの設定を行うことができます。

ファイル情報の表示

演算結果リスト表示

クリックするとリスト表示内

容を CSV ファイルで保存

できます。

⇔、マウスを左にドラッグ

左側グラフのカーソル線位置のデー

タがハイライト表示されます。
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３． 伝達関数 Window

このページはブランクです。



Page 27

４． Waterfall 解析 Window

４． Waterfall 解析 Window
メイン画面で、解析範囲指定されたカレントチャネルと解析範囲指定されたカレントチャネルの FFT 演算結果を WATERFALL 形式で

表示します。デフォルトでは直前に設定されていた条件でグラフ表示が行われます。直前に設定されていた条件が不整合の場合、グ

ラフは表示されず解析条件変更メッセージが表示されます。

◆ FFT 点数: 512, 1024, 2048, 4096, 8192, 16384 から選択できます。

◆ 窓関数: ハニング、ハミング、ブラックマン、カイザーベッセル、エクスポネンシャル、フラットトップ、Off から選択できます。

◆ 解析タイプ: スペクトラム(尖塔値または rms 値)、パワースペクトラム、パワースペクトラム密度、エネルギースペクトラム密度から

選択できます。

◆ 3 次元グラフ表示形式は、カラーマップまたはカーブの選択ができます。

◆ Z 軸属性は、連続時間、時間間隔、参照チャネル刻み指定、MARK から選択できます。

◆ 解析結果を CSV ファイルに保存することができます。
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４． Waterfall 解析 Window

４．１． 操作
４．１．１． Waterfall 解析 Window を表示する
① メインの波形表示画面で FFT 解析対象の区間を切り出します。

このとき、解析対象チャネルをカレントチャネルに指定しておきます。

② メニューバーの、[Analyze] -> [Waterfall ...]をクリックするか、ツールバーの、   をクリックすると Waterfall 解析
Window が表示されます。デフォルトで表示される解析条件は、前回使用されたときの条件となります。

グラフ描画スタイルを変更するには、次に説明する設定ダイアログの<Graph Type>で設定します。

カレントチャネルに設定された Ch1 の切り出し区

間データの Waterfall 解析を行います

ここに表示されたグラフタイトル、および解析条件、各軸スケールは、

次に説明する[Analysis Condition...]で変更できます。
Color Map

Curve
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４． Waterfall 解析 Window

Waterfall グラフ上の値は、カーソルを表示して読み取ることができます。 カーソルを表示す

るには、次に説明する設定ダイアログの<Cursor Condition>で設定します。

<Off>ではカーソルを表示しません。(前ページのグラフです。)

<X-Axis>で[Separate]を選択すると、次のカーソル表示となります。

<X-Axis>で[Fixed]を選択すると、次のカーソル表示となります。

抽出スペクトラムグラフのカーソルはマウスドラッグま た

は上下矢印キー移動できます。

現在カーソル位置の断面データを表示します。

マウスをドラッグ、または左右矢印キーで、ここを支点としてカーソルは

X 軸上を移動します。 支点を移動するには、マウスの右ボタンをクリッ

クします。
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４． Waterfall 解析 Window

<Z-Axis>を選択すると、次のカーソル表示となります。

各画面でのカーソル操作方法まとめ

Z 軸カーソル設定時、選択されたスペクトラムグラフを下段に表示 X 軸カーソル設定時、選択された周波数のスペクトラムグラフを上段に表示

傾斜を保ったままカーソル移動     →Cntl+左ボタンドラッグ、Cntl+左右矢印キー
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４． Waterfall 解析 Window

③ 必要に応じて、Waterfall 解析条件を変更します。Waterfall 解析 Window のメニューバー[Option] -> [Analysis 

Condition...]をクリックするします。

解析条件設定<Analysis Condition>の設定内容 内容については、

「２．FFT 解析 Window」を参照して下さい。
項目 内容

Analysis Type 得ようとする解析結果を選択します。

振幅の場合 Spectrum(ス

ペクトラム): A
実効値の場合

Spectrum(rms): A/√2 (= Arms) 

Power Spectrum: Arms ^2 (= Prms)
Power Spectrum Deisity = Prms/⊿f (= PSD)

なお、⊿f は次の計算式から得られます。⊿f=fs(サンプリング周波数)/m(FFT Points FFT 点数)

Energy Spectrum Density = PSD x FFT フレーム周期

なお、FFT フレーム周期は、次の計算式から得られます。  FFT Points x サンプリング周期

Window Func 処理する時間軸データにかける窓関数を選択します。
Hanning(ハニング), Hamming(ハミング), Blackman(ブラックマン), Kaiser_Bessel(カイザーベッセル), FlatTop(フラッ

トトップ), Exponantial(エクスポネンシャル), Off(レクタンギュラ)

Exp. Window Param Exponantial が選択されたとき有効となります。t0(FFT フレーム内の窓開始点)および窓の幅をデータポイントで設

定できます。

FFT Points FFT 解析するフレーム長（データ点数）を選択します。選択は、512, 1024, 2048, 4096, 8192, 16284 から行え
ます。平均化処理を行わない場合、設定されている解析範囲指定の開始点からここで設定したフレーム長までを

解析対象とします。

次ページに続く

グラフタイトル設定<Title>:

FFT 解析グラフにここで入力されたグラフタイトルを表示します。初期値は､直前に設定された内容となります。

<Title>の右側にカレントチャネル番号およびチャネル名と単位が表示され、解析対象のチャネルを示します。

<Cursor Condition>: グラフ画面にカーソルを表示します。

解析条件設定<Analysis Condition>:  Waterfall 解析条件を設定します。

表示軸設定<X-Axis><Y-Axis><Z-Axis>: 軸スケールを設定します。

<Graph Type>: グラフ描画タイプを選択します。

グラフ画面色設定<Graph Color Condition>/Color Map の色スケール<Z-Axis Color Map>: それぞ

れのカラーバーをクリックすると、カラーパレットが表示されグラフ各部分の色の変更ができます。

[OK]をクリックするとここに表示された設定を確定し、解析内容を

変更し Waterfall グラフ Window に戻ります。
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４． Waterfall 解析 Window

前ページより

項目 内容

Display Lines 表示するスペクトラ本数を選択します。設定可能な最大表示スペクトラ本数は選択した FFT フレーム長の 1/2 ま
でとなります。FFT フレーム長を変更すると初期値に戻ります。

選択された FFT Poin s 表示スペクトラ初期値 表示スペクトラ最大値

512 200 255

1024 400 511

2048 800 1 23

4096 1600 2047

8192 3200 4095

16284 6400 819

0Hz(直流分)のスペクトラは表示されません。表示スペクトラ本数を設定すると、表示最大周波数が演算され設

定欄の右側<Max. Frequency>に表示されます。

サンプリング周波数（Fs）と FFT Points、Display Lines の関係は次のようになっています。

Max. Frequency = (Fs / FFT Points) x Display Lines  (Fs / FFT Points = ⊿f)

Ave Counts 1 組のスペクトラムを複数回の FFT 処理を行い平均スペクトラとする場合の平均化回数を指定します。初期値は

1(回)となります。

Overlap 後述する Z 軸モードが CONT 以外は平均化処理回数が 1 以上の場合に有効で、繰り返される FFT 処理の重なり

率を設定できます。設定可能な値は 0～99%範囲となります。CONT は平均化回数 1 でも有効です。

Z-Axis Angle: グラフ Z 軸方向の角度を選択します。選択可能な角度は 0,5,10,15,20 となり、初期値は 20 度となりま

す。

Mode: Z 軸属性を、CONT、TIME、MARK、REFCH の 4 種類から選択できます。

CONT: 時間経過に伴ったスペクトラムの変化を見る時に選択するもので、データの並び順（時間軸）方向に、設

定された FFT フレーム毎に連続的に切り出し処理を行い、それを並べた形式となります。従って Z 軸の属性は時

間となります。

TIME: 基本的には、CONT と同じ意味を持ちますが、パラメータとして Step が有効となり、明示的に FFT 処理を行

う時間間隔を設定します。例えば、Step に 10 と設定した場合は、時間軸上 10 秒毎に FFT 処理を行い、それを

並べた形式となります。なお、平均化回数が設定されている状態で  FFT 処理対象データの長さが設定された増

分値（時間間隔）を越えてしまう場合は時間間隔が優先され平均化回数はとり得る回数までの処理を行います。

MARK: 解析範囲の MARK 位置毎に FFT 処理を行い、それを並べた形式となります。パラメータは Step と Ref.ch

が有効となります。Step は、MARK 番号の飛び越し数で、初期値は 1、つまり MARK 毎に処理を行います。また、

Z軸はTIMEと同じ属性ですがスケールはMARK番号スケールとなり、スケール表示値は、参照チャネルで設定し

たチャネルのデータ値が表示されます。

REFCH: 収録データの任意のチャネルデータを Z 軸とするもので、Z 軸データの変化に伴うスペクトラム変化を見

る時に選択するものです。パラメータは Step と Ref.ch となります。Step は Z 軸に設定されたチャネルの増分値を

意味し、解析範囲指定されたZ軸チャネルの始めから増分値で設定された値を加算した地点毎にFFT処理を行

います。なお、Z 軸に設定されチャネルのデータは、昇順または、降順になっている必要があります。昇順/降順の

判定は Z 軸チャネルの解析範囲の先頭データと最終データを大小比較して行います。

Y-Axis Axis Attb.: LINEAR スケールまたは LOG スケールから選択します。

Auto/Max/Min: Auto にチェックを行うとオートスケールで表示します。オートスケールは表示するすべてのスペク

トラの最小値と最大値から参照されます。軸属性が LINEAR の場合は、最大値のみ参照されグラフの最小値は 0

となります。また、軸属性に LOG が選択された場合は最小値を含むディケードの開始値、例えば、最小値が 0.23

の場合は 0.1 がグラフの最小値となります。また、グラフの最大値は求めた最大値を含むディケードの終了値、例

えば最大値が 123.45 の場合は 1000  がグラフの最大値となります。表示スケールをマニュアル設定する場合

は、Auto チェック Box のチェックを取ります。チェックを取ると、スケール最大値(Max)最小値(Min)入力が有効と

なります。Y 軸属性に LOG スケールが選択された場合、Y  軸はディケード単位で増減し、左端は一次の周波数

（⊿f）が含まれるディケード開始周波数、右端は表示スペクトラ本数から演算された周波数を含むディケードの終

了周波数となります。LINEAR スケールを選択した場合、左端は 0Hz、右端は設定した表示スペクトラム本数から

求めた周波数となります。

Fromat: Y 軸目盛値表示形式の設定を行います。現在使用されている表示形式が表示されます。表示形式を変

更する場合は、表示欄右側の[Setting]ボタンをクリックします。クリックされるとフォーマット設定ダイアログが表示

されます。

X-Axis Axis Attb.: LINEAR スケールまたは LOG スケールから選択します。LINEAR   スケールを選択した場合、左端は

0Hz、右端は設定した表示スペクトラム本数から求めた周波数となります。また、LOG  スケールを選択した場合、

グラフはディケード単位で増減し、左端は一次の周波数（Δf）が含まれるディケード開始周波数、右端は表示ス

ペクトラ本数から演算された周波数を含むディケードの終了周波数となります。

Format: X 軸目盛値表示形式の設定を行います。現在使用されている表示形式が表示されます。表示形式を変

更する場合は、表示欄右側の[Setting]ボタンをクリックします。クリックされるとフォーマット設定ダイアログが表示

されます。

次ページに続く
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Cursor Condition

Graph Type

Color

Z-Axis Color Map

４．２． 解析結果の保存
４．２．１．
Waterfall 

Waterfall 

イル名
拡張子

WaterFall Analysis Waterfall
4chData.hdr
Spectrum
REFCH
No

保存

1 行目

刻。

2 行目

3 行目
4 行目

は単位

5行目

のスペクトラムの

6 行目以降

軸値

４．３． グラフのプリントアウト
表示

します
[Print Pre

[Print Setup...]

ページより

項目

Cursor Condition

Graph Type

Color

Axis Color Map

解析結果の保存
４．２．１． Waterfall 
Waterfall 解析結果

Waterfall 解析 Window 

名を付けて保存
拡張子 csv のテキストファイル

WaterFall Analysis Waterfall
4chData.hdr Ch1
Spectrum
REFCH 1rpm

Frequency(Hz)

保存される数値桁は

行目 1 列目 Water

行目 1 列目解析

行目 1 列目 FFT 
行目 1 列目 Z 軸属性

単位のみ)、3 列目

行目は、解析結果

のスペクトラムの Z 軸値

行目以降は解析結果行

軸値、4 列目同様。

グラフのプリントアウト
表示されている Waterfall

します。
[Print Preview]では

[Print Setup...]では

1 0.00E+00
2 4.88E+00
3 9.77E+00
4 1.46E+01
5 1.95E+01
6 2.44E+01
7 2.93E+01
8 3.42E+01
9 3.91E+01

10 4.39E+01
11 4.88E+01
12 5.37E+01
13 5.86E+01
14 6.35E+01
15 6.84E+01
16 7.32E+01

カーソル
形式

いずれかを

各

グラフ
描画色

のカラーボタンをクリックします

グラフ

設定

参照

解析結果の保存
Waterfall 解析結果をファイルに保存する

解析結果を csv ファイルに

Window のメニューバー

保存することができます
のテキストファイル形式

WaterFall Analysis Waterfall Analysis 10/11/2006
X Axis Acc

1024 Off
Rotational Speed

Frequency(Hz) 2.68E+03 2.68E+03 2.68E+03 2.68E+03 2.68E+03 2.69E+03 

は、設定されている

Water Fall Analysis

列目解析ファイル名、2 

FFT 解析タイプ、2 
軸属性(CONT、TIME

列目 Z 軸信号名(

解析結果のHeaderLine

軸値、5 列目以降

解析結果行。1 列目次数

。

グラフのプリントアウト
Waterfall グラフをプリントアウトするには

では、プリントプレビューを

では、用紙の向きやプリンタの

0.00E+00
4.88E+00
9.77E+00
1.46E+01
1.95E+01
2.44E+01
2.93E+01
3.42E+01
3.91E+01
4.39E+01
4.88E+01
5.37E+01
5.86E+01
6.35E+01
6.84E+01
7.32E+01

カーソル表示機能は
形式、Z-Axis はカーソル

いずれかを選択できます

各スペクトラムを線(Curve)

グラフ色はグラフ外側背景色
描画色(ScaleValue）、

のカラーボタンをクリックします

グラフ形式に Color Map 

設定した色毎の境界

参照されます。

解析結果をファイルに保存する
ファイルに保存することができます

のメニューバー、[File] -

することができます。
形式で保存されます

10/11/2006 15:52:14
G 

0% 
Speed

2.68E+03 2.68E+03 2.68E+03 2.68E+03 2.68E+03 2.69E+03 

されている解析条件設定

Analysis 固定 Keyword

2 列目解析チャネル

2 列目 FFT 点数
TIME、MARK、REF.CH

(ただし TIME、CONT

HeaderLine。1列目No.、2

列目以降スペクトラム

列目次数 1～表示

グラフのプリントアウト
グラフをプリントアウトするには

プリントプレビューを行うことができます

きやプリンタの設定

0.016 0.007
0.019 0.011
0.021 0.013
0.013 0.006
0.032 0.026
0.04 0.034

0.046 0.042
0.429 0.432

0.2 0.209
0.098 0.105
0.129 0.136
0.034 0.028
0.038 0.039
0.026 0.017
0.055 0.048
0.054 0.047
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は OFF、X-Axis、Z-
はカーソル線が Z 軸上に

できます。

(Curve)で表示するか

外側背景色(Outside）、
）、およびカーソル線色

のカラーボタンをクリックします。クリックされるとカラーパレットダイアログが

Color Map を選択した場合

境界は連続的に色変化

解析結果をファイルに保存する
することができます。

-> [Result Save]

されます。Waterfall 

2.68E+03 2.68E+03 2.68E+03 2.68E+03 2.68E+03 2.69E+03 

解析条件設定ダイアログ上

Keyword、2 列目設定

チャネル番号、3 列目解析

点数、3 列目 Window 
REF.CH のいずれか

CONT の時は TIME

2列目Frequency(Hz)

スペクトラム本数に依存した

表示スペクトラ本数

グラフをプリントアウトするには、Waterfall

うことができます。

設定を行うことができます

0.006 0.003
0.009 0.005
0.012 0.009
0.005 0.007
0.025 0.023
0.034 0.032
0.042 0.042
0.433 0.437
0.21 0.217

0.106 0.109
0.138 0.142
0.028 0.028
0.039 0.037
0.016 0.01
0.047 0.046
0.046 0.039

内容

-Axis の 3 種から選択
に移動する形式となります

するか、カラー濃淡(ColorMap)

）、グラフ内側背景色
線色(CurorLine）を個別

クリックされるとカラーパレットダイアログが

場合、グラフ Y 軸の最大値

色変化されます。グラフ形式

解析結果をファイルに保存する

ave]をクリックします

Waterfall 表示されたチャネルの

2.68E+03 2.68E+03 2.68E+03 2.68E+03 2.68E+03 2.69E+03 2.69E+03

上の Y 軸スケールフォーマット

列目設定された TITLE(表題

列目解析チャネル

Window 名、4 列目
のいずれか)、2 列目 Step

TIME に固定、信号名

Frequency(Hz)固定、3

した列数が生成される

本数-1 まで、2 列目周波数値

Waterfall 解析 Window

うことができます。

0.005 0.01
0.006 0.01
0.01 0.013
0.01 0.015

0.024 0.025
0.032 0.033
0.042 0.045
0.44 0.445
0.22 0.224

0.111 0.113
0.144 0.146
0.029 0.033
0.037 0.034
0.008 0.009
0.046 0.048
0.036 0.031

内容

選択します。X-Axis 
となります。X-Axis 選択

(ColorMap)で表示するかを

内側背景色(Inside）、グラフグリッド
個別に設定できます

クリックされるとカラーパレットダイアログが表示

最大値から最小値までを

形式に Curve を選択

をクリックします。ファイル保存

されたチャネルの解析結果

2.69E+03

スケールフォーマット

表題)、3 列目解析年月日

チャネル信号名、4 列目

列目 overlap 率。
Step 値+Z 軸単位

信号名が空欄の

3列目先頭スペクトラムの

される。

列目周波数値、3

Window のメニューバー

0.011
0.01

0.013
0.016
0.026
0.034
0.045
0.445
0.225
0.113
0.147
0.034
0.034
0.01

0.049
0.03

４． Waterfall 

Axis はカーソル線が X 
選択した場合は Fixed 

するかを選択します。

グラフグリッド線色(GridLine)
できます。 色を変更する場合

表示さ れます。

までを 5 段階に着色

選択した場合は、Min で

保存ダイアログが

解析結果がファイルに

スケールフォーマット設定に従属します

列目解析年月日、4

列目もとの信号

。
軸単位(ただし MARK

の場合は参照チャネル

スペクトラムのZ軸値

3 列目当該周波数

のメニューバー、[File] -> [P

Waterfall 解析 Window

X 軸上に移動する
Fixed か Separate の

(GridLine)、グラフ目盛値
場合、各項目の右

着色できます。また、

で設定した色のみ

ダイアログが表示され、ファ

がファイルに保存されます。

します。

4 列目 解析時

信号の単位。

MARK、CONT の時

チャネル番号)。

軸値、4列目 次

列目当該周波数における Y 

Print]をクリック

Window

。

Y 
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４． Waterfall 解析 Window

このページはブランクです。
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５． 1/n オクターブ解析解析 Window

５． 1/n オクターブ解析 Window
メイン画面で、解析範囲指定された範囲内にある同じ信号単位のデータから、最大４チャネル分のデータを 1/n オクターブ解析しま

す。

◆ 最大４チャネル表示できます。

◆ 時間軸フィルタ方式を採用しています。

◆ オクターブ分割数は、1,2,3,4,5,6,7,8,9,10,11,12 から選択設定できます。初期値は 3 となります。

◆ グラフの Y 軸スケールを dB 量で基準化して表示可能です。

◆ Y 軸物理量表示 1/ｎオクターブ分析グラフを表示できます

◆ 分解された各バンドの移動実効値時間軸波形を表示できます。

◆ 分析された各バンドの実効値の時間軸変化をコンターマップ（カラー濃淡図）で表示できます。
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５． 1/n オクターブ解析解析 Window

５．１． 操作
５．１．１． 1/n オクターブ解析 Window を表示する
① メインの波形表示画面でオクターブ解析対象の区間を切り出します。 このとき、解析対象チャネルをカレントチャネルに

指定しておきます。波形表示画面で選択されたカレントチャネル以降に存 在し、同じ単位のチャネル最大４つまでを自動表

示対象とします。

② メニューバーの、[Analyze] -> [1/3 Octabe]をクリックするか、ツールバーの、   をクリックすると1/nオクターブ解

析 Window が表示されます。デフォルトで表示される解析条件は、前回使用されたときの条件となります。 ただし、プログラ
ム初回起動時、あるいは解析条件が不整合な場合は、何も表示されない Window とともに③の解析条件 設定ダイアログ
が表示されます。この場合、③にしたがって先に解析条件を設定します。

Y 軸物理量 1/n オクターブ分析グラフの表示例

移動実効値波形表示グラフの表示例

カラーコンターマップグラフの表示例



③ 1/

更する

表示

グラフタイトルの

れた

解析

解析

ドは、

択は
※注意

移動実効値積分周期

0.63

グラフ

表示

どれを

③ 1/ｎオクターブ解析条件

する場合、1/ｎオクターブ

表示されます。

グラフタイトルの設定

れた文字列も同 様にグラフ

解析バンドの設定

解析バンドは、最小

、解析範囲の指定

は、1,2,3,4,5,6,7,8,9,10,11,12
注意  選択する周波数

心周波数ではありません

ようになります

移動実効値積分周期

0.63、1.0sec から選択

グラフ種類の種類の

表示するグラフを、

どれを表示するか選択

解析最小

この値とサンプリング

解析条件ダイアログが

オクターブ解析

設定 グラフタイトルは

にグラフ上部に

最小オクターブバンド

指定された時間軸幅

1,2,3,4,5,6,7,8,9,10,11,12
周波数は、選択値

ではありません。

ようになります。

移動実効値積分周期の設定 バンド

選択します。

の選択

、Y 軸物理量 1/3 

選択します。

グラフタイトル

解析最小オクターブバンドの

とサンプリング周波数

移動実効値演算

ダイアログが表示された

Window のメニューバー

グラフタイトルは、<Title>に入力

に表示されます。

オクターブバンド中心周波数と

時間軸幅を周期とした

から選択できます
選択値を中心とするオクターブバンドの

。例えば中心周波数

バンド毎実効値を時間軸

1/3 オクターブ分析

設定: 

オクターブバンドの中心周波数値を

周波数で自動的に設定されます

移動実効値演算の積分周期

<OK>: 設定されたパラメータでグラフを
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された場合は、下記

のメニューバー[Set] 

入力された文字列

。解析内容の Memo 

と Octave_Band

とした周波数以上

できます。
とするオクターブバンドの

中心周波数を 0.125、

時間軸で表示する

分析グラフ、移動実効値波形表示

を選択します。表示範囲

されます。

積分周期を選択します

されたパラメータでグラフを

下記に従って解析条件

et] -> [Condition]

文字列をグラフ上部に

Memo として使用

Octave_Band の分割数<Octave

周波数以上を設定します。

とするオクターブバンドの中心周波数

、バンド分割数を

する際に必要な

移動実効値波形表示

表示範囲は、

します。

されたパラメータでグラフを表示します。

５． 1/n 

解析条件を設定します

ondition]をクリックすると

に表示します。<Model>

使用して下さい。

<Octave Band Div>

。また、<Octave Band Div>

中心周波数であり、グラフ

を 3 とした場合

な解析パラメータです

移動実効値波形表示グラフ、カラーコンターマップグラフ

バンド分割数を選択

表示するグラフの

Y 軸スケールは

(Max)・最小値(Min)

単位として dB を

できます。

カラーコンターマップにおける

設定できます。

1/n オクターブ解析解析

します。 または、

ックすると解析 条件設定

<Model>および<Place>

Div>で設定します。

<Octave Band Div>を選択

グラフ表示される最小

場合に表示されるグラフは

パラメータです。0.1、0.125

カラーコンターマップグラフ

選択します。初期値

するグラフの種類を選択します

スケールは Auto か、またはスケール

(Min)を入力することができます

を選択したときは、0dB

カラーコンターマップにおける各レベルの

オクターブ解析解析 Window

、設定内容を変

条件設定ダイアログが

<Place>に入力さ

。解析開始バン

選択します。選

最小バンドの中

されるグラフは下図の

0.125、0.25、

カラーコンターマップグラフ、の内

初期値は 1/3 です。

します。

またはスケール最大値

することができます。また、

0dB 相当値の入力が

レベルの色 を

Window

さ

バン

選

の

内

最大値

、

が
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５． 1/n オクターブ解析解析 Window

Y 軸スケールの設定

Y 軸スケールの設定項目は、Scale を自動(Auto)とするか、または手動で設定するか、Y 軸を dB で基準化するか否かの 2 

点です。
Scale の選択は、<Auto>を選択する場合は、チェックボックスにチェックマークを付けます。また、手動で行う場合は、チェッ

クボックスをアンチェックした後、グラフの最大値<Max>、最小値<Min>、およびグリッド間隔<Grid>を設定します。ただし、後

述する Y 軸を dB で基準化しない場合は自動的に LOG_SCALE が採用されるため、グリッド間隔設定は不要です。また、最

小値設定に 0以上の値を設定する必要があります。
Y 軸を dB 単位で基準化する場合、ｄB チェックボックスにチェックした後、0dB 相当の物理量を設定します。例えば、音圧
(Pa)を SPL（音圧レベル）に変換する場合、0dB は、20μPa （20e-6）と設定します。

カラーコンター（濃淡）色の設定

バンド毎カラーコンターマップグラフにおける各レベル表示に使用する色を設定します。カラーレベルは５段階で、各段階別

に色が設定できます。「GraphType」に「Contou Graph」を選択すると「Color Map」が活性化し、その状態でカラーボタンをクリ

ックすると色の設定ダイアログが表示され、当該レベルの色を設定できます。
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５． 1/n オクターブ解析解析 Window

Y 軸物理量表示 1/8 Octave 分析グラフ表示例

５．１．２． 1/ｎオクターブ分析グラフを表示する
①1/ｎオクターブ解析条件ダイアログで[Band Graph]を選択し[OK]がクリックされると、設定された条件に従って 1/ｎオクタ

ーブ分析グラフを表示します。

デフォルトで表示される解析条件は、前回使用されたときの条件となります。 表示される周波数バンドは、設定さ

れた最小バンド中心周波数とサンプリング周波数から自動的に設定されます。

② グラフの操作

Cursor の操作

Corsor の操作は、キーボード上の左右矢印キーを押すことにより行います。

現在カーソル位置は、グラフ上枠外に赤▼印にて知らせます。また、カーソ

ル位置バンドの実効値は、グラフ枠右側リスト上に数値として表示します。

表示チャネルの ON/OFF の操作

グラフ枠右側リストのチェック BOX をアンチェックすると表示しません。

グラフチャネル表示色の設定

グラフ枠右側リストの Color ボタンをクリックします。クリックされると色の設定ダイアログが表示され、表示色を設定できます。

カーソルを左右にドラッグすると、カーソル位置の周 波

数バンドでの Y 軸値を右側のリストに表示します。

解析チャネルの信号名が参照されます。

表示軸の選択は、チェックボックスをチェックすると 表

示、アンチェックすると非表示となります。

グラフ表示色を変更するには、カラー

バーの位置にカーソルを置き右クリッ

ク し ま す 。 表 示 さ れ る <Change 

Color...>をクリックしてカラーパレットを
表示します。

グラフ右端の値はオーバーオール値です。

Y 軸物理量表示 1/3 Octave 分析グラフ表示例
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５． 1/n オクターブ解析解析 Window

５．１．３． バンド毎、移動実効値波形表示グラフを表示する

① 1/ｎオクターブ解析条件ダイアログで[Time Graph]を選択し[OK]がクリックされると、設定された条件に従って各バンドの

移動実効値トレンドグラフを表示します。

② グラフの操作

カーソル線の操作

グラフ枠内をクリックするとカーソル線が表示されます。カーソル線は、左右ドラッグすることで移動できます。カーソル線位

置の移動実効値はグラフ枠右リスト上に表示されます。

表示チャネルの変更 グラフは一度に１チャネル分の全てのバンド移動実効値を表示します。表示チャネルの切り替えは、

グラフ枠右側リスト上部 のタブをクリックします。

表示バンドの ON/OFF 設定

表示初期値はすべてのバンドが表示対象に設定されています。表示 ON/OFF は、グラフ枠右側リスト上のチェックボックスを

チェックすると表示、アンチェックすると非表示に設定できます。また、同時に連続した複数バンドを設定する場合は、設定し

たい最初の行のチェックボックスを操作後、シフトを押しながら同じ設定をしたい最終行のチェックボックスを操作すると、同

時に複数行の設定か可能です。

バンド表示色の設定

グラフ枠右側リスト上のカラーボタンをクリックします。クリックするとカラーパレットダイアログが表示され、表示色を選択でき

ます。
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５． 1/n オクターブ解析解析 Window

５．１．３． バンド毎カラーコンターマップグラフを表示する
① 1/ｎオクターブ解析条件ダイアログで[Contour Graph]を選択し[OK]がクリックされると、設定された条件に従ってカラー

コンターマップグラフを表示します。

グラフは、X 軸に時間、Y 軸にバンド中心周波数をとり、バンド毎移動実効値をカラーで表示します。また、カラーコンターマッ

プグラフ右側に、カーソル線で示される時刻位置の移動実効値グラフを表示します。

② グラフの操作

カーソル線の操作

コンターマップグラフ枠内をクリックするとカーソル線がクリック位置に移動します。また、カーソル線をドラッグしても移動でき

ます。
カーソル線位置における移動実効値はグラフ枠右側に表示され、カーソル位置の移動に連動して表示します。

表示チャネルの設定 コンターマップ表示枠右上のリストボックスに表示されているチャネル名を表示しています。このリスト

ボックスから表示したい チャネルを選択します。



５．１．
オクターブバンド

周波数

ラフ上平坦

５．２． 解析結果の保存
５．２．１．
1/n 

メニューバー

きます

拡張子

格納

実効値

定されている

1/3 Octave Analysis
FILE:
TITLE:
Center

５．３． グラフのプリントアウト
表示

をクリックします
[Print Pre

[Print Setup...]

５．１．4． オクターブバンド解析の留意点
オクターブバンド解析

周波数が上昇するにしたがって

上平坦ではなく

解析結果の保存
５．２．１． 1/n 
1/n オクターブ解析結果

メニューバー[File] 

きます。

拡張子 csv のテキストファイル

格納される内容は、

実効値となります。ただし

されている解析条件

1/3 Octave Analysis
FILE:
TITLE:
Center Freq

0.1
0.125
0.16
0.2

0.25
0.315

0.4
0.5

0.63
0.8

1
1.25
1.6

グラフのプリントアウト
表示されている1/n

をクリックします。
[Print Preview]では

[Print Setup...]では

オクターブバンド解析の留意点
解析では各バンドの

するにしたがって、バンド

ではなく中心周波数の

解析結果の保存
1/n オクターブ解析結果をファイルに保存する

解析結果を csv ファイルに

ile] -> [Save as]をクリックします

のテキストファイル形式

、解析区間全体

ただし、解析条件

解析条件にしたがいます

1/3 Octave Analysis
4chData.hdr
One Third Octave
X Axis Acc(dB)

0.1 29.347776
0.125 32.276854
0.16 33.169142
0.2 34.184185

0.25 34.916292
0.315 35.16803

0.4 35.295295
0.5 34.109669

0.63 33.760995
0.8 33.331314

1 32.416874
1.25 31.264811
1.6 30.028051

グラフのプリントアウト
1/nオクターブグラフをプリントアウトするには

では、プリントプレビューを

では、用紙の向きやプリンタの

オクターブバンド解析の留意点
バンドの実効値を求めてグラフ

バンド幅が広がっています

の上昇とともに、右肩上

オクターブ解析結果をファイルに保存する
ファイルに保存することができます

をクリックします。

形式で保存されます

解析区間全体の各バンドに於

解析条件で dB 指定の

にしたがいます。

Octave
Acc(dB) Y Axis Acc(dB) Z Axis
29.347776 30.152362
32.276854 33.13211
33.169142 33.83203
34.184185 34.695354
34.916292 35.701009
35.16803 35.979971

35.295295 35.640103
34.109669 34.408143
33.760995 34.115021
33.331314 33.138453
32.416874 32.617387
31.264811 32.361522
30.028051 30.653476

グラフのプリントアウト
オクターブグラフをプリントアウトするには

プリントプレビューを行うことができます

きやプリンタの設定
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オクターブバンド解析の留意点
めてグラフ上同

がっています。そのため

右肩上がりのグラフとなります

オクターブ解析結果をファイルに保存する
することができます

。ファイル保存ダイアログが

されます。 格納機能

於ける

の場合は、dB に

0 56415

Y Axis Acc(dB) Z AxisAcc(dB)
30.152362 34.331346
33.13211 37.312318
33.83203 37.990044

34.695354 38.912896
35.701009 39.969758
35.979971 40.056722
35.640103 39.98006
34.408143 39.170592
34.115021 37.796676
33.138453 37.672153
32.617387 36.339533
32.361522 36.064831
30.653476 35.348461

オクターブグラフをプリントアウトするには、1/n

うことができます。

設定を行うことができます

上同じ幅で表示していますが

そのため、フラットな

がりのグラフとなります。

オクターブ解析結果をファイルに保存する
することができます。

ダイアログが表示

格納機能そのものは、表示

に変換した結果を

56415 56416

Acc(dB)
34.331346
37.312318
37.990044
38.912896
39.969758
40.056722
39.98006

39.170592
37.796676
37.672153
36.339533
36.064831
35.348461

1/nオクターブ解析

うことができます。

５． 1/n 

していますが、各バンド

フラットな周波数特性

。

表示され、ファイル

表示グラフが何

を格納します。なお

解析Windowのメニューバー

1/n オクターブ解析解析

バンド幅は一定

周波数特性を持つ信号を

ファイル名を付けて保存

何れの場合でも機能

なお、オクターブの

のメニューバー、[F

オクターブ解析解析 Window

一定ではなく、中心

を解析すると、グ

保存することがで

機能しますが、

オクターブの分割数も設

File] -> [Print] 

Window

中心

グ

することがで

、

設

rint] 
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６． 度数分布解析 Window

６． 度数分布解析 Window
メイン画面で、解析範囲指定された範囲内にある同じ信号単位のデータを度数分布解析してグラフ表示を行います。

◆ 度数分布解析のレンジとスライス数を設定できます。

◆ 解析結果をリスト表示することができます。
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６． 度数分布解析 Window

６．１． 操作
６．１．１． 度数分布解析 Window を表示する
① メインの波形表示画面で度数分布解析対象の区間を切り出します。 このとき、解析対象チャネルをカレントチャネルに

指定しておきます。波形表示画面で選択されたカレントチャネル以降に存 在し、同じ単位のチャネルを自動表示対象としま

す。

下記の表示例では、Ch1からCh3までの物理量単位が<G>、Ch4が<rpm>で、カレントチャネルをCh1と設定したため、Ch1 

から Ch3の解析結果グラフが表示されます。

②  メニューバーの、[Analyze]  ->  [Distribution]をクリックするか、ツールバーの、    をクリックすると度数分布解析

Window が表示されます。デフォルトで表示される解析条件は、前回使用されたときの条件となります。 度数分布グラフ左
のリストには、範囲指定されたすべてのチャネルのうち、後述する解析条件設定ダイアログで解析Onに設 定されたチャネル
がリスト表示され、右側の度数分布グラフに表示されているチャネルはリストのチェックボックスにチェック を付け示します。
同一の度数分布グラフで表示できるチャネルは同じ物理量単位のチャネルに限られます。

この例ではカレントチャネルは Ch1。

Ch1 ～ Ch3 ま で 物 理 量 単 位 は

<G>、 Ch4 は<rpm>。

<ALL>にチェックを付け、チャネルリストの表示 Off のチャ

ネルのチェックを付けると、そのチャネル以降に存在し、物

理量単位同一の表示 Off チャネルがすべて自動的にチェ

ック状態となり表示 On状態となります。
[List]をクリックすると、解析結果をリス ト

表示します。詳細は後述します。

Y 軸スケールは、下記の設定画 面

で、<%>( この例)または< 計数
(カウント数)>の選択ができます。

グラフ表示色を変更するには、カラーバ

ーの位置にカーソルを置き右クリックし

ます。表示される<Change Color...>をク

リックしてカラーパレットを表示します。

解析チャネルの信号名が参

照されます。表示軸の選択

は、チェックボックスをチェッ

クすると表示、 アンチェック

すると非表示となります。

境界にカーソルを置き左右にドラッグすると、グ ラ

フと表の表示範囲を変更できます。

クロスカーソル位置のデータ値を表示します。クロスカーソルの

対象チャネルは、左側のチャネルリストに水色枠で表示されま

す。クロスカーソルは左右矢印キーで移動できます。水色枠は

Tab キーで次のチャネルに移動します。



③ 必要

クリックします

Title

Subtitle

Scale

Color

Cursor

Analysis

OK/CANCEL

必要に応じて、度数分布解析条件

クリックします。

項目

Title

Subtitle

Scale

Color

Cursor

Analysis

OK/CANCEL

度数分布解析条件

度数分布解析

で

Y_Axis

100%

度数軸

には

に

X_Axis

設定

グリッド

グラフ

ル

<

チェックボックス

Ch

Color

す

Name

Unit
Range/Slice
スの

ズは

在

す

[Copy]

値

Result

クすると

を

Max

ここで

[Set] 

[OK]

示

[CANCEL]

度数分布解析条件を変更します

度数分布解析 Window 

で表示され、<Subtitle>

Y_Axis： <Percent>

100%としたときの％

度数軸スケール(Y 

には、Auto のチェックをはずし

に数値を入力します

X_Axis： 物理量軸スケール

設定を行うには、Auto 

グリッド間隔)に数値を

グラフ各部(OutSide=

ル)の色の設定ができます

<Visible>にチェックを

チェックボックス：チェックすると

Ch： チャネル番号を

Color： カラーバーをクリックすると

す。

Name： そのチャネルの

Unit： そのチャネルの
Range/Slice： 設定項目
スの大きさを数値で

ズは 2(128/64)で合計

在していない場合は

す。選択されたセルを

[Copy]と[Paste]の

値が、ここで設定された

Result： 解析対象チャネルの

クすると度数解析を

を表示します。<N>が

Max： 各チャネルの

ここで使用される数値

[Set] -> [Y Format & Precision...]

[OK]をクリックすると

示します。

[CANCEL]では、変更
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します。度数分布解析

Window 上部にタイトルを

<Subtitle>の入力されたテキストがグラフ

<Percent>は、Y 軸度数単位軸

％値、チェックをはずすと

(Y 軸)を設定します。Auto 

のチェックをはずし、活性化

します。

スケール(X 軸)を設定

Auto のチェックをはずし

を入力します。

(OutSide=外周、InSide=グラフ

ができます。カラーボタンをクリックすると

にチェックを付けると、グラフ上

チェックすると解析対象

を表示します

カラーバーをクリックすると、カラーパレットが

そのチャネルの信号名を表示します

そのチャネルの物理量単位を表示
設定項目で、ダブルクリックすると

で入力します。例えば

合計 256(128*2)

は、初期値を自動で

されたセルを右クリックすると

2 種類で、他のセルにコピー

された<Range>を超える

チャネルの On/Off 

を行い、正しく演算が

が示されたチャネルは

チャネルの解析範囲指定された

数値および度数分布解析

Format & Precision...]で設定

をクリックすると、設定された条件で

変更された条件を無効

度数分布解析 Window のメニューバー

内容

にタイトルを付けます。<Title>

されたテキストがグラフ上部右側

軸度数単位軸の設定です。チェックを

チェックをはずすと計数値となります

Auto にチェックを付

活性化される Min(スケール

設定します。Auto にチェックを

のチェックをはずし、活性化される

グラフ表示部、GridLine=

カラーボタンをクリックすると、カラーパレットが

上にクロスカーソルが

解析対象チャネルとなります

カラーパレットが表示され

します。

表示します。
ダブルクリックすると数値の入力

えば<Range>に 128 が

256(128*2)クラスに計数されます

で求め表示します。自動

クリックすると編集ツールボックスを

のセルにコピー&ペーストができます

える値を含む場合、これらの

On/Off 変更、<Range>/<Slice>

が行われたことを<Y>

されたチャネルは、前回の処理で演算

された区間の絶対値最大

度数分布解析の結果の数値の

設定された表示桁数

で解析を実行し結果

無効とし、度数分布解析

のメニューバー[Condition] 

内容

<Title>に入力されたテキストが

上部右側に表示されます

チェックを付けると、解析範囲

となります。

付けるとオートスケールとなります

スケール最小値)、Max(最大値

にチェックを付けるとオートスケールとなります

Min(スケール最小値

GridLine=グラフ表示グリッド

カラーパレットが表示

にクロスカーソルが表示されます。

チャネルとなります。

され、そのチャネルのグラフ

入力ができます。度数解析
が入力され、<Slice>

されます。各値とも直前の

自動で求める<Range>

ボックスを表示します。編集

ペーストができます。なお、

これらの計数は、最大

<Range>/<Slice>の変更後、本設定

<Y>表示で示し、その後自動的

演算が行われていないことを

絶対値最大を示します。

の表示形式は、メインの

表示桁数となります。

結果を<Y>で表示し自動的

度数分布解析 Window 表示に戻

６． 度数分布解析

[Condition] -> [Condition]

されたテキストが、グラフ表示上部中心

されます。

解析範囲に存在する総

けるとオートスケールとなります。マニュアル

最大値)、Grid(グラフ表示

けるとオートスケールとなります

最小値)、Max(最大値)、

グリッド、Value=表示値、

表示され色の選択ができます

そのチャネルのグラフ線色を変更することができま

度数解析の最大物理量
<Slice>で 64 が入力された

の設定値を表示します

<Range>は、解析範囲の

編集ツールボックスのメニューは

、解析範囲指定されたデータの

最大/最小のセルにカウントされます

本設定ダイアログ下部

後自動的に度数分

われていないことを示します。

メインの波形表示 Window 

自動的に度数分布解析

戻ります。

度数分布解析 Window

> [Condition]を

表示上部中心に太字

総データ個数を

マニュアル設定を行う

表示グリッド間隔) 

けるとオートスケールとなります。マニュアル

、Grid(グラフ表示

、Cursor=カーソ

ができます。

することができま

最大物理量レンジとスライ
された場合、セルサイ

します。初期値が存

の絶対値最大で

ツールボックスのメニューは、

されたデータの絶対

のセルにカウントされます。

下部の[OK]をクリッ

度数分布解析 Window 

。

Window のメニュー、

度数分布解析 Window を表

Window
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６． 度数分布解析 Window

６．２． 解析結果の保存
６．２．１． 度数分布解析結果を表示しファイルに保存する
度数分布解析 Window の上部にある[List]をクリックすると、解析結果をリスト表示します。

1ch 分の解析結果は 3 列で表します。ここで表示される結果は、度数分布解析 Window の条件設定ダイアログで解析 On 

に設定されたチャネルです。したがって、実際にグラフ表示されているチャネルとは異なる場合があり、度数分布解析

Window のリスト部に表示されているチャネルとなります。
セルタイトル部(グレー部)は、1 列目はチャネル番号、2 列目は信号名、3 列目は物理量単位となり、以下チャネルごとの繰

り返しとなります。解析結果は計 6 行で示します。青いセルは解析タイトルで、その下の黄色いセルに結果を示します。

Range： 条件設定ダイアログで入力された値です。

Num of slice： 条件設定ダイアログで入力された値です。

Cell size： セルサイズ、Range/ Num of slice の値です。

Meas.Time(h)：解析対象時間（解析対象範囲を時間に換算した値）です。

Mean： セル計数値の平均値です。

σ： セル計数値の標準偏差値です。

Level： セル中央値です。
Counts： セル中央値の計数です。

%： セル中央値の%値です。

リスト表示データの保存機能 解析結果リスト表示画面上部の[Save]ボタンをクリックするとファイル格納ダイアログを表示し

ます。ファイル名を指定して格 納します。格納形式は、項目カンマ区切りで、拡張子は csv となります。

1 行目： 1 列目： Title で設定した内容です。

2 列目： Subtitle で設定した内容です。

3 列目：解析対象ファイル名です
4 列目：解析開始データ番号です。

5 列目：解析終了データ番号です。

2 行目： 1 列目：Memo欄に記載した内容です。

3 行目以降の形式は、上記解析結果リスト表示の内容と同一です。
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６． 度数分布解析 Window

６．３． グラフのプリントアウト

表示されている度数分布グラフをプリントアウトするには、度数分布解析 Window のメニューバー、[File] -> [Print]をクリック

します。[Print Preview]では、プリントプレビューを行うことができます。

[Print Setup...]では、用紙の向きやプリンタの設定を行うことができます。
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６． 度数分布解析 Window

このページはブランクです。
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７． 多次元時間率頻度解析 Window

７． 多次元時間率頻度解析 Window
メイン波形表示画面で、解析範囲指定された範囲内にあるチャネルデータどうしを比較するグラフ表示ができます。 例えばエ

ンジン回転数、車両速度、舵角、などそれぞれの信号レベルの分布がどの様に関連しているかを解析表示できます。

◆ 最大 4 要素(チャネル)の比較ができます。

◆ ３次元バーグラフ、または、カラーコンターマップグラフ表示の選択ができます。
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７． 多次元時間率頻度解析 Window

７．１． 操作
７．１．１． 時間率頻度解析 Window を表示する
① メインの波形表示画面で時間率頻度解析対象区間を切り出します。

② メニューバーの、[Analyze] -> [MultiDim Frequency Analysis ...]をクリックすると時間率頻度解析 Window が表示されま

す。デフォルトで表示される解析条件は、前回使用されたときの条件となります。、ただし、プログラム初回起動時、あるいは

解析条件が不整合な場合は、何も表示されない Window とともに、③の解析条件設定ダイアログが表示されます。この場

合、③にしたがって先に解析条件を設定します。

次の例は、時間率頻度解析 Window が表示された場合の例です。

３次元バーグラフ表示の例

カラーコンターマップ表示の例
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Memo 

表示するグラフの軸数を選択します。

表示するグラフの種類を選択します。

<OK>: 設定されたパラメータでグラフを表示します。

軸数２のとき、解析対象のチャネ

ル、２つをドラッグ＆ドロップ 上から

軸 1、次の選択を軸 2 に割り 当

て、

三次元グラフでは軸 1 が X 軸、軸 2

がＹ軸、軸 3 がＺ軸に表示

③ 時間率頻度解析条件ダイアログが表示された場合は下記に従って解析条件を設定します。 または、設定内容を変更す

る場合、時間率頻度解析 Window のメニューバー[Set] -> [Condition]をクリックすると解析条 件設定ダイアログが表示さ

れます。

3 次元グラフ垂直軸における各レベルの色を設定でき

ます。

3 次元グラフ垂直軸におけるスケールを設定します。

オートのチェックボックスをチェックすると、表示対象の

垂直軸のセル値最大を使用します。

時間率頻度解析条件（Analysis）の変更 セルサイズは、レンジ（Range）と分割数

(Num Oｆ Slice：初期値=16)で決定します。

レンジは、絶対値で記載されていますが、実際には±存在します。セルの大きさは、設定レンジ/分割数です。例えば、設

定レンジが 100 で分割数が 64 の場合、100/64=1.5625 がセルサイズとして使用され、合計セル数は、分割数×2 となり

128 個となります。
なお、正領域負領域とも対象であることを前提とした時間率頻度解析となります。

単軸グラフの色（Color）指定

単軸グラフには、各軸における 現在選択されている 3 次元グラフのカーソルにより選択されている行または列の頻度(Frq)、

合計(Summary 但し設定されている場合)、最大頻度数(Max Frq)の 3 種が描かれます。各グラフの色は Analysis Coler の

各項目をクリックすると変更できます。

単軸グラフのスケール(Scale_Summary Visible)設定 選択された軸ごとに表示さ

れる時間率頻度解析グラフのスケールを設定します。

オートの場合、Y 軸は、セルに計数された最大頻度数(Max Frq)、ただし合計数表示(Summary)ON の時は、合計結果の最

大頻度数、X 軸は、合計数表示 ON/0FF にかかわらず合計した結果で計数されているセルの最大値または最小値で絶対

値の大きい方が参照されます。

設定は、いずれも、最大値とグリッド間隔を設定します。なお、X 軸の場合は設定された最大値を使用し、-(マイナス)最大

値～最大値となります。
単軸グラフ頻度解析の結果の X 軸は、正領域と負領域で対称となります。
オート指定でも他軸のカーソル移動によって X 軸が再スケーリングされることはありません。

合計数（Summary）の表示選択

合計数は、当該軸の合計を表示するか否かです。合計数軸は、2 軸選択の場合、第 1 軸行方向 2 軸が列方向のマトリッ

クスと考えると、合計数は、第 1 軸は列合計、第 2 軸は行方向の合計を意味します。 合計

数表示 ON の時は、単軸グラフの Y 軸オートスケールは、合計数データを使用します。
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７． 多次元時間率頻度解析 Window

④ 解析条件設定画面で[OK]がクリックされると、設定された条件にしたがって時間率頻度グラフを表示します。

Window 左側に各単軸のグラフ、右側 3 次元グラフが表示されます。
表示サンプルでは、軸 1～3 まで設定した場合を示します。

単軸グラフは、設定ダイアログで<Summary>がチェックされている場合は、合計数と最大頻度と選択されている行または 列

の頻度グラフの三種を表示します。

⑥ カーソルの操作

単軸グラフのカーソル操作

カーソル機能は常時 ON で、初期値は X 軸セル番号１位置とします（グラフ X 軸中心）。

第 1 軸のカーソルを移動すると、第 2 軸の表示頻度グラフが変わります。同時に、3 次元グラフの X 軸（第 1 軸）カーソ

ル線位置が移動します。
第 2 軸の表示初期値頻度グラフは、第 1 軸のカーソル表示初期位置にしたがいます。
第 2 軸のカーソルを移動すると、第 1 軸の表示頻度グラフが変わります。同時に、3 次元グラフの Y 軸（第 2 軸）カーソ

ル線位置が移動します。第 1 軸の表示初期値頻度グラフは、第 2 軸のカーソル表示初期位置にしたがいます。 なお、

3 次元グラフでカーソル操作は行うことができず、カーソル線表示のみです。

３次元グラフのカーソル操作

カーソル線移動操作はありません。カーソル線の移動は、第 1 軸グラフのカーソル移動、または第 2 軸グラフのカーソル

移動にしたがいます。
グラフの移動操作は、Shift キー＋上下矢印キーで上下に移動し、Shift キー＋左右矢印キーで左右に移動します。

⑦ 3 次元バーグラフを回転させて表示することができます。 左右矢印キーで

水平方向に回転、上下矢印キーで垂直方向に回転します。
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７．２． 解析結果の保存
７．２．１． 多次元時間率頻度解析結果をファイルに保存する
多次元時間率頻度解析結果を csv ファイルに保存することができます。

グラフ Window 上の[Save]ボタンをクリックします。ファイル保存ダイアログが表示され、ファイル名を付けて保存することがで

きます。

軸１と軸 2 以上の各軸のカーソル位置における軸１と軸 2 の計数値をファイルにします。

Time Rate Frequency Analysis → キーワード

Date=,12-01-2009 → 解析年月日
Time=,11:09:32 → 解析時刻

FileName=,3to7.hdr,8887,11770, 2883 → 解析対象ファイル名、開始番号、終了番号、解析データ個数

Memo=, → 入力された Memo
Linked=,LINK → LINK されていることを示す

Rotational Speed,rpm,Y Axis Acc,G,X Axis Acc,G → 信号名、単位、組み合わせ軸降順記載

Size,Number,Size,Number,Size,Number
199.5,32,0.051,32,0.105,32 → セルサイズ、セル個数、組み合わせ軸降順記載

AxisNo.3,Level=,3092,Counts=,2883 → 軸 2 以上のカーソル位置のレベルと計数値

,AxisNo.1 CellNo,-16,-15,-14,・・・・12,13,14,15,16 → 軸１のセル番号

AxisNo.2 CellNo,Level,-1.628,-1.523,-1.418,・・・・,1.208,1.313,1.418,1.523,1.628 →軸 1 のセル中央値

-16,-0.787, 0, 0, 0,・・・・, 0, 0, 0, 0, 0 → 1 列目=軸 2 のセル番号、2 列目＝軸 2 のセル中央値、以降行列の要素

-15,-0.736, 0, 0, 0,・・・・, 0, 0, 0, 0, 0

-14,-0.685, 0, 0, 0,・・・・, 0, 0, 0, 0, 0

-13,-0.635, 0, 0, 0,・・・・, 0, 0, 0, 0, 0

-12,-0.584, 0, 0, 0,・・・・, 0, 0, 0, 0, 0

-11,-0.533, 0, 0, 0,・・・・, 0, 0, 0, 0, 0

-10,-0.482, 0, 0, 0, 0, 0, 0, 0, 0, 1, 1,10,11,11, 6, 3, 6,18, 9,10, 3, 7, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

-9,-0.432, 0, 0, 0, 0, 0, 0, 0, 0, 0, 4, 7, 8,12, 6, 6,13, 9, 9, 3,12, 5, 1, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

-8,-0.381, 0, 0, 0, 0, 0, 0, 0, 0, 2, 2,11,15,11, 7, 7,13,14,16, 7, 9, 7, 1, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

-7,-0.330, 0, 0, 0, 0, 0, 0, 0, 0, 0, 9,13,13,22, 5, 4,11,10, 9,16, 7, 4, 4, 1, 0, 0, 0, 0, 0, 0, 0, 0, 0

-6,-0.279, 0, 0, 0, 0, 0, 0, 0, 0, 3, 7,19,15,15, 8, 5, 9,16,18,13,14, 5, 9, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

-5,-0.228, 0, 0, 0, 0, 0, 0, 0, 0, 2, 1,19,12,12, 7, 6, 4,15,11,18,16, 9, 2, 1, 0, 0, 0, 0, 0, 0, 0, 0, 0

-4,-0.178, 0, 0, 0, 0, 0, 0, 0, 0, 0, 5,13,25,18, 9, 8, 4,15,16,18,14,10, 3, 1, 1, 0, 0, 0, 0, 0, 0, 0, 0

-3,-0.127, 0, 0, 0, 0, 0, 0, 0, 0, 1, 5,19,23,11,12, 9, 8,10,13,17,19,13, 7, 4, 0, 0, 0, 0, 0, 0, 0, 0, 0

-2,-0.076, 0, 0, 0, 0, 0, 0, 0, 0, 0, 1,14,11,10, 8,13,11,16,25,25,25,16, 6, 2, 0, 0, 0, 0, 0, 0, 0, 0, 0

-1,-0.025, 0, 0, 0, 0, 0, 0, 0, 0, 1, 7,10,17,12, 7,12,19,19,19,24,14, 7, 5, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

1,0.025, 0, 0, 0, 0, 0, 0, 0, 0, 0, 4, 9,18,12, 5, 7,21,29,19,15,15,12, 2, 4, 0, 0, 0, 0, 0, 0, 0, 0, 0

2,0.076, 0, 0, 0, 0, 0, 0, 0, 0, 0, 4,10, 6,10,11,15,24,26,12,10,14,10, 3, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

3,0.127, 0, 0, 0, 0, 0, 0, 0, 0, 0, 3, 4, 7, 7, 7,11,20,19,17,14,11, 3, 2, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

4,0.178, 0, 0, 0, 0, 0, 0, 0, 0, 0, 1, 1, 8, 4, 9,17,23,25,13,16, 7, 2, 2, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

5,0.228, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 3, 1, 7,19,24,25,15,17,10, 1, 2, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

6,0.279, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 1, 3, 3, 7,17,12,13,18,12, 7, 2, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

7,0.330, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 1, 0, 4, 7,14,21,13,20, 5, 4, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

8,0.381, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 2, 5,13,21,24,21, 8, 7, 1, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

9,0.432, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 2, 4,10,14,19,14, 8, 3, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

10,0.482, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 1, 1, 1,10,13,16,15,14, 6, 1, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

11,0.533, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 1, 4,10,13,16, 4, 1, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

12,0.584, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 1, 0, 1, 5, 9, 6, 5, 1, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

13,0.635, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 1, 1, 1, 1, 4, 9, 5, 2, 1, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

14,0.685, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 1, 1, 1, 4, 7, 2, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

15,0.736, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 1, 4, 2, 5, 1, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

16,0.787, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 4, 7, 3, 4, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0
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７． 多次元時間率頻度解析 Window

このページはブランクです。
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８． X-Y グラフ Window

８． X-Y グラフ Window
メイン波形表示画面で、解析範囲指定されたすべてのチャネルのデータを X-Y グラフ表示することができます。

◆  Y 軸は最大４軸です。

◆ 軸スケールは、オートスケール、またはマニュアル設定できます。

◆ 統計データとして、相関関数、標準偏差値、平均値をリスト表示します。

◆ 最小二乗法による近似線表示により、基準チャネル(X 軸チャネル)との関係を視覚的に捉えることができます。
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８． X-Y グラフ Window

８．１． 操作
８．１．１． X-Y グラフ Window を表示する
① メインの波形表示画面で X-Y グラフ表示対象の区間を切り出します。

② メニューバーの、[Analyze] -> [XY Graphics ...]、または、ツールバーアイコンの、 をクリックします。

デフォルトで表示される解析条件設定ダイアログは、前回使用されたときの条件となっています。

③ [OK]をクリックすると、設定ダイアログの条件で X-Y グラフ表示が行われます。

のチャネルの表示が

Off となります。

各チャネルを Y 軸に割り当てるには、<Axis>のセルにマウスを置きダ

ブルクリックで表示される Y 軸選択ダイアログで軸を選択します。

OK をクリックすると、ここで設定された内容で X-Y グラフが表示されます。

X 軸設定： X 軸として描画するチャネルをリストボックスで選択します。

AutoScale をチェックするとオートスケールで、チェックをはずずと、軸スケールの最大値(MAX)、最小

値(MIN)、グリッドの大きさ(GRID)を設定できます。

Factor は、Line 表示指定時 X 軸表示スケールを、ここで入力された数字倍にして表示します。Dot 

表示指定時は必ず 1 にして下さい。

Color： カラーバー左のボタンをクリックするとカラーパレ ッ

トが表示され、グラフ各部の色の変更ができます。

Graph Type： グラフ描画形式を、線グラフ(Line)か散布図グラフ(Dot)かを選択します。

Cusor: チェックを付けると、データ読み取り垂直カーソルを表示します。

Vert Cursor: チェックを付けると、Y 軸スケール読み取りガイド用上下水平カーソルを表示します。

Factor は、Line 表示指定時、該当チャネルの Y 軸表示スケールを、ここで入力された数字倍にして

表示します。Dot 表示指定時は必ず 1 にして下さい。

X Ch： X 軸チャネル選択

X 軸対象チャネルを、プルダウンリストからクリックして選択できます。

ここで選択されたチャネルは、自動的に下記の Y 軸チャネルリストの表示

On/Off 選択対象外となります。

Y Axis Scale： Y 軸グラフスケール設定
軸 1(Axis 1)から軸 4(Axis 4) まで、4 つの軸のスケールを個別に設定できます。

Auto>をチェックするとオートスケールで、チェックをはずずと、軸スケールの最大

値(MAX)、最小値(MIN)、グリッドの大きさ(GRID)を設定できます。

カラーバーをクリックするとパレット

が表示され、該当チャネルのグラ

フ描画色を変更できます。
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８． X-Y グラフ Window

X 軸チャネル番号、チャネル名、標準偏差、お

よび平均値を表示します。

チェックをはずすと、そのチャネルの

表示が Off となります。

Y 軸は最大４軸設定できます。

ヘッダファイル情報表示

垂直カーソル位置 X 軸値

Dot 表示選択では、最小二乗法による相

関近似線が描画されます。

各チャネルの垂直カーソル位置での Y 軸スケー

ル上の位置を示します。その時の値を、右のリス

ト<Value>に表示します。
カラーバーに、マウスを置き右クリ

ックすると表示される[Change 

Color...]をクリックしまスカラーパレ

ットが表示され、該当チャネルのグ

ラフ描画色を変更できます。

ここにマウスカーソルを置き左にドラッグすると、 リ

スト表示部分を広げることができます。
上下 2 本の水平カーソルは、Y 軸スケールの位置を示

します。Y 軸スケールに参照スケール値を表示したい

場合に使用します。

X 軸および Y 軸の値の小数点位置などの表示形式

は、[Set] -> [X Format & Precision...]/[Y Format & 

Precision...] で行います。

④ X-Y グラフ Window が表示されます。

設定ダイアログの<Graph Type>で<Dot>が選択されたときの表示例

各チャネルを Y 軸に

割り当てるには、

<Axis>のセルにマウ

スを置き右クリックで

表示される Y 軸選

択ダイアログで軸を

選択します。

カーソルの移動方法と表示

垂直カーソル： データ読み取りのカーソルです。カーソル位置にマウスポインタを置くとポインタが、<->に変わります。この状

態で、マウスを左右にドラッグすると、垂直カーソルが左右に移動します。

水平カーソル(上下２本)： Y 軸スケールのガイドカーソルで、カーソル位置の Y 軸スケール値を、黄色枠付き数値で示しま

す。グラフ画面上にマウスカーソルが存在する状態で、キーボードの上下矢印キーで、上側のカーソルが移動、[Shft]+上下

矢印キーで下側のカーソルが移動します。
各カーソルを消去するには、メニューバー[Set] -> [Analysis Condition...]をクリックして設定ダイアログを表示、<Cursor>(垂
直カーソル)、<Vert Cursor>(水平カーソル)のチェックをはずします。

設定ダイアログの<Graph Type>で<Line>が選択されたときの表示例
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８． X-Y グラフ Window

⑤ グラフ表示画面で、左側のグラフ表示部と右側のリスト表示部の境界をマウスで左側にドラッグすると、リスト表示部を拡

大できます。

結果表示リストでは、次の内容が示されます。

項目 内容

Ch チャネル番号、チャネル番号の前のチェックをはずすと表示 Off、カラーバーを右クリックするとグラフ色の変更が

できます。

Value カーソル位置の値です。

Unit 表示物理量単位です。

Axis そのチャネルが、軸 1 から軸 4  のいずれの軸に割り付けられているかを表示します。このセル位置にマウスを置

き、右クリックすると割り付け先軸の変更ができます。

Factor Factor は、Line 表示指定時、そのチャネルのデータを、ここで入力される数字倍にして表示します。

Dot 表示指定時は必ず 1 にして下さい。

Name チャネル名です。

R 相関係数です。

A 最小二乗法による近似直線式のスロープ値です。

B 近似直線式のオフセット量です。

S 標準偏差値です。

Mean 平均値です。

⑥ グラフ表示内容を変更するには、メニューバー[Set] -> [Analysis Condition...]をクリックして設定ダイアログを表示しま

す。

８．１．２． グラフ表示条件を保存し読み出す

① X-Y グラフ表示 Window のメニューバー[Set] -> [Save Condition ...]をクリックすると、現在の表示条件に名前を付けて

ファイルとして保存できます。

② X-Y グラフ表示 Window のメニューバー[Set] -> [Load Condition ...]をクリックすると、過去に保存された X-Y グラフ表

示条件を読み出し、現在の表示を置き換えることができます。

ここにマウスカーソルを置き左右にドラッグします。
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８． X-Y グラフ Window

８．２． 解析結果の保存
８．２．１． 解析結果をファイルに保存する
X-Y グラフ右側の解析結果を csv ファイルに保存することができます。

X-Y グラフ表示 Window のメニューバー、[Set] -> [SaveResult]をクリックします。ファイル保存ダイアログが表示され、ファ

イル名を付けて保存することができます。

保存される内容は、

1 行目はメインタイトル、サブタイトル、

2 行目は対象ファイル名、収録年月日、時分秒、開始ポイント、終了ポイント、データ個数

3 行目は X 軸チャネル番号、信号名、単位、、、、平均値、変動値

4 行目は Y 軸チャネル番号、信号名、単位、相関係数、スロープ値 A、オフセット量 B、平均値、変動値

5 行目は Y 軸チャネル番号、信号名、単位、相関係数、スロープ A、オフセット量 B、平均値、変動値

6 行目は Y 軸チャネル番号、信号名、単位、相関係数、スロープ値 A、オフセット量 B、平均値、変動値

以後収録チャネル分続きます。

1 行目はグラフにつけたタイトルおよびサブタイトル、2 行目にファイル名、ファイル生成年月日、解析開始データ番号、終

了データ番号および、解析データ数、4 行目に X 軸に設定されたチャネルの番号、信号名、単位 平均値、標準偏差値が

書き込まれます。

Test Force measurement
Test.hdr 07-28-200 18711 24849 6138
X_ChNo Name Unit Mean S
Ch1 Obj1_X kgf 5.4 1.8
Y_ChNo Name Unit R A B Mean S
Ch2 Obj1_Y kgf -0.8 -5.2 15.6 -12.7 12.1
Ch3 Obj1_Z kgf 0.8 11.3 -41.1 20.5 26.3
Ch4 Obj2_X kgf -0.8 -5.1 17.7 -9.8 11.8
Ch5 Obj2_Y kgf 0.3 0.2 1.8 2.7 1
Ch6 Obj2_Z kgf 0.7 2.1 -4.7 6.6 5.6
Ch7 Obj3_X kgf 0.6 0.9 -6.2 -1.5 2.5
Ch8 Obj3_Y kgf -0.6 -0.4 1.8 -0.6 1.2
Ch9 Obj3_Z kgf -0.8 -6.3 27.4 -6.7 14.6

８．３． グラフのプリントアウト
表示されている X-Y グラフをプリントアウトするには、X-Y グラフ Window のメニューバー、[File] -> [Print]をクリックします。

[Print Preview]では、プリントプレビューを行うことができます。
[Print Setup...]では、用紙の向きやプリンタの設定を行うことができます。

プリントプレビュー例
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８． X-Y グラフ Window

このページはブランクです。
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９． 多軸グラフ Window

９． 多軸グラフ Window
メイン波形表示画面で、解析範囲指定されたすべてのチャネル(メイン画面で表示されていないチャネルも含む)のデータを、ひとつ

のグラフ枠内に表示する Window です。

◆  Y 軸は最大４軸です。

◆ 軸スケールは、オートスケール、またはマニュアル設定できます。

◆ カーソル読み取り値をリスト表示できます。

◆ グラフに信号名タイトルを付け、表示、およびプリントアウトできます。
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ヘッダファイル情報表示

垂直カーソル

表示形式は、[Set] -

Format & Precision...] で行います。

垂直カーソル位置での
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９． 多軸グラフ Window

結果表示リストでは、次の内容が示されます。

項目 内容

Ch チャネル番号、チャネル番号の前のチェックをはずすと表示 Off、カラーバーを右クリックするとグラフ色の変更が

できます。

Value カーソル位置の値です。

Unit 表示物理量単位です。

Axis そのチャネルが、軸 1 から軸 4  のいずれの軸に割り付けられているかを表示します。このセル位置にマウスを置

き、右クリックすると割り付け先軸の変更ができます。

Name チャネル名です。

MIN 表示区間の最小値です。

MAX 表示区間の最大値です。

⑤ グラフ表示条件を変更するには、メニューバー[Set] -> [Setting...]をクリックします。

のチャネルの表示が

Off となります。

各チャネルを Y 軸に割り当てるには、<Axis>のセルにマウスを置きダ

ブルクリックで表示される Y 軸選択ダイアログで軸を選択します。

OK をクリックすると、ここで設定された内容で X-Y グラフが表示されます。

X 軸設定： X 軸として描画するチャネルをリストボックスで選択します。

AutoScale をチェックするとオートスケールで、チェックをはずずと、軸スケールの最大値(MAX)、最小

値(MIN)、グリッドの大きさ(GRID)を設定できます

Color： カラーバー左のボタンをクリックするとカラーパレ ッ

トが表示され、グラフ各部の色の変更ができます。

Cusor: チェックを付けると、データ読み取り垂直カーソルを表示します。

Vert Cursor: チェックを付けると、Y 軸スケール読み取りガイド用上下水平カーソルを表示します。

Y Axis Scale： Y 軸グラフスケール設定
軸 1(Axis 1)から軸 4(Axis 4) まで、4 つの軸のスケールを個別に設定できます。

Auto>をチェックするとオートスケールで、チェックをはずずと、軸スケールの最大値

(MAX)、最小値(MIN)、グリッドの大きさ(GRID)を設定できます。

カラーバーをクリックするとパレット

が表示され、該当チャネルのグラ

フ描画色を変更できます。
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９． 多軸グラフ Window

⑥ グラフ表示画面内に、チャネル名を表示できます。チャネル名を表示するには、設定ダイアログで垂直カーソル表示

(Cursor)をいったん Off にします。その後、[Set] -> [Name]をクリックしてチェックを付けます。

９．１．２． グラフ表示条件を保存し読み出す

① 多軸グラフ表示 Window のメニューバー[Set] -> [Save Setting ...]をクリックすると、現在の表示条件に名前を付けてフ

ァイルとして保存できます。

② 多軸グラフ表示 Window のメニューバー[Set] -> [Load Setting ...]をクリックすると、過去に保存された X-Y グラフ表示

条件を読み出し、現在の表示を置き換えることができます。

９．２． グラフのプリントアウト
表示されている多軸グラフをプリントアウトするには、多軸グラフ Window のメニューバー、[File] -> [Print]をクリックします。

[Print Preview]では、プリントプレビューを行うことができます。

[Print Setup...]では、用紙の向きやプリンタの設定を行うことができます。 チャネ

ル数が 32ch を超えるときは、複数ページにわたってプリントされます。

プリントプレビューの例

チャネル名を表示したいグラフ線上でマウスをクリックしてドラ ッ

グすると引き出し線が表示されます。ドロップするとチャネル 名

が表示されます。チャネル名が設定されていないチャネル で

は、チャネル番号の表示となります。 表示されたチャネル名に

マウスを置き、右クリックするとチャネ ル名表示を削除できま

す。
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10． スパイクカット
スパイクカットは、収録データに存在するフィルタ処理では除去できないスパイク状のノイズを除去する機能です。

◆ ワークダイアログで効果を確認しながら操作ができます。



10．１． 操作
10．１．１．

SpikeCut 

ダに保存

① スパイクカット

選択

れます

② 次

のとき

ックして

操作
．１．１． スパイクカット機能を使う

SpikeCut を行うと、

保存し、コピーされたファイルで

スパイクカット範囲

選択された解析処理範囲

れます。

次に<Spike cut dialog>

のとき、画面両端にあるカーソルを

ックして拡大表示します

表示チャネルの

スパイクカット機能を使う

、元の波形グラフを

コピーされたファイルで

範囲を設定します

解析処理範囲に複数のスパイクノイズがある

ut dialog>を開きます

にあるカーソルを

します。

チャネルの切り替え

スパイクカット機能を使う

グラフを直接編集します

コピーされたファイルで操作を行って

します。メインの波形表示画面

のスパイクノイズがある

きます。[Analyze] 

にあるカーソルを移動して SpikeCut 

このようなスパイクノイズを
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スパイクカット機能を使う

します。 したがって

って下さい。

波形表示画面でスパイクノイズを

のスパイクノイズがある場合、ここで

nalyze] -> [Spike Cut]

SpikeCut を行いたい

このようなスパイクノイズを除去します

2 本のカーソル

でそれぞれマウスをクリックしてそのカーソル

したいスパイクノイズの

したがって、操作にあたっては

でスパイクノイズを除去

ここで設定される

> [Spike Cut]をクリックします

いたい波形の幅などがカーソルで

します。

のカーソル線が画面の両側

でそれぞれマウスをクリックしてそのカーソル

したいスパイクノイズの両端にカーソルを

にあたっては、必ず、

除去する範囲を

される除去条件に適合

をクリックします。<Spike cut dialog>

などがカーソルで読

両側に位置しています

でそれぞれマウスをクリックしてそのカーソル線を

にカーソルを置きます

10．

、元のファイルは

を選択します。反転表示

適合したノイズすべてが

<Spike cut dialog>が表示

読み取りるまで[ZOOM IN]

しています。画面の左部分

を引き出しドラッグして

きます。

． スパイクカット

のファイルは別のフォル

反転表示として

したノイズすべてが除去さ

表示されます。こ

[ZOOM IN]をクリ

左部分、右部分

しドラッグして、除去

として

さ

こ

をクリ
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③ スパイクカット条件を設定します。<Spike Noise Width>は、除去したいスパイクノイズ幅を意味します。現在の左右カーソ

ル幅はグラフ枠外右側<WIDTH>に表示されます。
<Amplitude>は、ノイズの振幅値（ABS(最大値  - 最小値)）を意味します。現在の左右カーソルで囲まれた範囲の振幅値

はグラフ枠外<Amplitude>に表示されます。

<IN-OUT Difference>は、ノイズカット開始点と終了点の許容差分値を意味します。現在の左右カーソルで囲まれた範囲の

差分値はグラフ枠外<Diffrence>に表示されます。

設定値の入力は直接各入力にキーボードより入力する以外に、現在表示されている値を一括して設定することができます。

一括設定する場合は、表示欄下の[SET]ボタンをクリックします。

④ 次に、スパイクカット状況の確認を行います。[PREVIEW]をクリックすると現在の設定値でのスパイク除去状況を確認でき

ます。設定値に合致する範囲が存在すると、元波形を赤色で表示し補間され生成された波形は青色で示します。 合致する

範囲が存在しないと波形表示上変化しません。また、拡大して表示されている場合、などは ZOOM を解除して全体 を確認

することもできます。

[PREVIEW]操作を取り消すには

Preview した結果で切り取りが上手く行かない場合、除去条件を再設定するか、表示チャネルを切り替えると、Preview が取

り消され、同時に、[APPLY]ボタンが非活性化されます。再び手順①に戻ります。

除去するノイズの定義は、幅(W: データ個数)、振幅（A: 物理量）および、切り取り開始点と終了点の絶対値データ値差（D: 

物理量）で定義します。除去は、指定されたデータ幅内で、設定した振幅を越えると同時に設定したデータ値差を越えない

範囲の場合に除去対象となります。

ABS（Max_Value－Min_Value）>=A ＆ ABS（D_begin―D_Until）<＝D



⑤ スパイクカット

ータファイルの

択します

元の

の波形

⑥  スパイクカット

他のチャネルも同時にスパイクカットを行う

① 表示

<Spike Cut Channel>

② 次

のとき

知らせます

なお

警告灯

スパイクカット操作

ータファイルの内容

します。赤色表示部

の波形が編集されてしまいますので

波形は事前に別のフォルダに

スパイクカット機能

他のチャネルも同時にスパイクカットを行う

表示されているチャネル

Spike Cut Channel>

次に<Spike cut dialog>

のとき、チェックボックス

らせます。

なお、<Spike Cut Channel>

警告灯は消灯のままとなります

操作を確定します

内容を更新します。

赤色表示部が消されて

されてしまいますので

のフォルダに残

機能を終了します

他のチャネルも同時にスパイクカットを行う

されているチャネル以外で

Spike Cut Channel>が表示され、

<Spike cut dialog>の<Multi_Ch.Cut>

チェックボックス右横の警告灯

<Spike Cut Channel>で複数

のままとなります。

します。Preview 後

。なお、実行に先立

されて、仕上がり波形

されてしまいますので、十分ご注意下

残しておくことをお

します。[QUIT]をクリックすると

他のチャネルも同時にスパイクカットを行う

で同時に同じ範囲

、同時に除去を

<Multi_Ch.Cut>チェックボックスにチェックを

警告灯が赤色点灯

複数チャネルが指定

Page 68

後、[APPLY]ボタンをクリックします

先立って、元の波形

波形を青色で表示します

注意下さい。 元

しておくことをお進めします。

をクリックすると、波形表示

範囲で、スパイクカット

を行うチャネルが

チェックボックスにチェックを

赤色点灯し、表示チャネル

指定されていない

同時複数

ボタンをクリックします

波形を Overwrite 

します。

波形表示 Window 

スパイクカット補間したい

うチャネルが選択できます。

チェックボックスにチェックを付け

チャネル以外に他のチャネルが

されていない場合は、<Multi_

同時複数チャネル除去設定警告灯

ボタンをクリックします。クリックされるとスパイクカットを

Overwrite するかどうか

Window に戻ります。

したい場合、[CH.SELECT]

。

け、複数チャネル

のチャネルが同時除去指定

<Multi_Ch.Cut>チェックボックスをチェックしても

除去設定警告灯

10．

クリックされるとスパイクカットを

かどうか聞かれますので

[CH.SELECT]ボタンをクリックします

チャネル同時処理を有効

同時除去指定されていることを

チェックボックスをチェックしても

． スパイクカット

クリックされるとスパイクカットを実行し、デ

かれますので、[はい]を選

ボタンをクリックします。

有効にします。こ

されていることを

チェックボックスをチェックしても、

デ

選

こ

されていることを

、
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2

10．１．2． スパイクカットの動作説明
スパイクノイズの定義 スパイクノイズは、次

の 3 点で定義します。

1. スパイクノイズの幅  W データ点数で設定します。

2. スパイクノイズの振幅  A  「最大値 - 最小値」の絶対値（当該チャネルの物理量）で設定します。

3. スパイクノイズ開始点と終了点の差分値  D  「左端データ値  - 右端終了データ値」の絶対値で設定します。

除去対象区間の検索原理

① 除去区間検索開始 表示されている波形の解析指定範囲の先頭データから、設定された矩形定規を掃引します。定規

の底辺は、ノイズ幅に含 まれる最小値に合わせます。

掃引を続け、矩形定規の高さ A を越える部分を検出すると、定規左端データ値と右端データ値の差分絶対値が設定された

D より等しいか小さいかがチェックされ、成立すると除去区間として捉えます。成立しない場合は、そのまま掃引を続けます。

② 除去区間の最適化

①で成立した時点から、そのまま、掃引を続け次に不成立点を検索します。 成立

区間のデータ点毎に設定幅Ｗでの変動値を演算して、最大変動値位置に 固定し

ます。

変動値演算式は
N W 1

Varn  di
in

 dn
d はデータ値を表します。
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③ ノイズ幅の縮退と直線補間

②で固定された、除去区間の左端および右端を幅を縮める方向で左右端

のデータ差分絶対値が設定した D を超えない範囲まで縮退させ、実際の

直線補間範囲を決定します。

直線補間後は、再び現在位置から掃引を開始し、指定された解析範囲の

終端まで繰り返します。

なお、直線補間は直接データファイルの値を修飾しますのでいったん操作

を行った後、元に戻すことはできませんのでご注意ください。
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11． 走行軌跡表示 Window
収録データに南北速度（km/h）、東西速度（km/h）および上下速度（km/h）データが含まれていると、走行軌跡を表示することがで

きます。
また、収録データに走行速度（km/h)が存在する場合は、あらかじめ走行軌跡 Window で生成したコースマップデータを読み込み表
示することができます。

◆ 平面図、高低図、または両方を表示できます。

◆ 波形表示画面と連動したカーソル表示ができます。



11．１． 操作
11．１．１．

本機能

走行軌跡表示

ータが

① メインの

② メニューバーの

で表示

③ 走行軌跡表示

操作
．１．１． 走行軌跡を表示する

本機能は、メイン波形画面

走行軌跡表示 Window 

ータが含まれていることが

メインの波形表示画面

メニューバーの、

表示される設定条件

走行軌跡表示 Window 

走行軌跡を表示する

波形画面 Separate Window 

Window を使用するには

まれていることが必要です

波形表示画面で走行軌跡表示対象

、[Option] -> [

設定条件は、前回使用

Window のメニューバー

走行軌跡を表示する

Separate Window でのみ

するには、収録データに

です。

走行軌跡表示対象の

> [Course Map]をクリックします

前回使用されたときの

のメニューバー[Set] 

メニューバー

タイトルが表示
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でのみ有効です。

データに、南北速度

の区間を切り出

をクリックします。

されたときの条件となります

et] -> [Condition]

メニューバー[Set] -> [Title]

表示されます。

。Common Wave 

南北速度（km/h）、東西速度

出します。

。 デフォルト

となります。

ondition]をクリックすると

> [Title]で入力されたグラフ

Common Wave では操作できません

東西速度（km/h

をクリックすると条件設定ダイアログが

されたグラフ

11． 走行軌跡表示

できません。

km/h）および上下速度

ダイアログが表示されます

走行軌跡表示 Window

上下速度（km/h）デ

されます。

Window
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項目 内容

File/Data 描画する走行軌跡データ(マップデータ)を、

Data Velocity/GPS: 現在の収録データから生成描画するか、

File: あらかじめ保存したコースマップファイル(コースマップファイルの作成方法は後述します)を使用するかを選 択

します。

保存されたコースマップファイルから描画する場合

File を選択します。選択されるとファイル名選択欄が有効となります。Browse ボタンをクリックしてファイル読み出し

ダイアログを表示させ、保存されたコースマップファイルを設定します。

Velocity で、速度データチャネルを指定します。速度データチャネルの単位は km/h と見なして処理されます。速

度データチャネルが存在しない場合は、コースマップ参照することはできません。
Start Offset には、使用するコースマップの開始点と、解析範囲の開始点がずれている場合の補正値で、m(メー

トル）単位で設定します。

収録データから走行軌跡を描画する場合

Data Velocity または Data GPS を選択します。選択されるとチャネル選択欄が有効となります。

Data Velocity の場合
N-S Velocity では、南北速度チャネルを設定し、E-W   Velocity では東西速度チャネル、U-D Velocity で上下
速度チャネルを選択します。いずれも、単位はkm/hと見なされて処理され走行軌跡マップを描画します。収録デ

ータに南北速度、東西速度および上下速度データが存在しない場合は、収録データから走行軌跡を描画するこ

とはできません。

Data GPS の場合

GPS Latitude に緯度チャネル、GPS longitude に経度チャネル、GPS Alititude に高度チャネル Velocity に速度

チャネルを設定します。緯度経度の単位は min、高度の単位は m、速度の単位は km/h です。

Graph Grid Auto にチェックを付けると、走行軌跡がオートスケールで表示されます。チェックをはずすと、南北(N-S)、東西

(E-W)、高低(U-D)の各表示グリッドのスケールを m(メートル)単位で入力できます。

Graph Type Plane: Y 軸を南北距離、X 軸を東西距離とした平面図を描画します。
Altitude: Y 軸を相対高度とし、X 軸を絶対距離とした高低図を描画します。 Plane＋

Altitude: 平面図と高低図の双方を同時に表示します。

Cursor Attrb. Linked にチェックを付けると、波形表示画面のカーソル操作に連動して走行軌跡、あるいはコースマップ上の同じ
位置にカーソルが移動します。チェックをはずすと、連動は行わず、カーソル操作は走行軌跡表示 Window 内で

行います。

Cursor Jump Points Linked をチェックしていないとき、カーソル高速移動操作時の飛び越し数を設定します。

Mark: 収録データに含まれるマーク情報位置ごとにカラーレベルを変更し、コースを着色します。
Ref.Ch: 収録チャネルのデータ値によりコースを着色します。

Velocity: 走行速度によりコースを着色します。

Altitude:  相対高度によりコースを着色します。 なお、走行速度または相対高度を選択した場合、各選択の右横

の Auto にチェックを付けるとカラースケーリング がオートスケールとなり、Auto のチェックをはずすとカラーレベル

スケーリングが設定できます。

Color Map チェックをつけると走行軌跡がカラーで表示されます。
走行軌跡を着色するカラーレベルは、最大値から最小値までを 5 レベル(段階）に分けて行い、着色指定が

MARK 属性以外を設定した場合は、自動的にグラディエーションされて着色されます。 各レベルの色変更は、カラ

ーボタンをクリックします。クリックされるとカラーパレットダイアログが表示され、任意の 色が選択できます。

Pixel Adjust チェックした場合、走行軌跡表示領域の縦横比を  1：1 に設定します。チェックしない場合表示領域は、Window

サイズに依存するため縦横比は 1:1 となりません。
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④ カーソルの操作は、波形表示画面とリンクした動きを行うことができます。
設定ダイアログで、Linked をチェックすると、波形表示画面のカーソル操作に連動して走行軌跡表示上のカーソルが移動し

ます。 波形表示画面で設定した解析範囲を超えてカーソルを移動すると、超えた地点でカーソル連動を中止し、再び解析

設定 範囲に入ると連動を再開します。また、設定した解析範囲を表示させない、あるいは解析範囲を移動しても走行軌跡

Window 起動時の解析範囲を内部的に保持していますので、起動時の解析範囲設定が有効となっています。

メニューバーの[Window] -> [Horz Tile]をクリックして波形表示画面と走行軌跡を同時表示します。

Linked のチェックをはずすと、カーソル移動はメインの波形表示画面と非連動となり走行軌跡表示 Window での操作でカー

ソルを移動できます。カーソルの移動は、左右矢印キーを押します。また、高速移動させたい場合は、[Shift]キー＋左右矢

印キーを押します

⑤ 走行軌跡表示上の拡大したい部分をマウスでドラックすると、表示されている縦横比を維持したまま拡大部分を示す枠

が表示されます。ドラッグを停止すると、その枠内を拡大した走行軌跡を表示します。

ズーム操作は、繰り返して行うことができます。走行軌跡表示内で、マウスの右ボタンをクリックすると、ズームを解除して初

期の表示に戻ります。

マウスドラッグで選択された部分を拡大表示します。

波形表示 Window でカーソルを移動すると、走行軌跡表示

上のカーソルが連動して移動し、波形表示 Window でのカ

ーソル位置と同じ地点を示します。



⑥GPS 

UMT 

GPS データ選択時

UMT 座標系について

選択時の表示領域は

座標系について

は、UMT 座標系
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座標系の座標表示となっていますとなっています。。単位は m です

11． 走行軌跡表示

です。

走行軌跡表示 WindowWindow
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11．１．２． 走行軌跡からコースマップを生成する
速度データの走行軌跡からコースマップへ変換処理を行うことができます。コースマップに変換することで、車両速度データ

のみ存在すれば、生成済みのコースマップを参照することができます。

走行軌跡表示時は、Window 右下に[ZeroPosition]ボタンが有効となっています。

① コースマップ開始点を設定します。 走行軌跡表示上のカーソルをコースマップ開始点に移動します。もし描画開始点を

コースマップ開始点とする場合は、キー ボード上の[Home]キーを押すことでも開始点に移動できます。開始点に移動したら、

[ZeroPoint]ボタンをクリックします。この 地点が起点となります。
[ZeroPosition]ボタンがクリックされると[Circuit]ボタンが有効となります。

② 次に、コースマップ終了点を設定します。 カーソル位置をコース終了点に移動した後、[Curcuit]ボタンをクリックします。走

行軌跡グラフの終了点に移動したい場合は、 キーボード上の[End]キーを押すことでもできます。 [Curcuit]ボタンがクリックさ

れた時点で、表示されている走行軌跡はコースマップに変換され再描画されます。

③ コースマップから走行軌跡へ復元するには、 コースマップに変換した直後であれば、コースマップ上を右ダブルクリックする

ことで、走行軌跡に戻すことができます。ただし、 コースマップに変換された結果ファイルを読み出し表示している場合は、復

元することはできません。 コースマップから走行軌跡へ復元されると、再び、[ZeroPosition]ボタンが有効となります。

④ 変換されたコースマップを保存するには、

メニューバー[Set] -> [MapSave]を選択します。選択されるとファイル保存ダイアログが表示され、ファイル名付けて保存で

きます。
保存されるコースマップは拡張子 csv のテキスト形式となります。

1 行目は識別行で 1 列名に CIRCUIT、2 行目に 1 列目に設定したタイトル、3 行目はデータヘッダー行となります。

4 行目からデータ行となり、1 列目が南北相対距離、2 列目が東西相対距離、3 列目が高度相対値となり、すべて m（メート

ル）単位で記載されます。

11．１．３． GPS 走行軌跡から KML ファイルを生成する
GPS データから KML ファイルを作成することができます。作成した KML ファイルは、他のアプリケーションで利用可能です。

①メニューバーの[File] -> [Export KML]を選択します。

②名前を付けて保存ダイアログが表示されますので、保存先フォルダとファイル名を指定し、[保存（S）]ボタンを選択してく だ

さい。

CIRCUIT

N-S(m)
1.77E-05
3.50E-05
5.27E-05
7.20E-05
8.83E-05
1.00E-04
1.10E-04
1.20E-04
1.33E-04
1.51E-04

ALT(m)
1.23E-05 -1.63E-06
2.52E-05 -3.20E-06
3.78E-05 -5.40E-06
5.06E-05 -7.37E-06
6.32E-05 -9.30E-06
7.39E-05 -1.15E-05
8.26E-05 -1.35E-05
9.19E-05 -1.55E-05
1.02E-04 -1.75E-05
1.12E-04 -1.95E-05
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12． オフセット調整処理
オフセット処理機能は、収録データにオフセットが重畳している場合に、そのオフセットを除去する機能です。

◆ 複数のオフセット除去方法および範囲指定方法から、信号の特性に即したオフセット調整処理方法を選択できます。
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12．１． 操作
12．１．１． オフセット調整処理を行う
オフセット調整処理を実行すると、元のファイル名に_adj を付加したファイル名が初期値となり、ファイルを生成します。

① メインの波形表示画面で解析範囲を指定し、波形表示画面のメニューバーの[Analyze] -> [Offset.ADJ]をクリックしま

す。

② <Offset Adjustment Dialog>が表示されます。

<Method>オフセット除去方法は、チャネルごと方法を選択することができます。

[Mean]: 解析範囲の平均値を Zero にします。オフセット処理の結果、正領域の面積と負領域の面積が同じになります。 加

速度等のデータの Offset 除去に向いています。

di   di
d i

n
[Start Data]: 解析範囲の最初のデータをすべてのデータから減算します。

di   di  d0 d0   0

[Min Data]: 解析範囲内の最小値をすべてのデータから減算します。

di   di   dmin

処理範囲を選択します。

処理後のファイル名を表示します。

ここをクリックするとオフセット除去方法の選

択リストが表示されます。

複数セルを選択して、マウス右ボタンクリッ

ク->左ボタンクリックで選択リストが表示さ
れ、一括で変更ができます。

対象

とします。

オフセット除去方法を選択すると、方

法により表示される値が異なります。
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

[Max Data]: 解析範囲内の最大値をすべてのデータから減算します。

di   di   dmax

[Manual]: 解析範囲内のデータから設定値をすべてのデータから減算します。

di   di   x

X は入力された設定値

[Start-End](Slant): 解析開始点データを Zero とし、同時に解析終了点データの差異を Zero とします。

演算式 n はデータ INDEX で 0 から n までが解析範囲となります。

d    d  
dn

d 0   i
i i

   n  1 


<Value> オフセット値表示では、選択されたオフセット除去方法により、その値が示されます。

項目 内容

Mean 解析範囲の平均値となります。

Start_Data 解析範囲の先頭データ値となります。

Min_Data 解析範囲の最小値となります。

Max_Data 解析範囲の最大値となります。

Manual 0 となります。

Start_End(Slant) 解析範囲の最終データと先頭データの差異

<Value>のマニュアル設定 セルにマウスを置き、ダブルクリックすると値を入力できます。この場合、選択された除去手法に

関係なく値の編集ができま す。

複数セルを選択した後、入力すると選択されているセルすべてに同じ値が入力されます。

<Value>項目表示セルをクリックすると、初期値に戻ります。

<ADJ Range>除去範囲を選択します。

項目 内容

AREA 指定された解析範囲が対象となります。

ALL 指定されている解析範囲にかかわりなく、すべてのデータが対象となります。

MARK 指定されている解析範囲で最初に出現する MARK 位置から解析範囲に出現する次の MARK 位置までを対象と
します。解析範囲に MARK がひとつだけの場合、MARK 位置から解析範囲の終りまでが対象となります。ただし、

解析範囲に MARK が存在しない場合は処理を行いません。

PAUSE 指定されている解析範囲で最初に出現するPAUSE位置から解析範囲に出現する次のPAUSE位置までを対象と
します。解析範囲に PAUSE がひとつだけの場合、PAUSE 位置から解析範囲の終りまでが対象となります。ただし、

解析範囲に PAUSE が存在しない場合は処理を行いません。

③ [EXEC]をクリックすると、ダイアログの<FileName>に設定されているファイル名にオフセット除去後の結果を生成し保存し

ます。

保存後、自動的にダイアログがクローズされ、処理された結果を表示します。 初期値として表示されるファイル名は、カレント

ファイル名に_adj を付加した名前となります。ヘッダファイルの内容は、カレント ファイルと同じでファイル名のみ_adj が付加さ

れた名前となります。

ファイルが読出された場合、同じ表示範囲、スケールで表示されます
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このページはブランクです。
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13． Statis 2 Window
メイン波形表示画面で、解析範囲指定された範囲内にあるデータの統計処理を行うことができます。 STATISⅡは、適用業務により

演算式(演算結果がスカラー量であること)を登録できる統計量演算 Window です。

◆ 使用できる演算関数はダイアログに登録されており、電卓イメージで式を設定できます。

◆ 演算処理ごとに結果をページシートとして生成し、テキストファイルとして保存できます。
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13．１． 操作
13．１．１． 式を登録し演算結果を表示する
① メインの波形表示画面で Statis 2 演算対象の区間を切り出します。

② メニューバーの、[Analyze] -> [Statis2]をクリックします。 デフォルトで表示される演算結果シートは、前回設定され

た条件による選択された解析対象区間の演算結果となります。

③ デフォルトの演算式として、基本的な応力計算の演算式例が登録されています。 登録された演算式の内容を表示、あ

るいは編集するには、[CND]をクリックします。演算式設定ダイアログが表示されます。 デフォルトの内容は、次のとおりです。

登録列番号 登録列名 内容 演算式

1 o max 該当チャネルの最大応力値 MAX(#0)

2 maxPoint 応力最大値のデータポイント MXP(0,#0)

3 o min 該当チャネルの最小応力値 MIN(#0)

4 minPoint 応力最小値のデータポイント MNP(0,#0)

5 o m 平均応力 ($1+$3)/2

6 o w 応力振幅 ($1-$3)/2

7 o t 真破断応力 81 81

8 o e 両振幅換算応力 ($6*$7)/(&6-&5)

ファイル名やコメント、解析対象として切り出さ れ

た範囲の情報が表示されます。

チャネルの演算結果は行ごと表示されます。 列は、左からチャネル番号、チャネル名、演算結果

物理量単位、各演算処理結果を表示します。

Calculation Unit

All を選択すると、すべてのチャネルに対して演算処理を行います。

Select を選択し、リストから単位を選択すると、選択された単位を持つ

チャネルが演算対象チャネルとなります。

処理対象チャネルの参照 参照するチャネル番号の先頭に#を付けて

表します。#1 ではチャネル 番号 1 のチャネルを示します。チャネル番

号 0 の場合、すべてのチャ ネルが演算対象となります。

項目の参照

(列)項目番号の先頭に$をつけて表します。$1 とは列 1 の内容が参

照されている(左の例では MAX(#0)の結果)ことを示します。
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④ 演算式を登録するには、演算式登録ダイアログで[ADD]をクリックします。次のダイアログが表示されます。 すでに設定さ

れた演算内容を変更する場合は、その演算式をダブルクリックすると、ダイアログが表示され編集ができます。

演算式の入力方法

INFIX 記法（通常の計算式）により、表記します。ダイアログ上の組み込み関数ボタンを操作して<Formula>に式を記述しま

す。
演算子は、四則演算(＋、－、＊、/）とべき乗（＾）が使用でき、その他、演算順序制御として括弧”(“,”)”が扱えます。

処理対象チャネルの参照

参照するチャネル番号の先頭に#を付けて表します。#1ではチャネル番号1のチャネルを示します。チャネル番号0 の場

合、すべてのチャネルが演算対象となります。

項目の参照

(列)項目番号の先頭に$をつけて表します。$1 とは列 1 の内容が参照されていることを示します。

組み込み関数

符号変換関数 SGN(X): X の符号を反転します

正領域化関数 PLS(X): X の負領域データをすべて 0 に置き換えます。

負領域化関数 MNS(X): X の正領域データをすべて 0 に置き換えます。

絶対値化関数 ABS(X): X を絶対値化します。

最大値関数 MAX(X): X の最大値を求めます。

最小値関数 MIN(X): X の最小値を求めます。

平均値関数 MEA(X): X の平均値を求めます。 解析範囲

関数 LEN（）: 解析範囲のデータ個数を返します。

自然対数関数 LOG(X): X の自然対数を求めます。 常用対

数関数 LGT(X): X の常用対数を求めます。 指数関

数 EXP(X): X の指数を求ます。

最大値位置関数 MAXP(k,X): X の最大値の位置を返します。ただし、k により返す値が異なります。

k=0 の時 解析範囲の開始点を 0 とした INDEX  値を返します。

k=1 の時 解析ファイルの収録開始点（トリガ点）を 0 とした INDEX 値を返します。

k=2 の時 解析範囲の開始点を 0  とした経過秒を返します。
k=3 の時 解析ファイルの収録開始点からの経過秒を返します。

最小値位置関数 MNS(k,X): X の最小値の位置を返します。 ｋの意味は最大値位置関数に同じです。

実効値関数 RMS(X): X の実効値を求めます。
合計値関数 SUM(X): X の合計値を求めます。

振幅関数 AMP(X): X の最大振幅を求めます。

平方根関数 SQR(X): X の平方根を返します。ただし X>0 の必要があります。

周期関数 PRD( ): ファイルのサンプリング周波数の逆数、周期を sec 単位で返します。

分散関数 VAR(X): X の分散値を返します。
n

 (xi  x)
 2   i1

n



共分散関数

積和関数

演算式

演算式

係数
あるチャネルを

X 軸

傾き
(LEN( )*SOM(#1,#0)

係数

(SOM(#1,#1)*SUM(#0)

(相関係数

以下

X 軸
CVR(#1,#0)/

(標準偏差値

求めます

標準偏差値

n

共分散関数 CVR(X,Y):

積和関数 SOM(X,Y)

演算式の結果は、スカラー

演算式の例 (直線最小

係数の求め方)
あるチャネルを基準

軸を 1ch とし、他

き係数 A は、以下
(LEN( )*SOM(#1,#0)

係数 B は、以下の

(SOM(#1,#1)*SUM(#0)

相関係数の求め方

以下の式で求めます

i1
(xi 

軸を 1ch とし、他
CVR(#1,#0)/（SQR(VAR(#1))*SQR(VAR(#0))

標準偏差値の求め

めます。

標準偏差値は、以下

i1
(x  x )2

Y

CVR(X,Y):

SOM(X,Y)

スカラー量である

直線最小２乗法による

基準として、それぞれのチャネルとの

他のチャネルを

以下の式で定義できます
(LEN( )*SOM(#1,#0)-SUM(#1)*SUM(#0))/(LEN( )*SOM(#1,#1)

の式で定義できます

(SOM(#1,#1)*SUM(#0)-SOM(#1,#0)*SUM(#1))/(LEN( )*SOM(#1,#1)

方) 相関係数は

めます。

 x)( yi  y)

他のチャネルを
SQR(VAR(#1))*SQR(VAR(#0))

め方) 標準偏差値

以下の式で定義できます

2  ii1
( y 

X と Y の共分散値
n


 2   i1

X,Y の積和値

n

xi yi
i1

である必要があります

による

それぞれのチャネルとの

AX+B

Y 軸とします。

できます。
SUM(#1)*SUM(#0))/(LEN( )*SOM(#1,#1)

できます。

SOM(#1,#0)*SUM(#1))/(LEN( )*SOM(#1,#1)

は

Y とします。 相関係数
SQR(VAR(#1))*SQR(VAR(#0))）

標準偏差値は以下の式で

できます。 SQR(VAR(#0))

 y )2

Y=

X
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i

共分散値を返します
  

(x  x)( yi 

n
積和値を返します。

があります。

それぞれのチャネルとの最小２乗法による

AX+B

SUM(#1)*SUM(#0))/(LEN( )*SOM(#1,#1)

SOM(#1,#0)*SUM(#1))/(LEN( )*SOM(#1,#1)

相関係数は、以下

で

SQR(VAR(#0))

2

します。

 y)

による直線近似線

m

m X
A    i1

m

m(
i1

m

 X i

B  i1

m(
i

SUM(#1)*SUM(#0))/(LEN( )*SOM(#1,#1)-SUM(#1)^2)

SOM(#1,#0)*SUM(#1))/(LEN( )*SOM(#1,#1)-SUM(#!)^2)

以下の式で定義できます

2

2

直線近似線を求めます。

m

XiYiX i
i1

m

X i  )  (
i1

m m

Yi  X
i1 i1
m m

 X i  )  (
i1 i

SUM(#1)^2)

SUM(#!)^2)

できます。

13． Statis 2 Window

。

m

Yi 
i1

X i  )

m

X iYi X i
i1

m

 X i  )
1

2

2

Statis 2 Window
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⑤ 演算項目名を編集するには、

削除したい演算項目行を選択し、キーボードの[Delete]ボタンをクリックすると、その行が削除されます。

削除されると、表示が上方向につまります。（演算結果シート上では列方向につまります）

⑥ 演算結果シートは[APPLY]をクリックするごとに、新しいシートがページとして生成されます。 シートが複数枚生成されると、

シート上にページ番号タグが表示されます。表示したいページをクリックすることにより演算結 果シートを切り替えます。

複数シートが生成された場合、Page１以外を表示しているときに[PAGE DEL] ボタンが有効となります。 このボタンをクリック

すると表示されているシートは削除され、ページがつまります

13．１．２． 演算式設定ダイアログの内容を保存し読み出す

演算式設定ダイアログの、[SAVE]をクリックすると、現在の設定内容に名前を付けて保存することができます。

[LOAD]をクリックすると、保存した設定ファイルの内容を読み出して演算式の設定を行うことができます。

<Column Name>セルをダブルクリックす る

と、項目名を入力できます。

セルにマウスカーソルを置き右クリックす

るとダイアログが表示され、項目のコピー

&ペーストができます。

APPLY をクリックするごとにシ ー

トを生成します。
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13．２． 解析結果の保存
13．２．１． 解析結果をファイルに保存する
演算シートの内容をテキストファイルに保存することができます。 演算シートの[SAVE]をクリックすると、ファイル保存ダイアロ

グが表示されます。

あらかじめ演算結果が書き込まれているファイルに追記する場合は、<Append> を選択します。選択されていない場合は、

上書きされます。なお、追記する場合は、演算項目が同じでなければなりません。 すべてのシートを格納する場合は、

<Last Page Write> を選択します。
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14． チャネル間演算 Window
メイン波形表示画面で、解析範囲指定された範囲内にあるデータに対して、チャネル間演算や関数演算を行うことができ、収録デー

タファイルから演算結果を反映した新たなデータファイルを生成することができます。ここで生成されたデータファイル形式は、

PcWaveForm で要求されるファイル形式を満たしており、PcWaveForm プログラムで他の収録ファイル同様に読み込み処理すること

がとができます。

◆ 使用できる演算関数はダイアログに登録されており、電卓操作イメージで式を設定できます。

◆ 演算種類は、四則演算、べき乗演算、70 を超える関数演算、およびテーブル参照が可能です。

◆ 式で記述された演算処理にコメントをつけて登録し、後で呼び出すことができます。
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演算関数一覧 各関数の詳細内容については、別冊(「演算関数仕様編」)に記述します。

１．三角関数 文法 機能

正弦関数 SIN(X) X の単位を rad と見なし正弦値を求める

余弦関数 COS(X) X の単位を rad と見なし余弦値を求める

正接関数 TAN(X) X の単位を rad と見なし正接値を求める

逆正弦関数 ASN(X) X を正弦値と見なし角度 rad を求める

逆余弦関数 ACS(X) X を余弦値と見なし角度 rad を求める

逆正接関数 ATN(X) X を正接値と見なし角度 rad を求める

ディグリ変換関数 DEG(X) X(rad)をディグリに変換する

ラジアン変換関数 RAD(X) X(deg)をラジアンに変換する

π 関数 PI_() π を戻す

２．算術関数 文法 機能
絶対値関数 ABS(X) X の絶対値を求める

累積関数 ACC(X) X の累積値を求める Ans(0)=X(0)、Ans(n)=Ans(n-1)+X(n)

変則累積関数 CHT(k,X,Y) k=初期値 Ans(0)=k×X(0)+Y(0)、Ans(n)=Ans(n-1)×X(n)+Y(n)

差分関数 DIF(X) X の 1 階差分値を求める

微分関数 DIV(X) X の微分値を求める

包絡線関数 ENV(k,X) k=1:絶対値、2:正領域,3:負領域、X の包絡線を求める

波形上限制限関数 GOV(k,X) k=閾値、X の閾値より大きい値を全て閾値に置き換える

波形下限制限関数 GUN(k,X) k=閾値、X の閾値より小さい値を全て閾値に置き換える

積分関数 ING(k,X) k=積分初期値、X の台形積分値を求める

移動積分関数 MIG(k,X) k=時定数、X の移動積分を求める

逆数関数 INV(X) X の逆数を求める

最小公倍数関数 LCM(k,X,Y) k=小数点以下切り捨て桁数、X と Y の最小公倍数を求める

常用対数関数 LGT(X) X の底 10 の対数値を求める

自然対数関数 LOG(X) X の底 e の対数値を求める

指数関数 EXP(X) X の指数値を求める

負領域化関数 MNS(x) X の正領域値を 0 にする

正領域化関数 PLS(X) X の負領域値を 0 にする

整数化関数 INT(X) X の小数点以下を切り捨て整数化する

丸め関数 ROD(n,m,X) n=小数点以下桁数、m=0：四捨五入、1:切り捨て、2:切り上げ

実効値関数 EFF(k､X) X の実効値を求める、k は演算範囲(省略可)

時間重み付け移動実効値関数 RRT(k,X,m) k=時定数、X の移動実効値を m（重み打ち切り値）まで遡った移動実効値を求める

移動実効値関数 RRV(k,X,f) k=時定数、X の移動実効値を求める。f=0：後方積分、f<>0：前方積分

符号反転関数 SGN(X) X の符号を反転する

平方根関数 SQR(X) X の平方根を求める

リサンプリング関数 RSM(k､X) k:=リサンプリング周波数、X のデータ列を k で指定したサンプリング周波数でリサンプリングする。

３．統計関連関数 文法 機能

相関関数 COR(X,Y) X と Y の相互相関関数を求める

移動相関値関数 MCO(k,X,Y) k=データ個数、X と Y の移動相互相関値を求める

移動振幅頻度関数 DOP(k,m,X) k=振幅計数時間、m=無効振幅値、X の振幅計数時間内の無効振幅を超える振幅数を求める

最大値関数 MAX（k,X) X の最大値を求める、k は演算範囲(省略可)

最小値関数 MIN(k|X) X の最小値を求める、k は演算範囲(省略可)

平均値関数 MEA(k|X) X の平均値を求める、k は演算範囲(省略可)

中央値関数 MED(X) X の中央値を求める。

合計値関数 SUM(k,X) X の合計値を求める、k は演算範囲(省略可)

標準偏差関数 STD(k,X) X の標準偏差を求める、k は演算範囲(省略可)

度数分布関数 TRC(k,m,X) k=セルサイズ、m=セル個数、X の度数分布を求める

度数分布統計値関数 TRX(k,m,X,Y,a) K=セルサイズ、m=セル個数、X=度数対象、Y=統計対象、a フラグ u

積和演算関数 MAC(X,Y) X と Y の要素毎乗算結果の合計を求める

共分散関数 VAR(X,Y) X と Y の共分散値を求める

相間係数関数 CRR(X,Y) X と Y の相間係数を求める

最小二乗法係数演算関数 LSM(X,Y) X と Y の最小二乗法で直線方程式 y=ax+b の傾き a とオフセット b を求める

ガンマ関数 GMM(X) X のカンマ関数値を求める

数列同値除去関数 UNQ(X) 昇順並び X 数列から同値を 1 個だけ残す

セル番号/セル代表値演算関数 CNV(k,m,n,f) k=0 セル番号数列、k=1 セル代表値、m=セルサイズ、n=セル数、f=0 正領域、f-1 正負領域
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４．解析補助関数 文法 機能

非線形補正テーブル関数 TBL(AAAA) AAAA で指定したテーブルを参照する

テーブル補間関数 ITP(n,m,X)
n= 補間テーブル X 軸列データ、m=補間テーブル対応にした Y 軸データ、n、m から補間して X

の値に相当した Y 値を求める

戻り値選択関数 RVS(ｋ,X,,Y) k:=フラグ、フラグ値により X 又は Y を戻す

1,2,5 刻み数列関数 ATS(k,n,m) k:刻み上限数、n:最小値、m：最大値 最小値と最大値間を 1,2,5 系列で刻んだ数列を求める

周波数 R10 系列 index 変換関数 FTI(X) X：周波数数列を R10 系列 index 値に変換する

R10 系列 Index 取得関数 ＲＴＩ（ｋ，ｍ） k で示す最小周波数から m で示す最大周波数を含む R10 系列 Index を求めます。

R10 公称周波数変換関数 RTF(X) R10 系列 Index を公称周波数に変換します。

５．論理演算関数 文法 機能

論理積関数 AND(X,Y) X,Y の論理積を求める

否定論理積関数 NAD(X,Y) X,Y の否定論理積を求める

論理和関数 OR_(X,Y) X,Y の論理和を求める

排他的論理和関数 XOR(X,Y) X,Y の排他的論理和を求める

否定論理関数 NOT(X) X の論理を反転する

部分否定論理関数 ECP(k,m,X) k=論理値、m=連続個数 X の k 論理が m 個連続しない所を反転する

X=Y 比較演算関数 EQU(X,Y,k) k=0 の時 X=Y 成立”1”、不成立”0”を戻し、k<>0 の時、成立した X の index を戻す。

X<>Y 比較演算関数 NEQ(X,Y) k=0 の時 X<>Y 成立”1”、不成立”0”を戻し、k<>0 の時、成立した X の index を戻す。

X>Y 比較演算関数 GT_(X,Y,k) k=0 の時 X>Y 成立”1”、不成立”0”を戻し、k<>0 の時、成立した X の index を戻す。

X>=Y 比較演算関数 GTE(X,Y,k) k=0 の時 X>=Y 成立”1”、不成立”0”を戻し、k<>0 の時、成立した X の index を戻す。

X<Y 比較演算関数 LT_(X,Y,k) k=0 の時 X<Y 成立”1”、不成立”0”を戻し、k<>0 の時、成立した X の index を戻す。

X<=Y 比較演算関数 LTE(X,Y,k) k=0 の時 X<=Y 成立”1”、不成立”0”を戻し、k<>0 の時、成立した X の index を戻す。

論理値化関数 RWC(k,m,X) k=倫理”1”の閾値、m=論理”0”の閾値,X を論理波形に変換する

Bit 論理関数 BIT(k,X) k=bit 位置 0~15、X を 2byte 整数に変換し、bit 位置の論理を求める

６．パルス列取扱関数 文法 機能
パルス差分値合成関数 ASS(X,Y) X,Y ともパルス差分値で、X の正数に対応した Y の負数を合成する。

周期計数関数 CNT(X) X の平均値を上昇で過ぎり再び下降で過ぎった回数を求める

F-V 変換関数 FVC(k,X,m) k=1 回転当たりパルス数、X パルス列から回転数に変換する

パルス逓倍関数 PDV(k,X) k=逓倍数、X パルス列を逓倍する

回転パルス生成関数 RTP(k,X) k=1 回転当たりパルス数、X 回転数列からパルスに変換する

パルス間引き整形関数 TPC(k,X) k=パルス間引き数、X パルス列を間引き後、50%比に整形

７．フィルタ関数 文法 機能

4 次バターワース･ハイパス関数 HPF(k,X) k=遮断周波数、X の HPF 処理をする

4 次バターワース･ハイパス関数 HPR(k,X) k=遮断周波数、(時間逆方向 HPF 処理をする

4 次バターワース･ローパス関数 LPF(k,X) k=遮断周波数、X の LPF 処理をする

4 次バターワース･ローパス関数 LPR(k,X) k=遮断周波数、X の(時間逆方向 LPF 処理をする

積分フィルタ LBF(k,X) k=遮断周波数  X に-6dB/oct フィルタ処理する

6 次チェビシェフ･ローパス関数 LCF(k,X) k=遮断周波数、X に 6 次チェビシェフフィルタ処理する

移動平均関数 MAV(k,X) k=平均化個数、X の移動平均を求める

８．補正フィルタ関数 文法 機能

ISO5349 補正フィルタ HTV(X) 手腕振動暴露解析  手腕 X,Y,Z 軸補正フィルタ

ISO26２．１２．/EN12299B 補正フィル

タ関数
WBB(|k,|X) 全身振動暴露解析座位仰臥位 X,Y 軸補正フィルタ

ISO2631-1 C 補正フィルタ関数 WBC(X) 全身振動暴露解析背もたれ X 軸補正フィルタ

ISO2631-1 D 補正フィルタ関数 WBD(X) 全身振動暴露解析座位仰臥位 Z 軸補正フィルタ

ISO2631-1 E 補正フィルタ関数 WBE(X) 全身振動暴露解析座位回転モーメント補正フィルタ

ISO2631-1 K 補正フィルタ関数 WBK(X) 全身振動暴露解析座位仰臥位 X,Y 軸補正フィルタ

聴感補正Ａカーブ・フィルタ関数 WAC(X) X に聴感補正 A フィルタ処理をする

聴感補正 C カーブ･フィルタ関数 WCC(V) X に聴感補正 C フィルタ処理をする

９．ロゼッタゲージ解析関数 文法 機能

最小主ひずみ関数 EMN(a,b,c) ひずみ量 a,b,c から最小主ひずみを求める

最大主ひずみ関数 EMX(a,b,c) ひずみ量 a,b,c から最大主ひずみを求める

主ひずみ方向関数 ETH(a,b,c) ひずみ量 a,b,c から主ひずみ方向を求める

最大せん断ひずみ関数 GMX(a,b,c) ひずみ量 a,b,c から最大せん断ひずみを求める

最小主応力関数 SMN(E,v, a,b,c) E=縦弾性係数、v=ポアソン比、a,b,c から最小応力を求める

最大主応力関数 SMX(E,v, a,b,c) E=縦弾性係数、v=ポアソン比、a,b,c から最大応力を求める

最大せん断応力関数 TMX(E,v, a,b,c) E=縦弾性係数,v=ポアソン比、a,b,c から最大せん断応力を求める

ゲージ率補正関数 GRT(k,X) k=ゲージ率、X を補正する
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１０．数列操作関数 文法 機能

波形数列生成関数 DAG(k,a,m,f,p)
k=生成データ個数、a=波高値、m=波形種別  0:正弦波 1:三角波  2:矩形波 3:鋸波、f=周波

数、p=開始位相角(deg)

数列生成関数 VRP(k,n,m,X)
k:=演算フラグ、k=0 補間なし、k=1 補間あり、n:=生成データ個数、m:=データ番号列、X のデータ

値を m のデータ番号位置に埋め込んだ配列を生成する

Index 範囲指定データ抽出関数 ERC(k,m,X) k=切り出し開始 index、m=切り出し終了 index X から切り出す

Index 指定データ抽出関数 PTV(k,X) k=Index 値、X の k で指定された位置のデータを求める

Index 飛び越しデータ抽出関数 SEP(k, m,X) k=抽出開始 index、m =飛び越し数、X から該当データを抽出する

論理値指定データ抽出関数 ZSP(X,Y) Y のデータ列を X のデータ列値=1 の Index で再構成する

Index 範囲指定データ置換関数 REP(k, X,Y) k=置き換え開始 index、Y の k で指定した開始 index から X のデータに置き換える

Index 指定データ置換関数 SBV(k,m,X) ｋ=index 値、m=データ値、X のｋで指定された位置に m を戻す

Index 飛び越しゼロ内挿関数 INS(k,X) k=挿入するゼロ個数、X データ間にｋ個ゼロ値挿入

数列振幅値変換関数 AMP(k,X) X を振幅値に変換して並び変える k=0：抽出順、1:昇順、-1:降順

数列著大値除去関数 LMT(k,X) k=振幅閾値、X から閾値を超える振幅部を除去して詰める

数列連結関数 LNK(X,Y) X の index 順に Y を連結します

数列縫合関数 MGR(X,Y) X と Y を Index 順に交互に縫合する

数列整列関数 QUE(X,Y) X=index 並び、Y を X の値順に並び変える

数列反転関数 REV(X) X の数列を反転する

数列並べ替え関数 SRT(k,X) k=1：昇順、2:昇順 index 戻り -1：降順,-2：降順 index 戻り

データ個数関数 LEN(k,X) X データ列のデータ個数を求める、k は演算範囲(省略可)

１１．Index 検索関数 文法 機能
閾値通過 Index 検索関数 1

（検索条件毎単発検索）
DTD(k,m, j,n,X)

k=閾値通過方向 0:DownCross 1:UpCross、m=閾値、j=検索方向 0:index 逆順 1:index 順、n=

検索開始 index、X の最初の閾値通過 Index を求める

閾値通過 Index 検索関数 2

（検索条件固定繰り返し検索）
DTM(k,m, j,n,X,o)

k=閾値通過方向 0:DownCross 1:UpCross、m=閾値、j=検索方向 0:index 逆順 1:index 順、n=

検索開始 index、X の閾値通過位置 Index を求める

閾値通過持続 Index 検索関数 1

（検索条件毎単発検索）
CTD(k,m, j,s,n,d,X)

k=閾値通過方向 0:DownCross 1:UpCross、m=閾値、n=検索方向 0:index 逆順 1:index  順、
n=検索開始 Index、s=持続時間、d=持続時間内許容変動値、X の s から j 方向に m 閾値を k 

方向に過ぎってから d 時間内の値が m±d 以内の時、閾値通過位置 Index を求める

閾値通過持続 Index 検索関数 2

（持続個数固定繰り返し検索）
DTE(k,m,n,X)

k=閾値通過方向 0:DownCross 1:UpCross、m=閾値、n=持続データ個数、X の閾値通過後、n

データ数通過が保持されている場合の閾値通過位置 index を求める

閾値通過持続 Index 検索関数 3

（持続時間固定繰り返し検索）
DTF(j,k,m,n,X)

j=検索開始 index、k=閾値通過方向 0:DownCross 1:UpCross、m=閾値、n=持続時間、X の検
索開始 index 以降で閾値を通過し,n 時間通過が保持されている場合の閾値通過位置 index を

求める

2 信号閾値通過 Index 検索関数 DTC(j,k,m,X,n,o,p,Y)

j=検索開始 index、k=開始点変化量閾値、m=次回開始点変化量閾値、n=遅延データ個数、
o=終了点閾値変化量、p=終了点検索方向 0:index 順 1:index 逆順、X の j 地点から開始点変

化量閾値通過位置indexを、Yから開始点閾値通過後遅延データ個数後の終了点閾値通過位

置 indexを求める

直近山谷 Index 検索関数 DTP(k,m,X)
k=検索方向&山谷種別、0:index 逆順谷  1:index 逆順山 2:index 順谷 3:index 順山、m=検索

開始 index、X の m 地点直近山谷位置 index を求める

山谷検索関数 PVF(k,m,X)
k:=演算モードフラグ、m:=無効振幅、X の Peak/Valley 値または peak/Valley 位置データ番号を

求める

値一致データ番号関数 EQP(k､m､X)
k:=演算モードフラグ、k=0 一致したデータ番号、k=1 一致したデータ個数、m:=演算データ列、X

のデータに m で指定したデータを含んでいるかを求める

データ照合関数 FND(k,X,Y) K=0 一致論理、k=1  一致 index

論理遷移 Index 検索関数 LST(k,X) k=0 の時、1⇒0 に遷移したデータ番号、k=1 の時、0⇒1 に遷移したデータ番号

最小値 Index 検索関数 MNP(X) X の最小値位置 index を求める

最大値 Index 検索関数 MXP(X) X の最大値位置 index を求める

区間最大値/最小値 Index 関数 PMP(j,k,m,X)
j=最大値/最小値 0:最小値、1:最大値、k=検索閾値、m=有効閾値 閾値 k を Up Cross して再

び Down Cross する区間の最大値または最小値で有効閾値を越えた位置 Index を求める

一定値区間 Index 検索関数 SWP(m,n, k,X)
m= 窓時間幅、n=窓 Y 軸幅、k=窓 Y 軸 Offset 値、X から設定した窓範囲にデータが入った時

の Index、窓範囲からデータが出た時の Index を求める

ゼロ交点 Index 検索関数 ZIS(k, j,X)
k=解析中心 index、j=解析時間幅、X の k 位置の j で指定した±幅の最大傾きとゼロ軸との交点

Index を求める

存在 index 取得関数 CMP(k,X,,Y) k；検索条件フラグ、X 検索数列、Y 検索対象



１２．文字列取扱関数

文字列指定範囲削除関数

文字列指定範囲切

文字列指定範囲検索関数

文字列挿入関数

文字列配列再構成関数

文字列置換関数

文字列配列文字数取得関数

文字列配列要素数取得関数

文字列数値変換関数

文字列大文字小文字変換関数

文字列要素置換関数

文字列一致検査関数

文字列指定文字削除関数

文字列 Index 

文字列分離関数

文字列結合関数

現在年月日取得関数

現在時刻取得関数

１３．解析情報取得関数
解析対象ファイル

収録チャネル

収録チャネル

収録チャネル

収録チャネル

マーク個数取得関数

マークメモ取得関数

マーク番号 Index 

絶対マーク番号取得関数

サンプリング周期関数

経過時間関数

解析範囲開始

サンプリング単位取得関数

収録開始年月日取得関数

収録開始時刻取得関数

収録開始 X 軸

収録データ個数取得関数

解析対象ファイルコメント

カレントフォルダパス

ファイルステータス

④ 現在表示

す。
[Formula]
当てられることを

右の

括弧

す。演算式

演算式

１２．文字列取扱関数

文字列指定範囲削除関数

文字列指定範囲切り出し関数

文字列指定範囲検索関数

文字列挿入関数

文字列配列再構成関数

文字列置換関数

文字列配列文字数取得関数

文字列配列要素数取得関数

文字列数値変換関数

文字列大文字小文字変換関数

文字列要素置換関数

文字列一致検査関数

文字列指定文字削除関数

Index 指定抽出関数

文字列分離関数

文字列結合関数

現在年月日取得関数

現在時刻取得関数

１３．解析情報取得関数
ファイル名取得関数

チャネル信号名取得関数

チャネル単位名取得関数

チャネル数取得関数

チャネル番号取得関数

個数取得関数

取得関数

Index 取得関数

番号取得関数

周期関数

経過時間関数

解析範囲開始 Index 取得関数

単位取得関数

収録開始年月日取得関数

収録開始時刻取得関数

軸オフセット取得関数

個数取得関数

ファイルコメント取得関数

カレントフォルダパス名取得関数

ファイルステータス取得関数

現在表示されている

[Formula]には、<$1>
てられることを示

の空欄に式を入力

括弧、演算子で構成

演算式の入力は

演算式は全て半角英数字

文法

CDEL(k,n,&m)

CEXT(k,n,&m)

CFND(k,&n,&m)

CINS(k,&n,&m)

CRCP(k,n,&m)

CREP(k,&s,&n,&m)

CLN(&m)

ELM(&m)

CTN(&m)

CBSC(&m,k)

CERP(k,&n,&m)

CEQ(&m,&n,k)

CEC(k,n,&n,&m)

CPTV(k,&m)

CSEP(k,&m)

CNCT(k,&m)

CNDT()

CNTM()

１３．解析情報取得関数 文法
CFNM()

CHNM(k)

CUNT(k)

NCH()

CHS()

NMK()

CMRM(k)

MRK(k)

MKS()

PRD()

SPB(k)

STA()

CXUT()

CSDT()

CSTM()

取得関数 XOF()

NDT()

取得関数 CCMT(k)

CFPN()

RFC(&m)

されている各チャネルに

<$1>と表示されています
示します。このチャネルは

入力します。演算式

構成され通常計算式通

は入力欄にカーソルを

半角英数字で表記して

文法

CDEL(k,n,&m) k 

CEXT(k,n,&m) k 

CFND(k,&n,&m) k 

CINS(k,&n,&m) k 

CRCP(k,n,&m)
k 

k=1 

CREP(k,&s,&n,&m)
k 

←  

CLN(&m) &m 

ELM(&m) &m 

CTN(&m) &m 

CBSC(&m,k) k=0 

CERP(k,&n,&m) k=

CEQ(&m,&n,k) &m 

CEC(k,n,&n,&m)
k:

の

CPTV(k,&m) k 

CSEP(k,&m) k:

CNCT(k,&m) k:

現在年月日

現在時刻

文法
解析対象

CHNM(k) 解析対象

解析対象

解析対象

解析対象

解析範囲

CMRM(k) 解析範囲

k=

解析範囲

解析対象

k=

解析対象

収録

収録開始年月日

収録開始時刻

収録開始

収録

CCMT(k) ヘッダーファイルコメント

カレントに

RFC(&m) 設定

チャネルに 100Hz のローパスフィルタをかけた

されています。これは
このチャネルは、演算

演算式の表記方法

通常計算式通りの記法

にカーソルを移動しクリックすることによりキーボ

して下さい。
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k で指定した文字位置

k 文字位置から n 文字数

k 文字位置から&n 

k で指定した文字位置

k はフラグ、k=0 の時

k=1 の時、n は index 

k で指定した文字位置

←  char replace と等価

&m の文字数を取得

&m 文字列の要素数

&m を数値に変換します

k=0 の時、&m に含

k=置換する index、

&m と&n を比較して

k:検索開始文字位置

の時、一致した全ての

k で指定した&m の

k:セパレータコード  k=

k:セパレータコード k=0 

現在年月日を取得します

現在時刻を取得します

解析対象ファイルのファイル

解析対象ファイルの

解析対象ファイルの

解析対象ファイルの

解析対象ファイルの

解析範囲の付けられているマーク

解析範囲の k で示

k=マーク番号、  マーク

解析範囲に存在する

解析対象ファイルのサンプリング

k=初期値(sec)、累積

解析対象ファイルから

収録サンプリング周期

収録開始年月日を取得

収録開始時刻を取得

収録開始 X 軸オフセット

収録データ個数を取得

ヘッダーファイルコメント

カレントに設定されているフォルダパス

設定したファイルのステータスを

のローパスフィルタをかけた

これは、これから設定
演算 Window ダイアログの

表記方法は次のルールに

記法(Infix 記法)を採用

しクリックすることによりキーボ

文字位置から n 文字数を

文字数を&m 文字列

&n 文字列が&m 文字列

文字位置から&n 文字列を

時、n は論理数列、

index 数列、n に従って

文字位置から&m 文字列

等価

取得する←  char length 

要素数を取得する← char num_element 

します。  ←  assign $n = &m 

含まれる大文字を小文字

、&n 置換文字列、&m 

して k=0 の時論理値を

検索開始文字位置、&n：検索文字列

ての文字列を削除

の Index の文字列を戻

k=０改行、1 半角カンマ

k=0 改行、1 半角カンマ

します。

します。

ファイルのファイル名を取得します

ファイルの信号名を取得します

ファイルの単位名を取得します

ファイルの収録チャネル数を

ファイルの収録チャネル番号

けられているマーク個数

示したマーク番号メモを

マーク番号位置の index 

する先頭マーク絶対番号

ファイルのサンプリング周期を

累積サンプリング周期

ファイルから解析対象開始絶対

周期の単位を取得します

取得します。

取得します。

オフセット値を取得します

取得します。

ヘッダーファイルコメント行からコメント文

されているフォルダパス名

したファイルのステータスを取得します

のローパスフィルタをかけた演算結果

設定する演算式結果
ダイアログの、<ResultStartCh>

のルールに従います。 演算式

採用していま す

しクリックすることによりキーボ ードから

機能

を&m 文字列から削除

文字列から切り出す← char extract 

文字列に含んでいるか検索

を&m 文字列に挿入

、論理数列”1”に対応

って&m 文字列並び替

文字列に&s 文字列に一致

char length と等価

char num_element と等価

assign $n = &m と等価

小文字に、k=1 の時、

&m 置換対象文字列

を戻し、k=1 の時一致

検索文字列、&m：対象文字列

戻す。

カンマ、2tab、3 半角

カンマ、2tab、3 半角

機能
します。  ←  read file_name 

します。  ←read ch_name 

します。

を取得します。  ←  read num_ch 

番号を取得します。  ←  

個数を取得します。

メモを取得します。  ← 

index を取得します。

絶対番号を取得します、

を取得

周期データ列の生成

解析対象開始絶対 Index 値の取得

します。

します。

文を取得します。

名を取得します。

します。

演算結果データファイルを

演算式結果チャネルが、
<ResultStartCh>で設定

演算式は、参照チャネル

す。例えば、10*(20+30)/5 

ードから入力できます

14． チャネル間演算

削除する← char delete 

char extract と等価

検索する← char find 

挿入する← char insert 

対応する&m 文字列

替え← char recomposition 

一致した箇所を&n 文字列

等価

、&m に含まれる小文字

置換対象文字列

時一致した&n の index 

対象文字列、n=0 の時、異なる

半角スペースで文字列

半角スペースで文字列要素

read file_name と等価

read ch_name と等価

read num_ch と等価

←  read ch_series と

← read mark_memo 

取得

データファイルを作成する

、結果ファイルの
設定できます。

チャネル番号、

10*(20+30)/5 の

できます。

チャネル間演算 Window

char delete と等価

等価

char find と等価

char insert と等価

index で再構成

char recomposition と等価

文字列に置換する

小文字を大文字に変換

index を戻す。ﾝ

なる孤児列まで、n=1

文字列を要素に分離する

文字列要素を結合する

等価

と等価

read mark_memo と等価

する例を示しま

ファイルの Ch1 に割り

、関数、定数、

の様に記述しま

Window

変換

する



チャネル

カレントファイル

グに表示

またはすでに

ント範囲

タ(切

個、式中

なることを

範囲指定

開始

番号

チャネル
ルを表

$($n)

定数
いずれも

記述例

演算子
加算

演算子

を表すことはできません

することはできませんので

記述例

括弧
は等しい

記述例

式中

関数
関数

できます

す。

関数記述

はベクトルまたはスカラーのいずれも

場合

複数要素同士

算式中

持つチャネル

ネルとの

なるチャネル

チャネル番号の表記法

カレントファイル（現在波形表示画面

表示されているチャネル

またはすでに登録したチャネル

範囲を指定して参照

切り出し指定された

式中に出現した場合

なることを意味します。

範囲指定した置数例:

開始データ番号は、演算対象範囲

番号+データ個数-1 

チャネル番号の間接表記法
表す場合は、#($n)

$($n)と記述します。ただし

定数の表記法 演算式中

いずれも可能です。 例

記述例:

演算子の表記法
加算は+、減算は-、乗算

演算子は、オペランド

すことはできません

することはできませんので

記述例:

括弧の表記法 演算順序

しい必要が あります

記述例:

式中に出現する括弧の

関数の表記法
関数は大文字半角英数字

できます(用意されている

関数記述の一般形:

はベクトルまたはスカラーのいずれも

場合があります。

複数要素同士の演算

算式中に出現するチャ

つチャネル同士で は

ネルとの演算では、 要素

なるチャネル同士 の演算

表記法

現在波形表示画面に

されているチャネル）を指定する

したチャネル（演算式登録

参照する場合は、#1[

された範囲)が置数されます

場合、出現都度内部

。

: #1[0,200] 

演算対象範囲の左端

1 は解析対象範囲

間接表記法 参照チャネルに

#($n)と記載し、 n は

ただし、いずれも 置数

演算式中に定数を記述

例えば、123.456+123

#2*12.34 

乗算は*、除算は

オペランド（参照チャネル、

すことはできません。例えば、－#1 

することはできませんので括弧を使用します

#1*(-12.3)  

演算順序を指定する

あります。

（（12＋13

の数に制限は有りませんが

大文字半角英数字 3 文字で表記

されている関数とそのパラメータは

関数名(パラメータ

はベクトルまたはスカラーのいずれも可能

演算 先頭文字”#”または

するチャ ネル同士あるいはチャネルと

は、要素ごとに行

要素ごとに単一要素

演算では、演算結

に表示され、チャネル

する場合は、チャネル

演算式登録リスト上のチャネル

#1[開始データ番号

されます。なお、チャネル

出現都度内部の演算仮想レジスタに

#1[0,200] -> Ch1 のデータ

左端を 0 とした値

解析対象範囲のデータ個数と等

チャネルに格納されている

は格納先演算結果

置数に際して範囲

記述することができます

123.456+123－123.34E

#2*12.34 -> Ch2 の全ての

は/、べき乗は^で表

、または定数、関数

#1 の記述はエラーとなります

します。

12.3)  ->  Ch1 に-

する場合や、式の明確

13）－（10＋20）/10

りませんが、ネストされる

表記されるキーワードと

とそのパラメータは後述します

パラメータ)、または

可能です。ただし、

または”$”に続きチャネル

あるいはチャネルと定数

行われ、演算結果

単一要素が参照され演算結果

演算結果の要素数は何
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チャネル間演算 Window 

チャネル番号先頭に#

のチャネル）を参照する

番号,データ個数]と

チャネル番号が式中

レジスタに置数されますので

のデータ番号 0 から 200

値で、先行の演算

等しいか、または少

されている値をチャネル

格納先演算結果チャネル番号を

範囲を指定することはで

することができます。定数は、固定小数点

123.34E-6 の様に記述します

ての値に 12.34 が

表します。演算優先順序

関数）の間に記述します

はエラーとなります。また

-12.3が掛け算されます

明確さを表現するために

/10）*10  ->  結果

ネストされる括弧の数

されるキーワードと括弧からなります

します)。例えば、正

または関数(パラメータ

、複数のパラメータ

きチャネル番号で記述

定数との演算では、

演算結果の要素数に変化

演算結果の要素数

何れか要素数の少

Window が開かれている

#をつけて表します

する場合は、チャネ

と記述します。範囲指定

式中にいくつ出現しても

されますので同じ値

200 個を置数します

演算チャネルの範囲に

少なくなくてはなりません

をチャネル番号として

を表します。同様に

することはできません。

固定小数点、整数

します。

が掛け算されます

演算優先順序は、べき

します。ただし、定数

また、演算式中での

されます

するために括弧を使用

結果は 220となります

数は 4 重までとなります

からなります。関数はダイアログ

正弦関数の場合

パラメータ 1,パラメータ 2) 引数

のパラメータ引数を持つ関 数

記述したチャネルは

、演算式中で要素

変化は有りません。単一要素

要素数は、複数要素を持

少ないチャネルの

かれている収録ファイル）

します。 これから演算式

チャネ ル番号先頭に

範囲指定を省略すると

しても構いません。また

値を取ります。つまり

します

に含まれている必要

なくなくてはなりません。

として指定することができます

に、参照チャネル番号

整数、指数表記の

されます

べき乗->乗除算->加減算

定数を除きオペランドの

での負の定数を記述

使用することができま

となります

までとなります。上記 の例

はダイアログ上のボタンをクリックすることでも

SIN(x)の様に表記

引数は、式、チャネル

数は、パラメータによってスカラー

したチャネルは、複数要素を持

要素ごとに演算されます

単一要素のチャネル

持つチャネルの長

ないチャネルの要素数となります

14． チャネル間演算

）のチャネル（演算式登録

演算式が設定される

に$をつけて表します

すると解析対象範囲

また、同じチャネル

つまり、#1*2-#1 演算

必要があります。また

することができます。この場合

番号を間接指定する

加減算の順序となります

きオペランドの前にマイナスをつけて

記述する場合、演算子

することができます。式中の左括弧

例ではネストは 2 重

のボタンをクリックすることでも

表記します。一般形

チャネル参照、または

パラメータによってスカラー量

持つデータ列として

されます。演算規則は

のチャネル、定数と複数要素

長さとなります。また

となります。

チャネル間演算 Window

演算式登録ダイアロ

される演算チャネル、

します。 データポイ

解析対象範囲の 全てのデー

じチャネル 番号が複数

演算 結果は#1 と

また、開始データ

場合、収録チャネ

する場合は、

となります。通常、

にマイナスをつけて負数

演算子を続けて記述

左括弧と右括弧の数

重となります。

のボタンをクリックすることでも式に入力

一般形を下記に示しま

または定数で、属性

量に限定される

として扱えます。演

は、同じ要素数を

複数要素を持つチャ

また、要素数の異

Window

数

を
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14． チャネル間演算 Window

⑤ 収録データファイルの Ch1(#1)のデータに 100Hz のローパスフィルタをかけたチャネルを、演算結果チャネルの

Ch1($1)に割り当てます。

<Formula>に、直接[LPF(100,#1)]と入力することもできます。

⑥ [OK]をクリックすると設定された演算式が演算式登録 Window に登録されます。

⑦ [CalcExec]をクリックすると演算を実行します。正しい演算式が設定され結果が求められた場合は、リスト内<Result>フ ィ

ールドに<Y>が表示されます。

登録された演算式の記述に誤りがあり演算ができない場合は、<Calc Results Error, Can’t Save!>のメッセージボックスが

表示されます。<Result>フィールドの該当チャネルに<Err>と表示されます。該当の演算式をダブルクリックするか[EDIT]を
クリックして、設定ダイアログを表示し式を再入力します。

エラーが発生した個所のデータは 0 に置換されています。実行時

エラーが発生した新チャネルは生成されていますが、格納対象と

はなりません。実行時エラー内容を確認する場合は、チャネルリス

ト上のエラーチャネルをクリックして反転表示させます。 エラーチャ

ネルが反転表示されると、[ErrorLog]ボタンが有効とな ります。

[ErrorLog]ボタンをクリックするとエラーログダイアログが表 示されま

す。実行時エラー発生原因と発生データ番号をリストボッ クス上に

表示します。なお、発生番号は、演算開始地点を 0 とした

インデックス番号です。実行時エラーの総数が 200 を超える場合、

リストボックスには記載されません。

OK をチェックすると設定された演算式を演算式 Window に登録します。

All をチェックすると、チャネルリスト上で現在設定チャネル以降の他のチャネルにも同じ

演算式を適用します。

最後に、フィルタ周波数の 100(Hz)と,を入力し、

括弧を閉じます。LPF(100,#1)

チャネルリストの#1 をクリックして[Apply]をクリック

すると#1 が表示されます。

次に演算ボタンの LPF をクリックすると、LPF(#1 と

表示されます。

登録された演算式
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14． チャネル間演算 Window

⑧ 演算が正しく実行されると、<Count>および<FirstData>に演算結果が表示されます。次のファイル保存オプションにし た

がった操作を行います。

<Auto Save>にチェックを付けていない場合 演算結果ファイルを、手動で保存します。この場合、事前に[Browse]をクリッ

クして<FileName>にファイル名を設定します。 演算が実行されると[ResultSave]が活性化され、クリックすると事前に設定

したファイル名で演算結果を保存します。
（<FileName>に何も設定していない場合は、演算のみ行われ[ResultSave]は活性化しないためファイル保存は行われませ
ん。

<Auto Save>のみチェックを付けている場合 演算が実行されると、ファイル保存ダイアログが表示され、名前を付けて

演算結果ファイルを保存することができます。

<Auto Save>および<Auto FileName>にチェックを付けている場合 演算結果ファイルが自動保存されます。演算結果ファイ

ルは、現在処理中のカレントファイル名に_calc を付けたファイル名 となりカレントファイルと同じフォルダに保存されます。

<Auto Open>にチェックを付けている場合 保存さ

れた演算結果ファイルを自動表示します。

演算結果ファイルの内容について 演算結果は、収録データファイルと同じ、テキストベースのヘッダファイルとバイナリデ

ータファイルのペアで生成されます。 演算式登録 Window の<Data File Type>で選択されたデータ形式で生成されます。

内部演算は、倍精度で行われ、ここで選択された形でファイル保存されます。

<INTEGER(16bit)が選択されていると、データファイルは２バイト整数形式に変換されます。

演算結果ファイルにヘッダファイルに書き込まれる日付は使用している PC の時計から参照され保存時の日付時刻となりま

す。

収録データファイルに記載されている日付時刻と同じにしたい場合は、Set -> Create File Date にチェックをはずすか、演

算式登録 Window の<Create File Date>にチェックを付けると(操作は連動しています)、演算結果ファイルの日付に元デー

タファイルの日付が適用されます。

解析対象ファイルに記載されていた MARK 情報が解析領域に含まれていた場合、演算結果ファイルにも記載します。ただ

しデータ番号は解析領域の先頭を 0 とした番号に更新されます。なお、時刻はヘッダファイルに記載される生成日付に依

存し元のファイルと同じ生成日付とした場合は変更ありません。生成日付を格納時日付時刻とした場合は、先頭データを

格納時刻としてサンプリング周波数とデータ番号により更新されます。

マーク情報のフォーマット: MARK データ番号,時刻{,音声ファイル名{,アフターメモ}}

解析対象ファイルに記載されていた PAUSE 情報が解析領域に含まれていた場合で、生成日付時刻を元のファイルと同じ と

した場合は演算結果ファイルにも記載します。ただしデータ番号は解析領域の先頭を 0 とした番号に更新されます。なお、

演算結果ファイルに記載される生成日付を格納時日付時刻とした場合は、解析領域に PAUSE 情報が含まれていても反 映

しません。
ポーズ情報のフォーマット: PAUSE データ番号,ポーズ解除時刻

⑨ 演算結果を確認するには、チャネルリストで結果を確認したいチャネルをクリックして反転表示を行い[GraphView]をクリ

ックします。そのチャネルの演算結果波形が表示されます。演算結果波形表示 Window では、マウスをドラッグしてクロスカ

ーソルを移動することで波形データ上のポイントを読み取ることができます。



波形

式登録

ルに

波形として表示されるチャネルは

式登録 Window の

ルに保存することもできます

されるチャネルは、

の<FirstData>で

することもできます。

、演算結果がベクターデータとなる

結果を確認することができます
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がベクターデータとなる

することができます

がベクターデータとなる場合です。

することができます。また、このス

。 演算結果がスカラー

このス カラー量演算結果

14． チャネル間演算

がスカラー量となる

量演算結果は、後述の

チャネル間演算 Window

となる場合は、演算

の操作でファイ

Window
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14． チャネル間演算 Window

14．１．２． 登録済み演算式を編集する

登録済み演算式を削除する 演算式登録エリアの削除したい行を選択した後、右ダブルクリックするか、キーボード

上の[Delete]キーを押します。 押されると、確認ダイアログが表示され、[OK]で閉じると選択されていた行が削除さ

れます。

登録済み演算式を編集する 演算式登録エリアの編集したい行を選択した後、ダブルクリックするか、

Window 上の[Edit]をクリックします。 クリックされると、選択されている行の内容を初期値として演算式設定

ダイアログが表示さます。

演算式登録エリアに演算式を挿入する 演算式登録エリアの新たに演算式を挿入したい行を選択した後、

Window 上の[Insert]をクリックします。 クリックされると演算式設定ダイアログが表示されます。

挿入されると、挿入行以降のチャネルが自動的に付け変わります。また、演算式登録エリアに存在する結果チャネル番号

も同時に振り替えられます。
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14． チャネル間演算 Window

演算式登録エリアにチャネルをコピーして登録する [CH.Copy]をクリックします。<Copy>ダイアログが表示されますので、コ

ピー元のチャネルをクリック、または[Shift]+矢印キ ー、または、[Ctrl]+マウス左ボタンクリックで複数チャネルを選択し、

[OK]をクリックします。

14．１．３． 登録した演算式を保存する
演算式を保存して、他の収録ファイルで再利用する方法は、次の 2 つの方法があります。

登録された演算式リストをテンプレートファイルとして保存・読み出しを行う

演算式登録 Window に登録された演算式は、テンプレートファイルとして保存し、読み出すことができます。

Window 上の[CalcTempSave]をクリックすると、ファイル保存ダイアログが表示され、ファイル名を付けて、拡張子 clc を付

けて保存できます。
また、保存されたテンプレートファイルは、[CalcTempRead]をクリックして演算式登録 Window に読み出すことができます。

この機能により、チャネル間演算のため設定した演算式を用いて、他の収録データファイルで同様の解析を行う場合、ファ

イルに保存された演算式テンプレートを一括で読み出して参照することができます。

登録した演算式自体に情報を付けて保存・読み出を行う チャネル毎に設定した演算式に、解説部を付けて登録保存する

ことができます。 この機能により、他の収録ファイルで同様の解析を行う場合、チャネル毎に演算式を参照することができま

す。演算関数な どを組み合わせてカスタマイズを行った演算式ノウハウを積上げて行くことができます。

① 演算式登録ダイアログに演算式を入力します。



② ダイアログ

その

ダイアログが

説として

③ [OK]

演算式

④ 登録

解析

となく

⑤  複数登録

ダイアログ右下にある

その演算式に解説を

ダイアログが表示されます

として必要な情報

[OK]をクリックすると

演算式が登録されます

登録された演算式

解析する場合や、同

となく、登録された演算式

複数登録された

し、マウス右クリックします

にある[Register]

を付けて保存する

されます。 入力した

情報を入 力します

をクリックすると、入力された

されます。

演算式は、ドラッグ

同じ収録ファイルの

演算式に含まれるチャネル

された演算式情報をファイルとして

クリックします。

[Register]をクリック すると

する ための設定

した演算式の解

します。

された解説とと もに

ドラッグ&ドロップで<Formula>

ファイルの他のチャネルに

まれるチャネル番号

をファイルとして

示
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すると、

設定

解

もに

<Formula>にもってくることができます

のチャネルに同じ演算式

番号などを編集するだけで

をファイルとして保存し(拡張子

にもってくることができます

演算式を適用する場合

するだけで適用できます

拡張子 fml)、読み出すことができます

ドラッグしてドロップするとここに

ログ下部に演算式

ここの内容

をクリックします

にもってくることができます。こうすることで

場合でも、再度すべての

できます。

すことができます

ドラッグしてドロップするとここに演算式

演算式が表示されます

ファイルとして

存されたファイルを

ァイル名が表示

内容を保存するには Load 

をクリックします。

保存されたファイルを

には Save をクリックします

14． チャネル間演算

こうすることで、新たな収録

すべての演算式

すことができます。

演算式が入力されるとともに

ファイルとして保存された場合

されたファイルを読み出した場合

表示されます。

Load 

されたファイルを読み出す

をクリックします。

チャネル間演算 Window

収録ファイルを

演算式を入力するこ

されるとともに、ダイ ア

場合、あるいは保

場合、ここにフ

す

Window
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演算式情報登録ファイルのフォーマットについて 拡張子”.fml“テキスト形式で項目区切り文字半角セミコロン”;”で記述され

ています。 ファイルの先頭行は、ファイルキーワード行で、”REF_FORMULA_FILE” と記述し、当該ファイルが演算式情報登

録ファイル であることを意味します。 一つの演算式の登録は、演算式キーワードを含む開始行、演算式行および演算式中

で参照されているチャネル属性行で 構成され、繰り返すことにより複数の演算式の登録ができます。 なお、演算式中で複

数のチャネルを参照している場合は、チャネル属性行が複数となります。

REF_FORMULA_FILE

REF_FORMULA;日付;時刻;演算式参照チャネル数

タイトル;信号名;単位;演算式

参照チャネル番号;メモ;信号名;単位

REF_FORMULA;日付;時刻;演算式参照チャネル数

タイトル;信号名;単位;演算式

参照チャネル番号;メモ;信号名;単位

タイトル、メモは、演算式登録ダイアログで設定した内容が記録されます。 タイトル、メ

モ、信号名、単位が付けられていない場合は、区切り文字のみ記述します。 次に例を

示します。

REF_FORMULA_FILE 

REF_FORMULA;2009/03/19;09:57:57;1
全身振動前後;車体前後 X 実効値;m/s2;1.4*RRV(1,WBD(#1))

#1;;車体前後加速度_X;m/s2

REF_FORMULA;日付;時刻;演算式参照チャネル数 タイトル;信号名;単

位;演算式

参照チャネル番号;メモ;信号名;単位



14．１．４．

テーブルは

前に

① 演算式登録

テーブル

② 新規

クリックします

テーブル

式中

テーブル

れ、<Data append>

テーブル

タンをクリックします

力し[OK]

テーブル

をクリックします

テーブル

．１．４． テーブルを定義して非線形データを処理する

テーブルは、非線形

に使用するテーブルを

演算式登録 Window 

テーブル数は、10 

新規にテーブルを

クリックします。

テーブル名の入力: 

式中で参照できます

テーブル行の新規追加

<Data append>

テーブル行(ペア)の

タンをクリックします

[OK]をクリックして

テーブル行(ペア)の

をクリックします。クリックされると

テーブル行(ペア)のソート

テーブルを定義して非線形データを処理する

非線形データを線形化

するテーブルを登録する必要

Window の[Table]

10 個までで、ダイアログには

にテーブルを生成する場合

: 新規に作成する

できます。また、テーブル

新規追加: [ADD]ボタンをクリックします

<Data append>に X 値、Y 値

の変更: リストボックス

タンをクリックします。クリックされると

をクリックして編集します。

の削除: リストボックスカラー

クリックされると選択

のソート（並べ替

テーブルを定義して非線形データを処理する

線形化する場合などに

必要があります。

[Table]ボタンをクリックすると

ダイアログには、現在登録

場合、またはすでに

すでに

ストボックス

成

るには

ます

する場合、ダイアログの

テーブル名はテーブル

ボタンをクリックします

値の入力ができます

リストボックス上の編集

クリックされると表示されている

。

リストボックスカラー削除

選択された行(ペア

替え）: [SORT]ボタンをクリックします
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テーブルを定義して非線形データを処理する

などに使用します。

ボタンをクリックすると<Table edit>

現在登録されているテーブル

またはすでに登録済みのテーブル

すでに存在するテーブルを

ストボックス上にペア

成する場合はすべて

るには、[ADD]をクリックし

ます。

ダイアログの<Table Name>

はテーブル保存に際して

ボタンをクリックします。クリックすると

ができます。X 値は入力

編集したい行（ペア

されている値を初期値

削除する行(ペア)

ペア)がテーブルから

ボタンをクリックします

テーブルを

登録

テーブルを定義して非線形データを処理する

。 収録したデータをテーブルにより

<Table edit>ダイアログが

されているテーブル名が

みのテーブル定義ファイルを

するテーブルを編集

にペア番号、X 値

はすべて空欄となっています

をクリックし、<Data append> 

<Table Name>に入力します

して、ファイル名の

クリックすると、現在使用

入力、Y 値は出力

ペア）をクリックすると

初期値として<Data append>

をクリックすると

がテーブルから削除されます

ボタンをクリックします。クリックすると

テーブルを保存します。

登録されたテーブルを

テーブルを登録

したデータをテーブルにより

ダイアログが表示されます

が表示されます

ファイルを一時的

編集する場合はダイアログ

値、Y 値が表示されてされています

となっています。 ペアを

<Data append> を表示

します。ここで入力

の初期値として使用

現在使用されているペア

出力として参照されます

をクリックすると反転表示されます

<Data append>が表示

をクリックすると反転表示されます

されます。なお、削除

クリックすると、X 値の昇順

14． チャネル間演算

されたテーブルを編集します。

登録から削除します。

したデータをテーブルにより変換する場合

されます。 同時に使用

されます。

一時的に編集する場合

はダイアログ上に、Table Name 

されてされています

ペアを新規作成、

表示し、X と Y 

入力されるテーブル

使用されます。

されているペア番号最大値+1 

されます。

されます。この状態

表示されます。変更

されます。この状態

削除は１行ずつしかできません

昇順に並べ替えられます

チャネル間演算 Window

場合、演算式定義

使用(登録)できる

場合、[EDIT]を

Table Name とリ

されてされています。新規に作

、または追加す

Y の値を入力し

されるテーブル名が演算

+1 が割り当てら

状態で、[EDIT]ボ

変更したい値を入

状態で[DEL]ボタン

ずつしかできません。

えられます。

Window

できる

とリ

作

てら

ボ

入



新規

テーブル

直線
yk=｛

また、

と X1,Y1

③ テーブルを

保存

テーブルファイルのフォーマット

テーブル

PWF_TABLE

PAIR=3

0,0

10,20

20,40

(最大

④ あらかじめ

番号

テーブル

い。すでに

⑤ 削除

ます

すでに

照されていないことを

⑥ 演算式中

の２種用意

えば

直接

ル名

新規に生成したテーブルまたは

テーブル参照は部分線形法

直線で補外処理されます
｛(Y4-Y3)/(X4

、Xk が X5 より大

X1,Y1で構成される

テーブルを保存

保存ダイアログが表示

テーブルファイルのフォーマット

テーブル定義ファイルは

PWF_TABLE

PAIR=3

10,20

20,40

最大テーブルペア

あらかじめ作成したテーブル

番号を選択した後、

テーブル登録エリアは

すでに、登録済

削除したいテーブルを

ます。[OK]ボタンをクリックすると

すでに、演算式で参照

されていないことを

演算式中でのテーブル

種用意されています

えば、エリア番号 3

直接テーブル名称を

名が複数登録されている

Y5

Y4

X0   X1 X2

Y1

Y0

したテーブルまたは、編集追加

部分線形法により

されます。被修飾
Y3)/(X4-X3)｝* (Xk-X3)

大きい時は、X4,Y4

される直線を延長

保存するには、<Table edit>

表示され、ファイル

テーブルファイルのフォーマット

ファイルは、拡張子.tbl 

テーブルペア数は 30 組となります

したテーブル定義

、[READ]ボタンをクリックし

エリアは 0～9 の 10 

登録済みエリアに読み

したいテーブルを選択した

ボタンをクリックすると、

参照されているテーブルを

されていないことを確認してください

でのテーブル参照の方法

されています。テーブル

のテーブルを参照

を記述します。

されている場合、

X3

Y1

Y0

編集追加した場合

により補間処理されます

被修飾データ Xk が
X3)＋Y3 の直線

X4,Y4 と X5,Y5 で

延長して補外されます

<Table edit>テーブル

ファイル名を付けて保存

.tbl のテキスト形式

１行目

2 行目

3 行目以降

4 行目

5 行目

となります。)

定義ファイルを読

ボタンをクリックし読み

10 個分用意されています

み込むと読み込まれた

した後、[DEL]ボタンをクリックします

削除されます。

されているテーブルを削除

してください。

方法はテーブル

テーブル番号(登録エリア

参照する場合 %3

例えばテーブル

、最もテーブル番号

X4  X5
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場合、必ず並べ替

されます。対象となるデータが

X3 と X4 の間
直線の方程式で補間

で構成される直線

されます。

テーブル登録ダイアログの

保存することができます

形式です。フォーマットは

キーワード

テーブル

行目以降 テーブル

読み出す場合、<Table edit>

み出し登録することができます

されています。登録

まれた内容に更新

ボタンをクリックします

。

削除した場合、演算実行時

はテーブル番号を記述する

エリア番号)で参照

%3 と記述します

えばテーブル名称が INVERT 

番号の若いテーブルが

替え操作を行って

となるデータが定義

間にある時、修飾
補間されます。

直線を延長して補外

ダイアログの[SAVE]ボタンをクリックします

することができます。

フォーマットは以下の

キーワード固定です

テーブル定義ペア数

テーブル定義ペアで

<Table edit>テーブル

することができます。

登録するエリアを選択

更新されます。

ボタンをクリックします。クリックすると

演算実行時にエラーとなります

する方法と TBL 

参照する場合、先頭文字

します。また、テーブル

INVERT の場合、TBL(INVERT)

いテーブルが参照されます

って下さい。

定義した X の範囲

修飾された結果の

補外され、同様

ボタンをクリックします

の様になります。

です。

数です。

ペアで、1 列目が X

テーブル登録ダイアログ

。

選択した後、[READ]

クリックすると削除確認メッセージダイアログが

にエラーとなります。削除

TBL 関数を使用してテーブル

先頭文字%に続きエリア

テーブル名で参照する

TBL(INVERT)と記述

されます。

14． チャネル間演算

範囲を越えている場合

yk は、

同様に X0 より小さい

ボタンをクリックします。クリックするとファイル

。

X、2 列目が Y となります

ダイアログ上の登録先

[READ]ボタンをクリックしてくださ

メッセージダイアログが

削除する場合、

してテーブル名で

きエリア番号を記述

する場合は、TBL

記述します。同じ名前

チャネル間演算 Window

場合は、最後の

さい時は、X0,Y0 

クリックするとファイル

となります。

登録先テーブル

ボタンをクリックしてくださ

メッセージダイアログが表示され

、演算式で参

で記述する方法

記述します。 例

TBL 関数を使用 し

名前のテー ブ

Window

X0,Y0 

方法

し、



14．１．５．

サンプリング

間サンプリングに

て行

① 演算式登録

② [Base]

リサンプリングの

<Base setting>

入力

リサンプリングは

1/2 

新旧

周波数

<Base setting>

経過時間又

要で

処理対象

ます

周期

メートル

．１．５． リサンプリング処理と周波数

サンプリング周波数

サンプリングに変更

行われます。

演算式登録 Window 

[Base]ボタンをクリックすると

リサンプリングの設定

<Base setting>設定

入力が有効となります

リサンプリングは新旧

1/2 で位相遅れ無

新旧の最小公倍数

周波数/空間周波数

<Base setting>設定

経過時間又は走行距離

で、反対に等距離

処理対象チャネルは

ます。

周期の入力: サンプリング

メートル(m)を単位とします

ここをクリック

ここをクリック

リサンプリング処理と周波数

周波数の変更や、等時間

変更することができます

Window の<BaseConv>

ボタンをクリックすると設定

設定

設定ダイアログの<Sampling Frequency Change>

となります。周波数入力

新旧の周波数の最小公倍数

無しローパスフィルタで

最小公倍数が変更前の周波数

空間周波数の相互変換

設定ダイアログの<Base Change>

走行距離チャネルの

等距離サンプリングから

チャネルは、収録ファイル

サンプリング周期を入力

とします。サンプリングは

ここをクリック。

ここをクリック。

リサンプリング処理と周波数

等時間サンプリングから

することができます。いずれも

<BaseConv>チェックボックスにチェックを

設定ダイアログが

<Sampling Frequency Change>

周波数入力にリサンプリングする

最小公倍数まで

しローパスフィルタで処理された

周波数の 10 倍程度

相互変換の設定

<Base Change>

チャネルの選択: 等時間

サンプリングから等時間サンプリングするためには

ファイル(CurrenFile)、

入力します。等時間

サンプリングは周波数

チャネルを
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リサンプリング処理と周波数/空間周波数の相互変換

サンプリングから等距離サンプリング

いずれも、演算実行時

チェックボックスにチェックを

ダイアログが表示されます。

<Sampling Frequency Change>

にリサンプリングする周波数

まで、いったんゼロ内挿入法

された後、変更する

倍程度を限度に行

<Base Change>を選択します。

等時間サンプリングから

サンプリングするためには

、演算結果ファイル

等時間サンプリングへの

周波数、または空間周波数

リサンプリング

周期

チャネルを選択。

空間周波数の相互変換

サンプリング、またはその

演算実行時にすべてのチャネルの

チェックボックスにチェックを付けます。

。

<Sampling Frequency Change>を選択します

を入力します。

内挿入法によりアップサンプリングされ

する周波数でダウンサンプリングし

行って下さい。

。選択されると次

サンプリングから等距離サンプリングするためには

サンプリングするためには経過時間

ファイル(Calc.Ch)のいずれのファイル

サンプリングへの変換時は

空間周波数の何れも

リサンプリング後の周波数

周期を入力。

空間周波数の相互変換

またはその反対に

にすべてのチャネルの演算結果

。

します。 選択されると

。

によりアップサンプリングされ

でダウンサンプリングし

次の入力が有効

サンプリングするためには

経過時間チャネルが存在

のいずれのファイル

は秒(sec)、等距離

れも周期(波長)で設定

周波数を入力。

14． チャネル間演算

に等距離サンプリングから

演算結果が求まった

されると変更するサンプリング

によりアップサンプリングされ、変更する

でダウンサンプリングし最後に振幅復元

有効となります。

サンプリングするためには走行距離

存在していなければなりませ

のいずれのファイル内のチャネルが

等距離サンプリングへの

設定します。

チャネル間演算 Window

サンプリングから等時

まった直後に一括し

するサンプリング周波数

する周波数の

振幅復元を行います。

走行距離チャネルが必

していなければなりませ ん

のチャネルが選択でき

サンプリングへの変換時 は

Window

等時

し

周波数

。

ん。

は
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14．２． 解析結果の保存
14．２．１． スカラー量演算結果をファイルに保存する
演算結果で最大値や平均値など、ひとつのデータから成り立っている演算結果をリスト表示し保存する機能です。 他の統

計解析機能では結果は収録チャネルごとに得られることが前提となっており、複数のチャネルや演算式を参照した 結果を

求めることができません。本機能により、チャネルをまたいだ統計量や評価値などを演算解析表示することができま す。

① ベクター量演算結果が得られると、結果を保存するかどうか[Memo]チェックボックスが有効となります。

② 保存する場合、チェックボックスにチェックを付けます。現在の演

算結果を<Scalar Memo>に書き込みます。以後、演算終了ごとに書き

込みます。ただし、チェックボックスにチェックを付けた時点で、<Scalar 

Memo>の初期化が終了していない場合は（生成されていない場合）、

チェックボックスをチェックすると、<Scalar Memo> 生成ダイアログ

<Channel Select>が表示されます。 ダイアログ上には、現在結果がス

カラー量で求まっているチャネル番 号（$X）とその信号名が表示され

ています。Memo 記録するスカラー量 チャネルのチェックマークをつけ

ます。ここでチェックされた演算結果チ ャネルが<Scalar Memo>リスト

の列として生成され、以後演算を繰り返 すごとに記録されます。なお、

初期値はすべてチェック状態となりま す。

③ 演算式登録 Window 上の[MemoList]は、スカラー量が記録されていると有効です。クリックすると<Scalar Memo>が表

示されます。



リストは

ャネル

ない

Memo: 1 

リスト

降の

④ <Scalar List>

存されたファイルは

ファイル

ファイル

⑤ <Scalar Memo>

が必要

生成

ログを

設定

リストは、1 回の演算結果

ャネル方向がならびます

ない場合および単位

Memo: 1 行の演算

リスト行を削除するには

の行が詰まります

<Scalar List>の

されたファイルは

ファイル名を付けて

ファイル保存例

<Scalar Memo>

必要です。初期化

生成ダイアログ<Channel Select>

ログを閉じると、表示中

設定された Memo Sheet 

演算結果を１行で表示

がならびます。ただし、

単位が異なっていた

演算ごとにメモを記入

するには、削除する

まります。

の保存: <Scalar List>

されたファイルは MS エクセルなどで

けて保存します。

<Scalar Memo>の初期化: 演算

初期化を行う場合[Create]

<Channel Select>が

表示中の<Scalar Memo>

Memo Sheet のフォームは

表示し、したがって

、<Scalar Memo>

なっていた場合は、演算結果

記入することができ

する行をクリックして

: <Scalar List>の書き込

エクセルなどで開くことができます

演算式の変更や

[Create]をクリックします

が表示されます

Memo>が初期化

ームは、途中で変更
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したがって行方向には

<Scalar Memo>初期設定した

演算結果を書き込

することができ。入力する項目

をクリックして選択後、キーボードの

込まれた内容を、

くことができます。[Save]

や保存する演算結果

をクリックします。クリックされると

されます。<Scalar Memo>

初期化され、求まっている

変更された場合

には演算回数分生成

した内容と演算結果

込みません。

項目セルをダブルクリックすると

キーボードの[Delete]

、拡張子 csv のテキスト

[Save]をクリックするとファイル

演算結果チャネルを

クリックされると、現在

Memo>に記録する演算結果

まっている演算結果

場合は、記録されたすべての

演算回数分生成されます。また

演算結果がスカラー量

セルをダブルクリックすると入力可能状態

[Delete]キーを押します

のテキスト形式で

をクリックするとファイル保存

チャネルを変更する場合

現在の演算結果を

演算結果チャネルを

演算結果チャネルを保存

されたすべての値を

14． チャネル間演算

また列方向は、演算結果

量でない場合や

入力可能状態になります

します。行を削除すると

で保存することができます

保存ダイアログが表示

場合、<Scalar Memo>

を基準とした<Scalar Memo> 

チャネルを選択します

保存します。

を失います。

チャネル間演算 Window

演算結果のチ

や、存在してい

になります。

すると、削除以

することができます。保

表示されます。

<Scalar Memo>の初期化

<Scalar Memo> 

します。このダイア

Window

<Scalar Memo> 
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14．３． 演算関数
関数ごとに、その機能詳細や文法、演算仕様をご説明申し上げます資料は、「演算関数仕様編」として別冊になっています

ので、そちらをご参照下さい。
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このページはブランクです。
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このページはブランクです。
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15．  NoteBook Window

15． NoteBook Window
NoteBook Window は、収録データファイルの統計値を記録管理する Window です。同じ収録データファイルから MARK 区間毎の統

計値を一度に演算する機能の他、収録データファイルをまたいで同じ NoteBook ファイルに記録することなどができます。

◆ 演算項目は、最大値、最小値、平均値、最大振幅値、変動値、実行値です。

◆ 判定条件を設定して、結果表示に判定結果を反映することができます。



15．１． 操作
15．１．１．
NoteBook 

ます
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シート名およびシートコメントのファイルからの読み出し

シート名およびコメントを、あらかじめ csv 形式ファイルにて生成した場合、当該ファイルから読み出して設定することができま

す。

<Book Condition>ダイアログの[Read RefFile]をクリックします。ファイル読み出しダイアログが表示されます。

ファイル名を設定してダイアログを[OK]をクリックして閉じると、ファイルの内容に設定されます。 なお、シート

名およびコメントファイルのフォーマットは、1 列目がシート名、2 列目がシートコメントとなります。

シート、シート名、コメントの Copy と Paste コピーするセルにカーソルを移動し、クリックして反転表示させます。、反転表示

後、右クリックすると、編集ツールボックスが 表示されます。[Copy]を選択します。次に Paste 先セルをクリックして反転表示

させます。Paste 先が決定したら、右クリック しすると、編集ツールボックスが表示されます。[Paste]を選択します。
なお、シート番号セル(No.)を選択して Copy すると、シート自体が Copy されます。

④ 次に、シートのページ構成を設定します。<Book Condition>ダイアログの設定を行うシート番号セルをダブルクリックする

と<NoteBook Sheet Condition>ダイアログが表示されます。

このダイアログでは、列数、列名、およびページ名と表示条件を設定します。 列数は、ダイアログ上の<Columns>に列数を入

力します。入力後フォーカスを外すと設定されます。 列名は、<Name>セルをダブルクリックして入力する方法と、あらかじめ

csv 形式ファイルを作成し、この作成された列名ファ イルから読み出す方法があります。ファイルから読み出す場合は、

[Read RefFile]をクリックします。列名ファイルは拡張 子.csv のテキスト形式です。1 列目が列番号、2 列目が列名となりま

す。

判定表示の設定

演算結果を、設定数値ページ(初期値名称 VAL)に記載した数値と比較し、設定条件が成立した場合、演算結果数値の表

示色を変更することができます。設定は、<NoteBook Sheet Condition>ダイアログの<Cnd>で行います。

参照値ページの設定は、#1 セル、#2 セルをダブルクリックし、選択可能な Value ページから選択します。 条件成立時の表

示色の設定は、Pen セルをダブルクリックしまスカラーパレットダイアログが表示され、色の選択ができます。

条件式 内容 参照

ページ数

NON 条件を使用しません。 0

<=#1 参照値より小さいか等しいと成立 1

<#1 参照値より小さいと成立 1

>=#1 参照値より大きいか等しいと成立 1

>#1 参照値より大きいと成立 1

>=#2 & <#1 参照値 2 より大きいか等しく、参照値 1

より小さいと成立

2

>#2 & <=#1 参照値 2 より大きく参照値 1 より小さい

か等しいと成立

2

<#2 | >#1 参照値 2 より小さいか、または参照値

1 より大きいと成立

2

こ こ を ダ ブ ル ク リ ッ ク す る と 、

NoteBook Sheet Condition ダイア

ログが表示されます。

ダブルクリックするとページ名を入

力できます。

ダブルクリックすると列名を入力で

きます。

ダブルクリックすると判定条件がリ

スト表示されます。
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⑤ 設定数値ページ（初期値名称 Value）および設定メモページは削除、あるいは追加することができます。 演算結果表示

ページおよび先頭ページは削除/追加はできません。 ページ名称欄を右クリックするとページ編集メニューが表示されます。

ページを追加する場合、追加ページの属性により次の何れかのメニューを選択しま

す。
[Add a char page to the tail]は、最終ページの次にメモページを追加します。
[Add a value page to the tail]は最終ページの次に数値ページを追加します。

ページを削除または初期化する場合は、[Delete or Initialze]をクリックします。 設定

数値ページおよび設定メモページはそのまま削除されますが、演算結果表示 ペー

ジおよび先頭ページは、削除されることはなく、初期化されます。

⑥ 表示ページを切り替えるには、表示したい<Page>セルをダブルクリックします。ダブルクリックされると当該ページを表示

します。

⑦ 設定数値ページ(初期値名称 Value)を編集するには、Window 左側ページリストから設定数値ページのページ番号をダ

ブルクリックし、編集したい設定数値ページを表示します。 入力するセルをダブルクリックすると入力可能となります。設定す

る数値を直接入力します。 また、セルを右クリックすると編集ツールボックスが表示されます。セルを Copy し他のセルに

Paste することで、各セルに入 力する手間を低減することができます。

⑧ 既存 NoteBook ファイルの表示と演算追加

すでに生成されている NoteBook の表示あるいは、演算結果を追加する

場合、NoteBook ファイルを指定して読み出す必要があります。 ファイルを

指定しなくても初期値設定状態での NoteBook を表示し、演算 実行し演

算結果を記録することが可能ですが、生成済み NoteBook ファイ ルに追

記することはできません。現在の表示がファイルの内容を表示して いるか、

または、メモリー上の NoteBook の内容を表示しているかは、 Window 左

上の<File Name>で確認します。ここに何も表示されていない場 合はメモリ

ー上の NoteBook が表示されています。
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NoteBook ファイルの読み出し、保存は[Browse]をクリックします。<Input a file name to create or select a file to read>が

表示されます。ダイアログ上で読み出すファイル名を指定します。

NoteBook ファイルは、NoteBook Window が閉じられると自動的に Close され、また、いったんファイル名が指定されている

と、次回、NoteBook Window が開かれると同時に自動的に読み出されます。

NoteBook ファイルを指定せずに解析結果を求めた後、すでに存在する NoteBook ファイルを読み出すと、表示されている

内容が読み出された NoteBook ファイルの内容に更新されます。

15．１．２． 演算を実行する
①  演算範囲を、<Calc Area>で選択します。

<ALL>が選択された場合は、設定されている解析範囲全体の演算を行います。

<MARK>あるいは<PAUSE>が選択されている場合は、解析範囲に含まれる MARK、あるいは PAUSE ごとに演算されます。

なお、結果は MARK、あるいは PAUSE で区切られた区間分の列を使用します。

② 解析範囲を設定した後、NoteBookWindow を起動した場合は、[CALC EXEC]が有効となっています。演算範囲を指定

後、[CALC EXEC]をクリックすると設定されている解析範囲を演算し結果を、各演算結果ページに書き込みます。 規制値

判定条件が設定されている場合で成立したセルは設定されている PEN 色で表示されます。

演算範囲に<MARK>、あるいは<PAUSE>を選択した場合でも、設定された解析範囲にMARK、あるいはPAUSEが存在して

いないと解析範囲全体の値求めます。(<ALL>を設定した場合と同じ結果となります。)

MARK、あるいは PAUSE が含まれている場合、解析範囲に設定された地点から最初に存在する MARK、あるいは PAUSE 

位置までを最初の区間とし、また最後のMARK、あるいはPAUSEから解析範囲の最終点までを最後の区間として演算結果

を求めます。したがって、MARK 区間毎に演算結果を求めたい場合は、解析範囲指定時に正確に MARK 位置から MARK 

位置までを解析範囲に設定する必要があります。

③ いったん演算した結果の取り消しは、[CLEAR COLUMNS]をクリックします。<Note Book Editing>が表示されます。 最終

列から何列分を演算取り消しするかを<Clear Colums>に入力します。初期値は 1 で、演算結果を求めた最終列の演 算が

取り消されることを意味します。途中の列を消去することはできません。
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15．１．３． 異なった収録データファイルでの NoteBook ファイルの共有

同じ、NoteBook ファイルを異なった収録ファイルで使用することができます。ただし、同時に NoteBookWindow を開いた場

合、同じ NoteBook ファイルを使用することはできません。
NoteBook ファイルは、Window が閉じられるごとに更新されています。したがって、同時に異なった収録ファイルの結果を書
き込みたい場合は、たがいに NoteBookWindow を明確に閉じる操作を行うことで可能となります。

例えば、A,B の 2 種の収録ファイルの同時表示している場合に、A ファイルの結果を記録した NoteBook ファイルに B ファイ

ルの結果を追加記録する場合は次の様な手順となります。

① A ファイルの波形表示 Window で解析範囲を設定します。

②  NoteBook   Window を起動します。

③  記録すべき NoteBook ファイルを登録します。

④ 演算実行します。

⑤  NoteBook Window を閉じます。  → NoteBook ファイルに結果が記録された後、CLOSE されます

⑥ B ファイルの波形表示 Window で解析範囲を設定します。

⑦  NoteBook   Window を起動します。

⑧ 記録すべき NoteBook ファイルを読み出します。 →NoteBook ファイルが OPEN されます

⑨ 演算実行します。

⑩  NoteBook Window を閉じます。  → NoteBook ファイルに追加された結果が記録された後、CLOSE されます

異なったファイルで同じ NoteBook ファイルを共有する場合、解析対象ファイルのサンプリング周波数は異なっていても問題

ありませんが、チャネル構成及び単位は同じ必要があります。 異なっている場合は、新たに解析対象となった収録ファイル

のチャネル構成に従います。

同じチャネル番号で信号名、および単位が異なっている場合は、自動的に最後に解析対象となったファイルに記載されて

いる信号名および単位に更新されますので注意が必要です。

直前の結果で存在していないチャネルが含まれた場合は、自動的にチャネルが追加されます。 直前まで

存在したチャネルが含まれてない場合は、直前までの存在したチャネルの結果は削除されます。
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16． Archi_1 Script
Arch_1 Script とは、PcWaveForm 上で記述し任意の解析を実行する機能を持った Script 言語体系の名称です。

PcWaveForm では、任意の解析を行うことのできる独自のプログラムを、PcWaveForm に用意された各種の関数を用いて、処理手続

きを記述(Script)し実行することができます。このプログラム言語機能を用いて、元データファイルから演算・フィルタ処理されたデータ

ファイルの生成、データファイルの一括自動解析、グラフを含む解析レポートの作成などを行うことができ、データ解析作業の効率化

を図ることができます。

◆ フォルダ内データファイル(PcWaveForm 形式/テキスト形式)の一括処理ができます。

◆ チャネル間演算 Window で行っているデータ解析処理の自動化を図ることができます。

◆ Script 処理結果は、PcWaveForm 形式波形データファイル、テキスト形式の解析結果シート、BMP 形式グラフ、PcWaveForm 手

書き Window データプロット機能用のプロットデータファイルなどの形で得ることができます。



16．１． Archi_1 Script 
16．１．１．編集
PcWaveForm 

Window 

Window 

Window 

Window 

16．１．１．１．
編集

16．１．１．２．作成・保存された
編集

[File]

演算式

Archi_1 Script 
．１．１．編集

PcWaveForm の波形表示画面

Window を表示します

Window は 3 分割

Window で作成した

Window のエリア分割

．１．１．１．
編集 Window のメニューバー

．１．１．２．作成・保存された
編集 Window のメニューバー

[File]メニュー

演算式/Archi_1 ファイルリスト

Archi_1 Script の作成と編集操作
．１．１．編集 Window を起動する

波形表示画面 メニューバーの

します。この Window 

分割され、中央が

した演算式ファイル

分割サイズを変更

Archi_1 Script 
のメニューバー[File]

．１．１．２．作成・保存された
のメニューバー[File]

ファイルリスト

の作成と編集操作
を起動する
メニューバーの

Window において、Archi_1Script 

が Archi_1 編集作成

ファイル（拡張子.clc）

変更する場合は、境界線

Archi_1 Script を新規作成する場合
[File]メニューから[New(

．１．１．２．作成・保存された Archi_1 Script
[File]メニューから[Open(

New(N)： 新規作成

ます。なお

保存するか
Open(O)：

ァイル読み

Save(S)：

Save As(A

択するとファイル

Print(P)：

Print Setup(

Exit： PcWaveForm 

編集作成

Page 116

の作成と編集操作
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16．１．２． 記述エリアへの書き込み方法
記述エリアの書き込みする位置にカーソルを移動し、キーボードから入力します。

記述規則は、別冊の「Archi_1 Script 記述方法編」の第 1 章：「記述の基本則」をご参照下さい、なお、記述構文の記述則

については、同様に Archi_1 記述方法編の各項を参照下さい。また、構文毎の詳細仕様については別冊、「Archi_1 Script 

言語仕様編」を、記述する演算関数の詳細仕様ついては「Archi_1 Script 演算関数仕様編」をご参照下さい。 入力された

文字列は色分けして表示されます。Script キーワード：青色表示、コメント文：緑色表示、文字列即値：茶色表 示、その他文

字列：黒色表示となります。

16．１．２．１． Archi_1  Script 文の挿入
入力はキーボードから直接入力する以外に、Window 右側 Archi_1 構文 Key Word 

リストから挿入する KeyWord をドラッグして、Window 中央部の記述編集エリアにドロ

ップすることで行うこともできます。ドロップすると、ドロップ位置の行に挿入され、以前

に記述されていたスクリプト文は、1 行下方に移動します。ただし、ドロップした構文の

項目（引数）は、ドロップした後、キーボードから入力して下さい。

16．１．２．２． 演算式ファイルの挿入
演算式はキーボードから直接入力する以外に、チャネル間演算 Window で作成し保

存した演算式ファイル(拡張子.clc)を、作成中の Archi_1 Script に挿入することができ

ます。Window 左側、ファイルリスト上部の<Formula>タブをクリックして、表示を演算式

ファイルリストに切り替えます。次に[BROWSE]ボタンをクリックして挿入する演算式ファ

イルが格納されているフォルダを選択します。選択するとフォルダに格納されている演

算式ファイルがリストに表示されます。

表示されているファイルリストから挿入したい演算式ファイルをドラッグして、記述編集エリアの挿入する行にドロップすること

で、演算式を Archi_1 Script に挿入できます。

16．１．２．３． Archi_1 Script ファイルの挿入
すでに作成した Archi_1 Script ファイルを挿入することができます。Window 左側、フ

ァイルリスト上部の<Procedure>タブをクリックして Archi_1 Script ファイルリストに切り

替えます。次に挿入する Archi_1 ファイルが格納されているフォルダを[BROWSE]ボ

タンをクリックして選択します。挿入する Archi_1 Script ファイルをドラッグして、記述

編集エリアにドロップします。ドロップした行から挿入され、以前に記述されていた

Archi_1 Script 文は挿入したファイル構成行分、下方に移動します。

16．１．３． 編集機能
記述編集エリアの記述内容は、メニューバー[Edit]のプルダウンメニューから編集機能を選択して編集することができます。

[Edit]のプルダウンニュー

Undo(U)： 行った編集操作を直前の状態に戻します。

Cut(T)： 選択されている範囲を切り取り、一時的に内部に保持します。

Copy(C)： 選択されている範囲を一時的に内部に保持します。

Paste(P)： 内部に保持された内容を現在カーソル位置に貼り付けます。

Delete(L)： 選択されている範囲を削除します。

Find(F)： 指定した文字列を探します。

Replace(R)： 指定した文字列を置換します。

RefChRenubering： 参照チャネル番号を振り替えます。

Indent： 記述されている内容を行段付けします。

Ch list： 記述されているチャネル番号リストを表示します。

proc LINK： 外部演算処理ブロックをリンクします。
ColorCode： カラーパレットダイアログを表示しカラーコードを挿入します。
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16．１．３．１． Cut： 文字列切り取り機能

記述した Script 文から任意箇所を指定して切り取る機能です。切り取った文字列は、いったん、内部に保持されており、後

述する文字列貼り付け機能により転写可能です。
操作：

切り取る文字列を選択（ドラッグ）した後、 [Edit]のプルダウンメニューから[Cut(T)]を選択するか、右クリックして編集 Tool 

Box を表示し、Tool Box のメニューから[Cut(T)]を選択します。 範囲指定はドラック操作で行います。指定した範囲は、反

転表示されます。 反転表示された範囲は、切り取り機能実行後、削除されます。

16．１．３．２． Copy： 文字列複写機能
記述されている文字列の任意範囲を指定し、文字列貼り付け機能用に内部に保持する機能です.。

操作：

の複写対象文字列を指定した後、[Edit]のプルダウンメニューから[Copy(C)]を選択するか、右クリックして編集 Tool Box を

表示し、Tool Box のメニューから[Copy(C)]を選択します。 複写範囲指定はドラック操作で行います。指定した範囲は、反転

表示されます。 内部に保持された文字列は、他のテキストエディタ等でも使用できます。

16．１．３．３． Paste： 文字列貼り付け機能
直前編集操作で切り取り機能、または複写機能を実行するか、他のエディタで内部に保持されると有効となる機能で、現

在カーソル位置に、内部に保持されている文字列を貼り付ける機能です。
操作：

Script の貼り付け開始したい位置にカーソルを移動した後、[Edit]のプルダウンメニューから[Paste(P)]を選択するか、右クリ

ックして編集 Tool Box を表示し、Tool Box のメニューから[Paste(P)] を選択します。

16．１．３．４． Delete： 文字列削除機能
記述した任意範囲を指定して削除する機能です。

操作： 削除したい範囲を指定した後、[Edit]のプルダウンメニューから[Delete(D)]を選択

します。 削除範囲指定はドラック操作で行います。指定した範囲は、反転表示されます。

Cut を選択。

Copy を選択。

Paste を選択。
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実行前 実行後

16．１．３．５． Undo： 編集操作の取り消し機能
いったん実行した編集操作を取り消し、直前の状態に戻す機能です。

操作：

[Edit]メニューから[Undo(U)]を選択します。
選択されると、ひとつ前の状態に戻ります。なお、取り消し操作を行うことができないような変更の場合、[Undo(U)]メニュー

は無効となり選択できません。Undo 操作を行った後、更に[Undo(U)]メニューが有効な場合は、再び選択することにより、更

に前の状態に戻ります。

取り消しの効かない操作を行った場合でも、その直前の操作を取り消すことができると[Undo(U)]ボタンは有効のままとなっ

ていますので、ご注意下さい。

16．１．３．６． Indent： 段付け機能
演算処理ブロック制御文で制御される演算処理ブロック、および演算処理ブロック内に記述される演算処理ブロックを段付

けし、記述した Script 文を見易くする機能です。

操作：

[Edit]のプルダウンメニューから[Indent]を選択します。

段付け例：

case $1 = 1
proc calc {

$2 = $2*200

} calc

$1 = 3

段付けは演算処理ブロック制御文から演算処理ブロックは半角 2 文字、演算処理ブロック開始文と終了文の間に記述され

た構文は半角 2 文字で段付けされ、演算処理ブロック終了文に出会うと半角 2 文字戻します。

実行例：
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16．１．３．７． Ref.ch Renumbering： 参照チャネル番号振り替え機能
記述されている参照チャネル番号を振り替える機能です。 対象は、数値属性参照チャネ

ル($n)、文字属性参照チャネルのすべてが対象となります。 操作：

[Edit]メニューから[Ref.ch Renumbering]を選択します。

選択すると、<Re-Numbering>ダイアログが表示されます。

新たに振られる先頭チャネル番号を<Start Number>欄に記述し、飛び越し数を<Step>欄に記述します。 例えば、新たに

設定する先頭チャネルを 10ch、飛び越し数を 2 と設定すると、現在記述されている最もチャネル番号の若 いチャネル番

号から昇順に、10ch、12ch、14ch と新たに振られます。また、文字属性参照チャネルと数値属性参照チャ ネルを分離し

て振り替えたい場合は、ダイアログ上の Char.Ch Separation のチェックボックスをチェックすると、数値属性参 照チャネルの

昇順から振り替えられ、続いて振り替えられた数値属性参照チャネルの最も大きいチャネル番号に続いて文 字属性参照

チャネルが昇順に振り替えられます。

※ いったん振り替えると編集操作の取り消し機能（Undo）は効きませんので注意下さい。

16．１．３．８． Find： 文字列検索機能
記述した Script から指定した文字列を探す機能です。

操作： [Edit]のプルダウンメニューから[Find(F)]を選択

します。 選択すると<検索>ダイアログが表示されます。

検索する文字列欄に探す文字列を記述します。検索する方向は、現在カーソル位置から上方、または下方を選択します。

また、検索対象文字列を大文字と小文字を区別したい場合は、チェックボックスをチェックします。チェックされないと大文

字と小文字を区別しません。検索を開始する場合は、[次を検索]ボタンをクリックします。クリックすると、検索が開始され、

指定した方向で記述した文字列最初に出会う文字列が反転表示され検索結果を知らせます。検索対象文字列が存在し

ない場合は、何も表示されません。また、[次を検索]ボタンを次々にクリックし、指定した方向に存在しない場合、検索開始

位置が自動的に記述の先頭行に戻り、循環して検索を行います。なお、検索を終了する場合は、ダイアログの[キャンセル] 

ボタンをクリックします。

Find 機能実行例：

文字属性参照チャネル$60 を検索
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15 行目にエラー発見

16．１．３．９． Replace： 文字列置換機能
記述されている文字列に一致した文字列を、指定した文字列に置換する機能です。

操作： [Edit]のプルダウンメニューから[Replace(R)]を選択

します。 選択すると置換ダイアログが表示されます。

置換対象文字列を<検索する文字列(N)>欄に記述し、置換する文字列を<置換後の文字列(P)>欄に記述します。 一致し

たすべての文字列を一度に置換する場合は、[すべて置換(A)]ボタンをクリックします。置換対象文字列を確認しな がらひ

とつひとつ置換する場合は、[置換して次に(R)]ボタンをクリックします。また、初めに対象文字列を検索し、その後置 換する

場合は、[次を検索(F)]ボタンをクリックし、その後、[置換して次に(R)]ボタンをクリックします。検索方向は、現在カー ソル位

置から下方に探し、存在しない場合は、先頭行から探します。なお、大文字と小文字を区別する場合は、チェックボ ックス

をチェックします。文字列置換機能を終了する場合は、[キャンセル]ボタンをクリックします。なお、[キャンセル]ボタン をクリ

ックする前に置換した文字列は、[キャンセル]ボタンをクリックしても元に戻りません。

16．１．３．10． Syntax： 構文の文法チェック機能
記述された構文すべての文法チェックを行う機能です。 実行する前に、

構文記述上に文法上のエラーが無いか確認できます。 操作：
[Edit]のプルダウンメニューから[Syntax(S)]を選択します。
選択すると、文法チェックし結果を表示します。

文法エラーを発見した場合

注）表示される文法エラー発生行番号は実際に文法エラーを含んだ行の次の行番号を表示する場合があります。これは、

Archi_1 Script の構文が項目（引数）区切りに半角スペース、または改行で記述しても良い記述則により、項目数が不足し

た場合などは直下の行まで一つの構文と見なして文法チェックされるためです。

文字列”timee”を”time”に置換
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エラーを修正し、Script 文にエラーが無くなりました。

16．１．３．11． Ch List： チャネル番号リスト表示機能
Script 中に記述されているチャネル番号をリスト表示する機能です。

Script 記述中に記述するチャネル番号がすでに使用されているかの確認や、定義した信号名単位を確認したい場合など

に使用します。
操作：

[Edit]メニューから[Ch List]を選択します。 選択するとチャネルリストダイアログが

表示されます。

表示項目は、チャネル番号、信号名、出現回数、記述されている行番号です。

チャネル番号項名をクリックすると、出現順⇒チャネル番号昇順⇒チャネル番号降順と、クリックされる度に並び替えて表

示します。また、ダイアログはノンモーダル形式ですので、表示したままスクリプト文の作成や編集を行うことができます。 表

示したまま次の構文を記述、編集しても、表示されている内容は自動更新されませんので、最新の情報を表示させたい 場

合は、ダイアログ上の[Update]ボタンをクリックします。クリックすると、最新の情報に更新されます。

なお、ノンモーダル形のため、表示されたチャネルリストダイアログを閉じる場合は、ダイアログ右上の  [閉じる]をクリッ
クします。

“wav”を”.wav”に修正
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16．１．３．12． proc LINK： 外部演算処理ブロック・リンク機能
記述した構文中に演算ブロック呼出文（call proc）が記述され、呼び出し先の外部演算処理ブロックの記述が無い場合、別

の Archi_1 Scrip ファイル上に記述されている外部演算処理ブロックをファイルから読み出し、記述している構文の最終行

(end)以降に、貼り付ける機能です。

操作：

[EDIT]のプルダウンメニューから[proc LINK]を選択します。

選択するとサブルーチン読み出しダイアログが表示されます。

ダイアログ上の[BROWSE]ボタンクリックして呼び出し先外部演算処理ブロックが記述されている Archi_1 Scrip ファイル（拡

張子.prc）を選択します。次に<Update>チェックボックスを確認します。チェックされた場合は、すでに存在しているサブリー

チンを除いて貼り付けます。アンチェックされた場合は、作成中のスクリプトにすでに存在していても指定されたファイルの外

部演算処理ブロックに更新されます。[OK]ボタンをクリックすると、指定されたファイルを読み出し作成中のスクリプトの最終

行以降に演算処理ブロック呼出文（call proc）に対応する外部演算処理ブロックを読み出して貼り付けます。

なお[CANCEL]ボタンをクリックすると、何もしないでダイアログを閉じます。

外部演算処理ブロックのリンクを終了すると、ファイルから読み出してリンクした外部演算処理ブロック数（リンク成功数）と、

作成中のスクリプト記述に演算処理ブロック呼出文（ｃall proc）が存在しても指定したファイルに対応する外部演算処理ブロ

ックが存在していない数（リンク失敗数）を表示します。

※ 外部演算処理ブロックとは、演算処理ブロック呼出文（call proc）により呼び出されて実行される演算処理ブロックを意

味し、演算処理ブロック記述則に大きな違いがありません。機能的には Subroutin としての役割を持ちます。

16．１．３．13． Color Code： グラフ描画線色コード挿入機能
グラフ線種線色定義文で線色を記述する場合、先頭文字半角”#”に続き16進数文字6桁でカラーコードを記述する必要

があり、その場合にカラーパレットから色指定しカラーコード文字列を生成挿入する機能です。
操作：

カーソルをカラーコード文字列記述位置に移動後、[EDIT]のプルダウンメニューから[Color Code]を選択します。 選択され

るとカラーパレットダイアログを表示します。

線色を選択決定後、「OK」ボタンをクリックすると、現在カーソル位置から選択されたカラーコード文字列を挿入します。
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16．１．３．14． 参照チャネル信号名表示機能
Archi_1 Scrip 構文では、取り扱う変数を全てチャネル番号で記述し、変数自体を固有な名称で記述することはできません。

チャネル番号には固有な名称（信号名、単位）を信号名定義文で定義できますが、構文記述を見ても記述されている信 号

名を知ることができません。信号名表示機能は構文記述されているチャネル番号を定義されている信号名に置き換えて 表示

する機能です。

操作： 参照されているチャネル番号の信号名を知りたい場合、行番号位置にカーソルを移動

します。 移動すると、直下の行位置に、記述されているチャネル番号を信号名として表示しま

す。

※ 信号名で表示したいチャネル番号は、当該行の以前に、信号名定義文（def ch_name）、または代入文/演算文で定 義済

みである必要があります。

16．２． Archi_1 Script ファイルの保存と読み出し
16．２．１．記述編集エリアに表示されている内容のファイル保存
名前を付けて格納する場合 現在編集作成エリアに表示しているスクリプト文に名前を付け

て保存する場合を意味します。 操作：

[File]のプルダウンメニューから[Save As(A)]を選択します。 ファイル格納ダイアログが表示されますので、ファイル名欄にファ

イル名を指定して[保存]をクリックすると保存します。ファイ ル形式は内部形式で、拡張子は.prc となります。

カレントのファイルに上書きして保存する場合

すでに保存されていた Archi_1 Script ファイルを Open し、編集後に同じファイルに上書きして保存する場合を意味します。

操作： [File]のプルダウンメニューから[Save(S)]を選択

します。 選択されると直ちに上書き保存します。

格納するファイル名を入力します。
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16．２．２．Archi_1 Script ファイルの読み出し
すでに格納されているスクリプトファイルを読み出す場合

操作： [File]のプルダウンメニューから[Open(O)]を選択します。

ファイル読み出しダイアログが表示されますので、ファイル名欄にファイル名を指定して[開く(O)]をクリックすると、編集作成

エリアに読み出します。

すでに実行メニューに登録済みの場合、実行メニューから読み出すこともできます。 詳細操作方法は「16．３．３．１．実行

メニューから編集 Window への遷移」に記述します。

16．２．３．作成編集エリアの印刷
現在、作成編集記述エリア表示されている内容を印刷する場合

操作：
[File]のプルダウンメニューから[Print(P)]を選択します。

印刷ダイアログが表示されますので、プリンタの選択、ページ範囲、部数等設定した後、印刷ダイアログ上の[印刷(P)]をクリ

ックすると選択されたプリンタに印刷出力します。

※ Ａｒｃｈｉ_１ Script で記述され格納されたファイル形式はテキスト形式拡張子.prc となります。他のエディタ、あるいは

Windows アクセサリのメモ帳等でも表示印刷できます。

読み出しするファイル名を入力します。
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登録されていないメニューボタン

16．３． Archi_1 Script 実行メニューの操作
Archi_1 Scrip ファイルの実行メニューへの登録、あるいは Archi_1 Script の実行は実行メニューから行います。

16．３．１．実行メニューダイアログの表示
操作：

PcWaveForm メニューバーの[Option]のプルダウンメニューから[Archi_1 Execute]をクリックするか、 ツールバー上のアイコ

ン をクリックすると Archi_1 Script 実行メニュー<Archi_1 Exec.>ダイアログが表示されます。

16．３．２．Arch_1 Script ファイルの実行メニューへの登録
操作： 実行メニューボタン右横の[Browse]ボタンを選択します。選択されると、ファイル読み出しダイアログが表示され、登

録した い Archi_1 Script ファイル（拡張子.prc）を選択すると、実行メニューボタンに登録されます。登録したメニューボタン

には、 Archi_1 Scrip 構文： 実行メニューボタンラベル宣言文（dcl menu_label）でボタンラベル名が宣言されていると宣言し

たラベ ル名が表示され、当該宣言文が存在していないと、読み出したファイル名が表示されます。 すでに登録済みのボタ

ンに登録すると、新たに登録された内容に入れ替わります。

登録ファイル個数は 1 ページ当たり 20 個で、ページ 1～6 ページあり合計 60 ファイルとなります。

※ 実行メニューへの登録は当該スクリプト編集都度行う必要はありません。すでに登録済みの Archi_1 ファイルを編集 し

た場合、上書き格納（save）を行うことで、編集済みの Archi_1 Script ファイルに自動更新登録します。 但し、格納先フォ

ルダを変更した場合、或いはファイル名を変更した場合は、再登録が必要です。

登録されているメニューボタン
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16．３．３．実行メニューから編集 Windowへの遷移と登録削除

16．３．３．１．実行メニューから編集 Windowへの遷移
操作：

実行メニューラベルを右クリックすると、選択リストが表示されます。[Edit(E)]を選択すると、Archi_1 Script 編集 Window に

遷移し当該ボタンの Archi_1 Script ファイルを読み出し表示します。

16．３．３．２．実行メニューから登録削除
操作：

実行メニューラベル右クリックで表示される選択リストから[Delete(D)]を選択すると、削除確認ダイアログが表示されます。

登録削除する場合は[はい(Y)]をクリックします。クリックされると登録削除されボタンラベルは空欄となります。

※ すでに登録されている実行メニューボタンに別の Archi_1 Script ファイルを登録した場合、直前に登録されている

Archi_1 Script ファイルは登録削除されます。

16．３．４．実行環境設定
実行環境設定は実行メニューダイアログ下部のチェックボックスで行います。

16．３．４．１． 結果シートを初期化する場合
結果シートとは実行結果を表示するために用意されている結果シート Window を指します。

<Result Sheet Clear>チェックボックスをチェックします。チェックすると、実行時に結果シートに書き込む前に結果シート

Window を初期化してから書き込みます。アンチェックすると、すでに書き込まれている結果シート Window に追記されます。

ただし、追記する場合は、結果シートの書き込むページの列数がすでに書き込まれている内容と同じで無い場合は書き込

む前に当該ページを初期化して書き込み、同じ列数の場合は追記されます。

16．３．４．２．結果シート・ファイルに追記格納を指定する場合
結果シート格納文（save sheet）で格納した場合に、すでに同じファイル名が存在した場合に追記するのか、上書きするの

かを指定します。

追記する場合は<Result Sheet File Append Write>チェックボックスをチェックします。チェックすると結果シート格納先ファ

イル名がすでに存在している場合に追記処理されます。ただし、すでに存在しているファイルのページごとにチェックされ同

じ列数（チャネル数）でないページは上書きされます。
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表示される実行メニュー

16．３．４．３． データ位置情報ファイルに追記格納指定する場合
データ位置情報ファイルとは PcWaveForm の Value Draw Window (手書き Window)で読み出すことにより、描画波形上に

データなどを書き込むために用意されているファイルで、Archi_1  Script 構文で生成しデータ位置情報ファイル格納文

（save pos_info）で格納できます。データ位置情報ファイルは、解析対象とした収録ファイル（解析対象ファイル）と対をなす

もので、解析対象ファイルが異なった場合は追記処理指定しませんが、同じ解析対象ファイルを複数回に分けて処理した

場合など追記を指定します。

追記する場合、<Position_Info File Append Write>チェックボックスをチェックします。チェックするとデータ位置情報格納先

ファイルがすでに存在している場合は、データ位置情報ファイル格納文(save pos_info)で格納する際に追記されます。

16．３．４．４． 格納した波形ファイルを自動読み出しする場合
生成波形格納文（save wave)で格納した波形ファイルを実行終了後、自動的に PcWaveForm で読み出し表示するかしな

いかを指定します。

自動読み出しをする場合は、<Wave File Auto Open>チェックボックスをチェックします。チェックすると実行終了すると、格

納した波形ファイルを自動的に読み出し、PcWaveForm 波形表示 Window に表示します。なお、複数個の波形ファイルを

格納した場合、自動表示される波形ファイルは最新（最後に格納された波形ファイル）のものとなります。

※  実行環境は実行時環境宣言文(dcl script_env)でも設定できます。

16．３．５．Arch_1 Script の実行
現在表示している収録ファイルを解析対象ファイルとする場合は、波形表示 Window から表示されている波形の解析範囲

を指定してから行います。記述した Archi_1 Script 内で解析対象ファイルを読み出して処理する場合は、どの PcWaveForm 

上のどの Windowにいても実行できます。

操作：

実行する Archi_1 Script ファイル表示している実行メニューボタンをクリックします。

16．３．５．１．実行時の表示
Archi_1 ファイルが実行されると、プログレスバーダイアログが表示されます。 ダイアログは現在実行されている構文の行番

号と進行状況を表示します。ただし、進行状況は、スクリプト記述全体行数を 100%として表示する為、繰り返し処理記述が

あると、増減して表示されます。

実行メニューアイコン
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16．３．５．２．実行時エラーが発生した場合の表示
実行時通知ダイアログが表示されます。ダイアログにはエラーが発生した行番号と内容を表示し実行を中断します。

通知ダイアログは、ノンモーダル形式ですので、実行時エラー内容を表示したまま、作成編集 Window に遷移して記述した 構

文の編集を行うことができます。

通知ダイアログを閉じる場合は、閉じる場合は、ダイアログ右上の [閉じる]をクリックします。なお、再実行した場合は、
自動的に閉じます。

16．３．５．３．Script 実行時の強制終了
記述した構文ロジックが無限ループに入ってしまった場合など、強制終了したい場合は、キーボード上の[Esc]キーを押しま す。

[Esc]キーが押されると通知ダイアログが表示され、実行がキャンセルされたことを知らせます。
なお、実行中で Script 文によりダイアログを表示している場合は[Esc]キーを長押しします。

16．３．５．４．Script 実行の終了表示
Script 処理が正常終了すると、実行終了ダイアログが表示され実行終了を知らせます。

16．３．６．実行メニューの入れ替え
実行メニューボタンに登録されているメニュー内容のすべてを一括して格納したり、格納されているメニューに入れ替えたり す

る機能です。作成した Archi_1 Script ファイルが増加した場合など、実行に先立って、個別にボタン登録を行うのではなく、 解

析機能、あるいは分野別に分類して、ボタンに登録したメニュー自体を一括して入れ替える時などに使用します。

16．３．６．１．実行メニューの保存
操作： 実行メニューダイアログ上の下部[SAVE]ボタンをクリックします。クリックするとファイル格納ダイアログが表示されます。

ファ イル名を付けて格納します。実行メニューファイルはカレントフォルダに生成されます。 ァイル形式は、項目区切り文字半

角カンマのテキスト形式で拡張子は、.mnu です。

1 行 1 列目 Script Menu ⇒  keyword です。

1 行 2列目 生成年月日 ⇒  YYYY/MM/DD 形式です。

1 行 3列目 生成時刻 ⇒  hh:m:ss 形式です。

2 行目以降ボタンの登録内容です。

1 行目 登録ボタン番号 ⇒  メニューの先頭ページ上から 1,2,3…60と振られます。

2 列目 Archi_1 ファイル名 ⇒ パスを含めたファイル名が書き込まれます。

登録されていないボタンは、書き込みません。

※ 実行メニューファイルを他のエディタ等で作成し、カレントフォルダに格納すると、Archi_1 Script 実行メニューダイアログ 表

示時に自動的に参照され、実行メニューファイルの内容に置き換わります。
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16．３．６．２．メニューの読み出し
操作：

実行ダイアログ上の[READ]ボタンをクリックするとファイル読み出しダイアログを表示します。読み出すファイル名を選択して

読み出され、読み出されたファイルの内容に置き換わります。
なお、ファイルに登録されていないボタン番号の内容は、直前に表示されていた内容のままとなります。

16．４． 結果シートの操作
16．４．１．結果シート Window の表示
操作：

PcWaveForm の波形表示 Window のメニューバー[Option(O)]のプルダウンメニューから[Archi_1 Sheet]を選択します。 選

択すると、結果シート Window に遷移します。

ただし、実行結果で結果シートに書き込みが行われると、実行終了後自動的に結果シート Window に遷移しますので、この

操作は、以前に結果シートに書き込んだ内容を見たい場合のみ行います。

16．４．２．結果シートページの切り替え
結果シート左上部に結果シート宣言ブロック開始文(dcl sheet)で宣言したページ数分のタブが表示されます。タブには、結

果シートページ属性宣言文（page）で宣言されたページタイトルが表示されます。宣言をしなかった場合は、<Page1:>、
<Page2:>と表示されます。表示ページ初期値は<Page1:>です。

操作：

表示したいページを切り替える場合、表示するページのタブをクリックします。

16．４．３． 結果シートの格納
結果シートは結果シート格納文（save sheet）で格納できますが、結果シート格納文を記述しない場合、結果シート Window 

から格納することもできます。
操作：

格納する場合、結果シート Window 右上[SHEET_SAVE]ボタンをクリックします。クリックするとファイル格納ダイアログが表示

され、ファイルを格納できます。ファイルは、テキスト形式項目区切り半角カンマ”,”の csv 形式で格納されます。なお、

Script 実行メニューでの<Result Sheet File AppendWrite>チェックボックスの機能とは関係ありません。

タブをクリックしてページを切り替えます。

格納ボタン[SHEET_SAVE]
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このページはブランクです。
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